European Monetary Union: Euro (CA-EUR)

Release 4.6C
## Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Caution Icon" /></td>
<td>Caution</td>
</tr>
<tr>
<td><img src="image" alt="Example Icon" /></td>
<td>Example</td>
</tr>
<tr>
<td><img src="image" alt="Note Icon" /></td>
<td>Note</td>
</tr>
<tr>
<td><img src="image" alt="Recommendation Icon" /></td>
<td>Recommendation</td>
</tr>
<tr>
<td><img src="image" alt="Syntax Icon" /></td>
<td>Syntax</td>
</tr>
</tbody>
</table>
Contents

European Monetary Union: Euro (CA-EUR) ................................................................. 8
European Monetary Union: Euro (CA-EUR) ................................................................. 9
Additional Functions for the Euro (CA-EUR-GEN) ..................................................... 11
  Funds Management: Budget Planning in Euro (FI-FM) .................................................. 12
  Transaction Currency Changeover (TR-TM-MM/FX/DE) ................................................ 15
  Transaction Currency Changeover: Preparations ......................................................... 20
  Conversion of the Transaction Currency ................................................................. 22
    Money Market ......................................................................................................... 24
  Foreign Exchange ..................................................................................................... 26
    FX Transaction: One Currency to be Converted ..................................................... 28
    FX Transaction: Two Currencies to be Converted .................................................. 29
  Derivatives .................................................................................................................. 30
  Transaction Currency Changeover: Cleanup ................................................................ 31
Issue Currency Changeover (TR-TM-SE) ......................................................................... 32
  Issue Currency Changeover: Preparations ............................................................... 36
  Conversion of the Issue Currency .............................................................................. 37
  Issue Currency Changeover: Cleanup ....................................................................... 38
    Nominal Adjustment for Perc.-Quoted Securities .................................................... 39
    Adjusting Unit-Quoted Securities .......................................................................... 41
    Adjusting the Class Data ....................................................................................... 43
Contract Currency Changeover (TR-LO) ........................................................................ 44
  Contract Currency Changeover: Preparations ............................................................ 49
    General Preparation Activities .............................................................................. 50
      Contract Currency Changeover: Accounts .............................................................. 51
      Valuing Foreign Currency Loans ......................................................................... 52
      Customizing Settings ......................................................................................... 53
    Preparation Activities per Loan Contract ............................................................... 56
      Processing Suspended Data .................................................................................. 57
      Emptying the Rollover Files ................................................................................ 58
    Preparation Activities for Mass Processing ............................................................ 59
      Customizing Settings for Mass Processing ............................................................ 60
  Conversion of the Contract Currency ....................................................................... 62
    Checking the Incoming Payments Level .................................................................. 63
    Conversion of Master Data ..................................................................................... 64
    Conversion of Flow Data ....................................................................................... 65
    Conversion of Borrower’s Note Loan Orders ............................................................ 66
    Conversion of Drawings on Disbursement ............................................................... 67
    Rollover .................................................................................................................... 68
    Generating and Posting Adjustment Flows .............................................................. 69
    Currency Swap Posting: Open Items ...................................................................... 70
    Currency Swap Posting: Loan Position .................................................................... 72
    Currency Swap Posting: Premium/Discount ............................................................. 75
European Monetary Union: Euro (CA-EUR)

Reconciliation within Asset Accounting .................................................................. 148
Reconciliation with the General Ledger .................................................................. 150
Changeover of Group Depreciation Areas ................................................................. 153
Preventing Errors........................................................................................................ 155
Limitations of the Changeover .................................................................................. 157
Changeover in Special Purpose Ledger (FI-SL) .......................................................... 158
Changeover Procedure in the Special Purpose Ledger ............................................. 160
Changeover in Funds Management (FI-FM) ............................................................... 162
Procedure for Changeover in Funds Management ................................................ 164
Changeover for Treasury (TR)................................................................................... 167
Currency Hedge........................................................................................................... 168
Automatic Conversion of Limits ................................................................................ 170
Changeover in Cash Budget Management (TR-CB) ................................................ 171
Changeover in Overhead Cost Controlling (CO-OM) ................................................. 173
Changeover Procedure for Overhead Cost Controlling (CO-OM) ............................ 175
Restrictions to the Changeover (CO-OM) .................................................................. 182
Changeover in Product Cost Controlling (CO-PC) ................................................... 184
Changeover Procedure for Product Cost Controlling .............................................. 187
Changeover in Profitability Analysis (COPA) ............................................................ 192
Changeover in CostingBased Profitability Analysis .................................................. 193
Changeover in AccountBased Profitability Analysis .................................................. 196
Changeover in Real Estate Management (IS-RE) ...................................................... 198
Changeover in Materials Management (MM) ............................................................ 201
Changeover Procedure in Materials Management ................................................... 204
Changeover of the Executive Information System .................................................. 207
Constraints on the Changeover (EC-EIS) .................................................................. 210
Changeover in Profit Center Accounting (EC-PCA) .................................................. 211
Constraints on the Changeover (EC-PCA) ................................................................. 213
Cleanup ....................................................................................................................... 214
Cleanup in Treasury (TR) ............................................................................................ 215
Reconciling TR-TM-SE and FI Balances ................................................................. 216
Adjusting Selection Criteria (TR-LO) ....................................................................... 217
Data Adjustment in Cash Management (TR-CM) .................................................... 218
Cleanup in Cash Budget Management (TR-CB) ....................................................... 219
Changeover in Consolidation .................................................................................... 220
Changeover Objects ................................................................................................. 223
Currencies and Organizational Units to be Changed Over ...................................... 224
Tables Affected by the Changeover .......................................................................... 227
Changeover Packages ............................................................................................... 229
Changeover Scenarios ............................................................................................. 232
Scenario when Using Periodic Extracts ................................................................. 233
Scenario when Using Realtime Update .................................................................... 235
Scenario when Using a Rollup .................................................................................. 237
Scenario when Using Offline Data Entry ................................................................... 238
Scenario when Using Step Consolidation ............................................................... 240
Changeover Process in Consolidation ..................................................................... 241
Changeover Process for FI-LC ................................................................. 242
Changeover Process for EC-CS ............................................................... 247
Reconciliation ........................................................................................... 252
  Reconciliation with Applications Supplying Data ..................................... 253
  Reconciliation Within Consolidation ......................................................... 258
  Reconciliation with Applications Receiving Data ...................................... 263
Documentation of Adjustment Entries ...................................................... 264
Constraints for the Changeover ................................................................. 267
Cleanup in the Next Closing ...................................................................... 269
Currency Translation Using Spot (Current) vs. Historical Exchange Rates .... 273
Extra Functions ....................................................................................... 276
European Monetary Union: Euro (CA-EUR)
This is a preliminary version of the documentation for the currency changeover to the euro. It will continue to be updated up until the introduction of the euro on January 1, 1999. You will find the final version in SAPNet.

**Purpose**

You need this component to be able to carry out transition to the euro in your R/3 System. You use it to cover legal requirements, to be able to carry out business transactions more easily in the dual currency phase and to carry out the local currency changeover.

**Integration**

Due to dependencies between the various R/3 components, you can only change over the financial and management information systems centrally and not locally in the individual departments. You can change over individual areas gradually and independently of the local currency. Examples include prices, customer and vendor master records, or wages and salaries.

**Features**

The component offers you

- Functions for covering previously known legal requirements (exchange rate translation)
- Additional euro functions for processing business transactions more easily during the dual currency phase
- A changeover package for the local currency changeover.

**Functions for Meeting Legal Requirements**

You will need statutory foreign currency translation rules and rounding rules (Preparation Directive based on Article 235 of the Maastricht Treaty) at the beginning of the dual currency phase.

The R/3 System fulfills the required **foreign currency translation rules** as follows:

- You can enter the exchange rates which the Council defines for the euro in the R/3 System, expressed in the individual national currencies of the participating member states (such as one euro = DEM 1.94352).
- The R/3 System also uses the specified exchange rates for translations between the various national currency units, that is there are no longer any currency cross-rates between the individual currencies. When translating a national currency amount into another currency, the amount is first translated to the euro and then into the other national currency unit.
- Exchange rates are neither rounded nor shortened by one or more places.
- No inverted exchange rates are used for translation, that is amounts in national currency units are always divided by the exchange rate when translating to the euro.
- The exchange rates have six significant figures. This way translations have a high degree of accuracy.
The R/3 System fulfills the required rounding rules as follows:

- Amounts which are translated from one national currency unit into another one are first translated to the euro and then into the other national currency unit.
- When translating to the interim result in euro, the system rounds to a minimum of three decimal places.

**Business and Technical Functions**

- Multicurrency capability at the beginning of the dual currency phase

  The R/3 System distinguishes between the transaction currency (entry currency) and the local currency (ledger currency). The transaction currency is the currency in which a transaction, such as posting an incoming invoice, is entered. The amount entered in transaction currency is then translated into the local currency and both amounts are stored in the document. This means you can always make reference to the business partner's currency when sending correspondence such as payment reminders. You can therefore enter business transactions in national currency in the R/3 System even after the changeover to the euro. This corresponds to a foreign currency transaction with the only difference being that the euro has fixed exchange rates. Before changing over the ledger currency to the euro, the euro is managed as a foreign currency. Between the changeover and the end of the dual currency phase, the national currency will appear as a foreign currency.

- Additional functions for improved and easier processing of business transactions during the dual currency phase, such as retroactive accounting functions in national currencies for the period after the local currency changeover (see Additional Euro Functions (CA-EUR-GEN) [Page 11].

- Programs for Local Currency Changeover [Page 109]

- Retroactive accounting functions in national currencies for the period after the local currency changeover.
Additional Functions for the Euro (CA-EUR-GEN)

Purpose

You need these functions to be able to process business transactions in euro more easily during the dual currency phase.

Features

The component includes various additional functions for the entire dual currency phase, such as

- Changing over the individual customer/vendor currency to the euro (logistics)
- Mass change functions for conditions, master records, and so on
- Parallel display of end amounts in national currency and euro (payroll accounting)
- Automated support of the currency change for rates
- Translation functions for various programs (such as taxes on sales/purchases return and EC sales list)

You can find more information on this as well as a detailed list of all additional functions in the Implementation Guide (IMG) for European Monetary Union: Euro under Functions and Settings for the Dual Currency Phase.
Funds Management: Budget Planning in Euro (FI-FM)

Purpose

As part of local currency changeover to euro, you can maintain a particular euro FM area for the component Funds Management (FI-FM), in which you execute the budget planning in euro for the fiscal year in which the currency changeover to euro is planned in the system.

To achieve budget planning in euro on the one hand and to manage the current business processed at the same time on the other, is a special case requiring a special system maintenance. This is because the simultaneous implementation of several local currencies per FM area is not supported, but both the general business processes and the budget planning in the local currency are to be executed.

In the changeover phase, it is therefore necessary to maintain a second identical FM area (to be named euro FM area in the following) to be managed in euro, parallel to the existing FM area (to be named original FM area) that is managed in the original FM area currency.

While you continue the budget execution in the original local currency, the euro FM area fulfills the function of being able to create budget planning for the year of the local currency changeover in euro. At the start of the new fiscal year (year of the local currency changeover), you transfer the budget data created in the euro FM area into the original FM area. As long as the original FM area is managed in the original local currency up to local currency changeover, an automatic revaluation from euro into the original FM area currency takes place when you import the budget data. You execute the import of the budget version again immediately after the euro changeover and so you correct the rounding differences conditioned by the revaluation. After the changeover phase, you will again continue working exclusively in the original FM area and will deactivate the euro FM area.

Prerequisites

- In the euro FM area a budgeting exclusively with annual values is allowed, but not with overall values or period values.
- Working with workflow is not supported in the euro FM area
- You have to guarantee identical master data and Customizing settings for both FM areas during the "double FM area maintenance".

Process Flow

The following presents the functional process flow of the local currency changeover with an original FM area and the assigned euro FM area.

In this example the following data applies:

<table>
<thead>
<tr>
<th>In the fiscal year 1999</th>
<th>In the fiscal year 2000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a euro FM area</td>
<td>Managing the original FM area in the original local currency (here: marks) up to the end of February 2000 (after completion of the old fiscal year)</td>
</tr>
<tr>
<td>Creating a budget version in euro in the euro FM area for the year 2000</td>
<td>Currency changeover in the original FM area to euro in March 2000</td>
</tr>
<tr>
<td>Managing the original FM area in the original local currency (here: marks)</td>
<td></td>
</tr>
</tbody>
</table>
1. In 1999, you use program Create euro FM area to create a euro FM area from the data of your original FM area. In addition to the master data and Customizing settings, you can also copy the original budget data of the version 0 from previous fiscal years. The euro FM area is managed in the local currency euro.

⚠️

After creating the euro FM areas, execute master data changes exclusively in the original FM area and update the changes in the euro FM area, using program Update master data in the euro FM area.

For more information see the Implementation Guide under Cross-Application Components → European Monetary Union: Euro → Functions and Settings for the Dual Currency Phase → Financial Accounting → Funds Management: Budgeting in Euro: Budget planning in euro in the sections:

- Create euro FM area
- Update master data in the euro FM area

2. You create a budget version in the euro FM area and execute the budget planning there for the year 2000.

3. At the beginning of the year 2000, you export the budget data of the euro FM area to an external data medium and import the data in the new (empty) budget version 00x of your original FM area. Since the local currencies of the FM areas are still different at this time, a revaluation of the budget values into the local currency of the original FM area takes place automatically on import.

For more information see the Implementation Guide under Cross-Application Components → European Monetary Union: Euro → Functions and Settings for the Dual Currency Phase → Financial Accounting → Funds Management: Budgeting in Euro: Budget planning in euro in the sections:

- Export of budget version
- Import of budget version

4. You use budget versions copier to copy transferred budget version (00x) to version 0. This provides you with a temporary manageable budget plan in the original FM area for the fiscal year 2000.

   For more information, see Copy Budget Versions [Ext.].

5. In March 2000, you execute the local currency changeover to euro in the original FM area.

   For information on the local currency conversion, see Local Currency Changeover [Page 110].

6. Immediately after the currency changeover to euro, you execute the export/import of the budget data from the euro FM area again (according to point 3) from the euro FM area into a new (empty) budget version 00y of the original FM area.

💡

Since no currency revaluation takes place (both FM areas are managed in euro) the rounding differences connected to the conversion are no longer given.
Funds Management: Budget Planning in Euro (FI-FM)

7. You apply the budget version (according to point 4) again and replace the budget values of the temporary budget plan by the newly imported exact budget values. The plan data is then available as approved.

8. The functional use of the euro FM area is completed. You can now work exclusively in the original FM area again. To do this deactivate the euro FM area and delete the euro FM area data from the database.

   For more information see the Implementation Guide under Cross-Application Components → European Monetary Union: Euro → Functions and Settings for the Dual Currency Phase → Financial Accounting → Funds Management: Budgeting in Euro: Budget planning in euro in the sections:

   - Activate/deactivate euro FM area
   - Delete management record for euro FM area

Local currency changeover using euro FM area
Transaction Currency Changeover (TR-TM-MM/FX/DE)

Purpose

You can convert the transaction currency of financial transactions with due dates which fall within the dual currency phase (from 01/01/1999 to 01/01/2002) to the common euro currency. However, this is not mandatory.

By contrast, if the transaction due date falls after the dual currency phase, the changeover of the transaction currency is compulsory, since the participating currencies will no longer be valid after this period.

You change over the currency for individual transactions upon agreement with the business partners involved.

You can carry out the transaction currency changeover before or after the local currency changeover.

The report program for the transaction currency changeover also allows you to value the transactions at a fixed euro rate without actually carrying out the changeover. This is necessary when the transaction currency changeover is only carried out after the key date at which gains and losses resulting from the fixed euro translation have to be realized. For more information, refer to the section headed Valuation Without Conversion under Money Market [Page 24].

The following examples look at four different scenarios for the transaction currency changeover in the money market area:

1: Transaction currency changeover after the local currency changeover

LC = TC = DEM
TC changeover as at 01/01/2001
LC changeover as at 01/01/1999

Dual currency phase

01/01/1999 01/01/2000 01/01/2001 01/01/2002 06/30/2002

<table>
<thead>
<tr>
<th>LC</th>
<th>DEM</th>
<th>EUR</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC</td>
<td>DEM</td>
<td>EUR</td>
</tr>
</tbody>
</table>

LC = Local currency
TC = Transaction currency
FC = Foreign currency (participating currency)
Transaction Currency Changeover (TR-TM-MM/FX/DE)

1. Before the local currency changeover (1.1.1999) from DEM to EUR, all money market transactions are managed as local currency transactions.
2. In the period between the local currency changeover and the transaction currency changeover (01/01/1999 to 01/01/2001), all money market transactions are managed as foreign currency transactions.
3. After the transaction currency changeover (01/01/2001), all money market transactions are managed as local currency transactions again.
4. After the local currency changeover (for example, 01/01/1999), the money market transaction must be valued at the fixed euro rate using the valuation function incorporated in the changeover program.

The system does not create any additional valuation flows during the transaction currency changeover.

The euro valuation flows are taken into account when the realized gains and losses are calculated.

2: Transaction currency changeover after the local currency changeover

LC ≠ TC
LC = DEM / TC = FRF
LC changeover as at 01/01/1999
TC changeover as at 01/01/2001

Dual currency phase

01/01/1999 01/01/2000 01/01/2001 01/01/2002 06/30/2002

<table>
<thead>
<tr>
<th>LC</th>
<th>DEM</th>
<th>EUR</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC</td>
<td>FRF</td>
<td>EUR</td>
</tr>
</tbody>
</table>

LC = Local currency
TC = Transaction currency
FC = Foreign currency (participating currency)

1. Before the local currency changeover (01/01/1999) from DEM to EUR, all money market transactions are managed as foreign currency transactions.
2. In the period between the local currency changeover and the transaction currency changeover (01/01/1999 to 01/01/2001), all money market transactions are still managed as foreign currency transactions.
3. After the transaction currency changeover (01/01/2001), all money market transactions are managed as local currency transactions.
4. Refer to example 1, step 4.
Posting System for Example 2

T-account example: Money Market
Transaction : 1000 FRF
LC : DEM (already valued at fixed rate)
TC changeover : FRF → EUR

<table>
<thead>
<tr>
<th>Bal.sheet acct MM (FRF)</th>
<th>Bal.sheet acct MM (EUR)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 FRF (290 DEM)</td>
<td>1000 FRF 1 (290 DEM)</td>
</tr>
<tr>
<td></td>
<td>170 EUR 2 (290 DEM)</td>
</tr>
</tbody>
</table>

Clearing acct

| 1000 FRF 1 (290 DEM) | 170 EUR 2 (290 DEM) |

Postings:
- 1: Post the FRF position to the clearing account at the fixed exchange rate.
- 2: Post the euro position.

3: Transaction currency changeover before the local currency changeover
LC = TC = DEM
LC changeover as at 01/01/2001
Transaction Currency Changeover (TR-TM-MM/FX/DE)

TC = Transaction currency
FC = Foreign currency (participating currency)

1. Before the transaction currency changeover (01/01/1999) from DEM to EUR, all money market transactions are managed as local currency transactions.
2. In the period between the transaction currency changeover and the local currency changeover (01/01/1999 to 01/01/2001), all money market transactions are managed as foreign currency transactions.
3. After the local currency changeover (01/01/2001), the money market transactions are managed as local currency transactions again.
4. During the transaction currency changeover, the system values the money market position at the fixed euro rate.

Gains and losses resulting from the transaction currency changeover are disclosed separately, regardless of the valuation principle for the corresponding transaction type. Any valuations after this point in time do not generate additional gains and losses.

The gain/loss that has already been disclosed is taken into account when the realized gains/losses are calculated.

4: Transaction currency changeover before the local currency changeover
(LC ≠ TC)

LC = DEM / TC = FRF
LC changeover as at 01/01/2001
TC changeover as at 01/01/2000

---

Dual currency phase

<table>
<thead>
<tr>
<th>TC</th>
<th>DEM</th>
<th>EUR</th>
</tr>
</thead>
<tbody>
<tr>
<td>LC</td>
<td>FRF</td>
<td>EUR</td>
</tr>
</tbody>
</table>

---

LC = Local currency
TC = Transaction currency
FC = Foreign currency (participating currency)

1. Before the transaction currency changeover (01/01/2000) from DEM to EUR, all money market transactions are managed as foreign currency transactions.
2. In the period between the transaction currency changeover and the local currency changeover (01/01/2000 to 01/01/2001), all money market transactions are still managed as foreign currency transactions.
3. After the local currency changeover (01/01/2001), all money market transactions are managed as local currency transactions.
4. Refer to example 3, step 4.

**Posting System for Example 4**

*T-account example: Money Market*

<table>
<thead>
<tr>
<th>Transaction</th>
<th>1000 FRF</th>
</tr>
</thead>
<tbody>
<tr>
<td>LC</td>
<td>DEM</td>
</tr>
<tr>
<td>TC changeover</td>
<td>FRF → EUR</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Bal.sheet acct MM (FRF)</th>
<th>Bal.sheet acct MM (EUR)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 FRF (300 DEM)</td>
<td>0 FRF ① (10 DEM)</td>
</tr>
<tr>
<td></td>
<td>170 EUR ③ (290 DEM)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Clearing acct</th>
<th>P&amp;L acct euro changeover</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 FRF ② (290 DEM)</td>
<td>170 EUR (290 DEM)</td>
</tr>
<tr>
<td>0 FRF ① (10 DEM)</td>
<td></td>
</tr>
</tbody>
</table>

**Postings:**

- ①: Valuation of the FRF position at the fixed exchange rate.
  Assumptions: 1 FRF = 0.0145 EUR
  1 EUR = 2 DEM
- ②: Post the FRF position to the clearing account at the fixed exchange rate.
- ③: Post the euro position.

For more information, see [Money Market][Page 24]

The following sections *Money Market*, *Foreign Exchange* and *Derivatives* describe the preparation, conversion and cleanup activities you need to carry out for the transaction currency changeover.
Transaction Currency Changeover: Preparations

Prerequisites

Before you can convert Treasury transactions (money market, foreign exchange and derivatives), you need to perform the following activities:

- Maintain the euro currency table R/3 Customizing by choosing Treasury Management → Basic Functions → Euro Currencies → Define participating countries for euro changeover.

  The table for participating currencies for changing over Treasury transactions is independent of the table of participating currencies used for the local currency changeover. You maintain the table for the local currency changeover in R/3 Customizing by choosing Cross-Application Components → European Monetary Union: Euro → Local Currency Changeover → Central Changeover: Preprocessing → Specify Participating Currencies for Changeover Package

- Create one or several number range with internal number assignment for storing the original transactions. In R/3 Customizing, choose Treasury → Treasury Management → Money Market/Foreign Exchange/Derivatives → Transaction Management → Transaction Types → Define Number Ranges.

- Create the number range 01 for EUR reference links. In R/3 Customizing, choose Treasury → Treasury Management → Basic Functions → Transaction Management → Define Number Ranges for Linking Transactions.

- Create the clearing accounts for taking the amounts in the original currency off the books and posting the amounts in euro (account currency = local currency). There is no open item management. In the application menu, choose Accounting → Financial accounting → General ledger → Master records → Create.

  If you want the system to generate postings, you need to create the following flow types for the money market, foreign exchange and derivatives applications: Postings need to be generated if you want to carry out balance sheet transfers. To do this, create two posting flows (a debit and a credit flow) and two valuation flows. If you only want to carry out one euro valuation, it is sufficient to create the two valuation flows.

  - Create a flow type (outflow) for taking the amounts in original currency off the books (Flow classification 4, Flow category 40, set as Relevant to posting). In R/3 Customizing, choose Treasury → Treasury Management → Money Market/Foreign Exchange/Derivatives → Transaction Management → Flow Types → Define Flow Types.

  - Create a flow type (inflow) for posting the amounts in euro (Flow classification 4, Flow category 40, set as Relevant to posting). In R/3 Customizing, choose the same path as for creating an outflow.

  - Create a P&L flow type for a possible loss as a result of the fixed-rate conversion (Flow classification 3, Flow category 90, set as Relevant to posting and Relevant to valuation) In R/3 Customizing, choose the same path as for creating an outflow.
Create a P&L flow type for a possible gain as a result of the fixed-rate conversion (Flow classification 3, Flow category 91, set as Relevant to posting and Relevant to valuation). In R/3 Customizing, choose the same path as for creating an outflow.

Maintain account determination for these flow types. In R/3 Customizing, choose Treasury → Treasury Management → Money Market/Foreign Exchange/Derivatives → Functions → Accounting → Account Determination → Define Settings.

To ensure that account determination is correct, you may need to define several debit and credit flow types per product category. This will depend on the flow types and account assignment references.

Maintain an account assignment reference to determine the corresponding balance sheet account for the target currency euro.

For the outflows and valuation flows, the system transfers the original account assignment references. For the other newly-generated flows, the account assignment reference is determined again.

Enter the euro exchange rates in the leading currency table, such as EUR/USD or EUR/DEM (for two participating currencies also EUR/EUR). In R/3 Customizing, choose Treasury → Treasury Management → Basic Functions → Transaction Management → Currencies → Define Leading Currency.

Maintain the exchange rate table. In R/3 Customizing, choose Global Settings → Currencies → Enter Exchange Rates.

Maintain the standing instructions for payment details for the currency euro. In the application menu, choose Master data → Standing instructions → Payment details.

After the transaction currency changeover, the system recalculates all the settings with values from the standing instructions.

Before the actual conversion, the conversion program runs the following checks:

- All flows with due dates before the key date for the changeover which are relevant for posting must have been posted.
- All open payment requests with due dates before the key date for the changeover must have been settled.

Interest and other flows are not transferred. To post any pre-posted interest flows to a euro account, you need to delete such flows before the changeover.
Conversion of the Transaction Currency

Prerequisites
The conversion program first runs the following checks:

- All flows with due dates before the key date for the changeover which are relevant for posting must have been posted. Otherwise, the transaction is not converted.
- All open payment requests with due dates before the key date for the changeover must have been settled.
  Any open payment requests which still exist during the changeover cannot be settled after the changeover.

If these requirements are met, the system posts the following flows:

- **Money market:**
  - Principal increases
  - Principal decreases
- **Foreign exchange:**
  - Purchase and sale flows
- **OTC options, caps/floors:**
  - Premiums
- **Swaps:**
  - Nominal amounts

Interest and other flows are not transferred. To post any pre-posted interest flows to a euro account, you need to delete such flows before the changeover.

Function description

- During the transaction currency changeover, the system converts all the relevant flows (including historic flows which have already been posted) into euros, if the currency is defined as a participating currency for European Monetary Union. The data from the original transaction is saved in *inactive* status under a new transaction number in a special number range. The converted transaction keeps the original number. The system generates a reciprocal reference category (category EUR) for both transactions.
- The system also resets the confirmation status of the active transaction activity and reads the new standing instructions for payment details for the new flows.
- The system updates Cash Management if the activities are relevant for planning.

Procedure
1. To convert the transaction currency, start report program RFTBEUR00.
2. Enter the following data in the selection screen:
   a) The key date for changeover
b) The number range for storing the old transactions

3. If you do not want the system to generate transfer flows and valuation flows, set the *Do not generate postings* indicator. In this case, you do not need to enter the transfer flow types or the flow types for valuation.

   If, by mistake, you set the *Do not generate postings* indicator for a transaction for which transfer flows should actually be generated, and run the conversion in this mode, you will need to generate the transfer flows manually. For details of the relevant posting system, refer to [Conversion of the Transaction Currency (TR-TM-MM/FX/DE/CM [Page 15)]

4. Otherwise, you must enter the above flow types in the program selection screen. For more information, see [Transaction Currency Changeover: Preparations [Page 20]].

5. You can also run the conversion for individual transactions, certain partners or according to other criteria.

6. Choose *Execute*.

   ![Warning icon] You cannot carry out a simulation run for the transaction currency changeover.

7. ![Warning icon] Flows that are generated by the transaction currency changeover must always be released for posting.

The following sections describe the changeover activities for the money market [Page 24], foreign exchange [Page 26] and derivatives [Page 30] areas.
Money Market

For information on the posting system (T-account example), see Transaction Currency Changeover (TR-TM-MM/FX/DE/CM) [Page 15]

Use

- The position in the relevant balance sheet account is posted to a clearing account, which needs to be created specifically for the transfer posting. If the transaction currency differs from the local currency, the position in the relevant balance sheet account is translated into the local currency amount at the fixed rate (via EUR). The system generates a flow using a special flow type for taking the original currency off the books. Any differences between the local currency amount posted to this clearing account and the existing local currency position are cleared by means of a P&L flow for gains and losses resulting from the euro changeover. Here, you use the relevant flow type for gains or losses resulting from the transaction currency changeover.

- The transaction amount in local currency is then copied from the outgoing flow (take original amount off the books) to the ingoing flow (post transaction amount in euro to corresponding account) and translated into euros. The program automatically converts all the currency fields and, where applicable, any calculation bases in transaction currency. The local currency amount posted is the same as the amount taken off the books (the inverse of the flow). This flow is generated with the flow type for postings in euros. This procedure ensures that the original transaction currency position calculated on the basis of the fixed rate is posted as the correct euro position.

- The valuation flows generated are released for posting automatically by the system.

- You may need to release the generated transfer flows. This will depend on the Customizing settings you have made for automatic posting release for the corresponding transaction type. To do this, choose Money market → Accounting → Posting → Release.

- After the release, execute the posting.

Any interest and other flows which have already been posted are displayed in euros when you display the transaction. However, the link to the posting document takes you to the document in the original currency. These items are not converted.

Valuation Without Conversion

Valuation Without Conversion (general)

If you do not carry out the transaction currency changeover at the beginning of the dual currency phase, you may need to perform a valuation based on the fixed euro exchange rate. The valuation is made independently of the valuation principles used for key date valuation, since both gains and losses resulting from translation to the euro are to be disclosed.

Procedure

1. Start report program RFTBEUR00.
2. Select the required application and enter the corresponding flow types for euro gains/losses.
3. Enter a number range (even though no transaction number is assigned).
4. Select the *Only execute valuation* field.
5. Execute the report program.

**Valuation Without Conversion (Money Market and Derivatives)**

The valuation is based on the book value of the transaction position, and determines the difference between the book value and the fixed euro rate.

The system generates a valuation flow using the flow types for euro gains/losses.
**Foreign Exchange**

**Use**

- Foreign exchange transactions are pending transactions which are usually only posted when they become due. This means that there is no related balance sheet position which needs to be transferred.

- Hence, the system converts the existing amounts in transaction currency directly into euros.

- If, by contrast, the main flows relating to a foreign exchange transaction have already been (pre-)posted, the procedure used for money market positions is applied to each of the two flows.

  For each currency you want to convert, the system translates the posted flows into the local currency amount using a fixed rate, and posts the flows to a clearing account. Any differences between the local currency amounts calculated and the book value are cleared by means of a P&L flow. The transaction currency amount is translated into euros and then posted from the clearing account to a corresponding euro account.

- If you want to settle a transaction involving two foreign currencies after conversion to fulfil the original purpose, even if it is no longer, strictly speaking, a foreign exchange transaction, the key date valuation function ensures that the swap accrual/deferral can be calculated correctly up to the transaction due date.

  The following sections describe the features of the transaction currency changeover which are specific to the foreign exchange area.

- [FX Transaction: One Currency to be Converted](Page 28)
- [FX Transaction: Two Currencies to be Converted](Page 29)

**Valuation Without Conversion**

**Valuation Without Conversion (general)**

If you do not carry out the transaction currency changeover at the beginning of the dual currency phase, you may need to perform a valuation based on the fixed euro exchange rate. The valuation is made independently of the valuation principles used for key date valuation, since both gains and losses resulting from translation to the euro are to be disclosed.

**Procedure**

1. Start report program RFTBEUR00.
2. Select the required application and enter the corresponding flow types for euro gains/losses.
3. Enter a number range (even though no transaction number is assigned).
4. Select the **Only execute valuation** field.
5. Execute the report program.
Valuation Without Conversion (for Foreign Exchange)

Foreign exchange transactions that have two participating currencies and have not yet been posted are valued on the basis of the acquisition value. Any existing key date valuations are reset automatically.

The system generates a valuation flow using the flow types for euro gains/losses.

Where transactions have already been posted, the procedure is the same as for money market transactions.
FX Transaction: One Currency to be Converted

Function

When a transaction only involves one currency that needs to be converted, the system takes the rate notation for the currency pair from the leading/following currency table (TCURR).

If you want to change over a USD/DEM transaction, you enter EUR/USD in the leading currency table. This entry is used as the new notation for the currency pair. The system determines the transaction exchange rate (VTBFHAZU-KKURS).

If the spot rate and the swap rate also need to be calculated, this is done as follows:

- In the original transaction in the old transaction currency, the system uses the spot rate to calculate the corresponding spot amount required for the new rate notation.
- The system calculates the new spot rate (VTBFHAZU-KKASSA) from the ratio of this amount to the leading currency amount of the converted transaction.
- The swap rate (VTBFHAZU-KSWAP) is the difference between the transaction exchange rate and the spot rate.
FX Transaction: Two Currencies to be Converted

Function

- To determine the EUR/EUR rate that appears in the transaction display after the changeover, the system converts the amounts from the original transaction (leading currency amount, following currency amount, spot amount) into euros and calculates an artificial euro rate based on the ratio of these amounts to each other. To calculate the transaction rate, the system divides the converted following currency amount of the original transaction by the converted leading currency amount. If the exchange rate notation is the inverse of the original transaction, the system uses the exchange rate notation in the leading currency table to calculate the euro rate.

This ensures that transactions with the same trading amounts are identical and have the same rate, even if the rate notation is not EUR/EUR.

You want to convert a DEM/FRF transaction (inverse rate notation). The entry in the leading currency table is FRF/DEM.

The transaction data is as follows:

- **Purchase:** 1m DEM at a forward rate of 3.0000 (DEM/FRF)
- **Sale:** 3m FRF
- **Spot rate:** 3.1000 (DEM/FRF)
- **Swap rate:** 0.1000 - (DEM/FRF)

The system converts the transaction to the euro by translating the two amounts (assumed exchange rates: EUR/DEM = 2, EUR/FRF = 5)

<table>
<thead>
<tr>
<th>Currency to be converted</th>
<th>Euro</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,000,000 DEM</td>
<td>500,000</td>
</tr>
<tr>
<td>3,000,000 FRF</td>
<td>600,000</td>
</tr>
</tbody>
</table>

The system determines the EUR/EUR rate by dividing the converted DEM amount by the converted FRF amount. This calculation is based on the entry FRF/DEM in the leading currency table TCURL.

The resulting EUR/EUR rate is 0.833333333.

- The system calculates the spot and swap rates in the same way.
Derivatives

Use

The conversion program can convert the following product categories:

- OTC options
- Caps/floors
- Swaps
- Forward rate agreements (FRAs)

The system only creates posting flows and P&L flows in the same way as for the money market and foreign exchange areas if you change over derivative transactions that affect balance sheet positions (such as purchased OTC options, purchased caps or floors, swaps).

OTC options, caps and floors affect balance sheet positions if the flow type for the premium is flagged as **relevant to position** and **relevant to posting**.

Swaps affect balance sheet positions if the flow types for the nominal amounts are flagged as **relevant to position** and **relevant to posting**.

The system converts flows from derivatives that do not affect balance sheet positions according to the corresponding fixed rate. In this case, no posting flows are generated.

When you convert OTC options to the euro, the system also converts the following underlying transactions:

- Foreign exchange transactions (for more information, see Foreign Exchange [Page 26])
- Caps/floors (straightforward conversion of the flows)
- Swaps (straightforward conversion of the flows)

The system does not change interest rates, calculation methods and conditions.

It also does not change listed underlyings, such as stocks and bonds. If necessary, you must convert these underlyings manually.

See also: **Transaction Currency Changeover: Cleanup [Page 31]**.

Valuation Without Conversion

The valuation procedure is the same as for the money market area. For more information, refer to the section headed **Valuation Without Conversion** under Money Market [Page 24]
Transaction Currency Changeover: Cleanup

Purpose

- You may need to clean up more complex financial transactions (derivatives) manually. For example, you may need to assign a new reference interest rate to the transaction.
- You need to edit listed underlying transactions (stocks and bonds) manually when they are exercised. You can do this when you create the exercise transaction.
- Interest rates, calculation methods and transaction conditions are not changed by the conversion program and may need to be adjusted manually.
  - For interest rate transactions for which you carried out an interest-rate adjustment before the changeover, you create a new condition effective from the next interest rate fixing date.
  - To adjust for any rounding differences, run the valuation report RFTBBE01.

Reversibility

No function to reset the transaction currency changeover is planned.

- If you convert a transaction by mistake, you need to reverse the transaction and enter it again under a new transaction number.
- You must also reverse any posted flows manually. (In the application menu, choose Accounting → Posting → Reverse manually).
- You can copy the data from the original (inactive) transaction.

Special items for gains and losses resulting from fixed euro rates

The system posts gains and losses resulting from the changeover to the euro to the accounts for realized gains and losses.

If you opt to create special items for these gains and losses, you need to do this manually in FI. You also need to write back the special items manually.

Check: Conversion complete?

The system creates a log (error list) automatically. You should print this log out, since it cannot be displayed again once you have exited the program.

You can check if the conversion was complete by comparing the log to the journal for financial transactions.

You can also use the collective processing function for references. The reference category used in the conversion is EUR.

At the end of the dual currency phase, you need to ensure that all the transactions have been changed over to the euro. You can check this using the journal for financial transactions and the maturity lists in the forex area.
Issue Currency Changeover (TR-TM-SE)

Purpose

As part of European Monetary Union (EMU), it is anticipated that almost all securities which have been issued in a participating currency will be converted to euro on a certain key date specified by the issuer before the end of 2001.

Since all flows and documents in the R/3 Securities component are not only recorded in local currency, but also in the issue currency, the issue currency of a security can only be changed if all the documents and flows which link to the security are also translated. The system carries out both steps automatically as part of the issue currency changeover.

You can change over the issue currency either before or after the local currency changeover.

The following examples look at four different scenarios for the issue currency changeover:

1. Issue currency changeover after the local currency changeover

   LC = IC = DEM
   LC changeover as at 01/01/1999
   IC changeover as at 01/01/2001

   Dual currency phase

   01/01/1999 01/01/2000 01/01/2001 01/01/2002 06/30/2002

   LC = Local currency
   IC = Issue currency
   FC = Foreign currency (participating currency)

   1. Before the local currency changeover (01/01/1999) from DEM to EUR, all securities are managed as local currency securities.
   2. In the period between the local currency changeover and the issue currency changeover (01/01/1999 to 01/01/2001), all the securities are managed as foreign currency securities.
   3. After the issue currency changeover (01/01/2001), all securities are managed as local currency securities again.
2: Issue currency changeover after the local currency changeover

(LC ≠ IC)

LC = DEM / IC = FRF

LC changeover as at 01/01/1999
IC changeover as at 01/01/2001

3: Issue currency changeover before the local currency changeover

LC = IC = DEM

LC changeover as at 01/01/2001
IC changeover as at 01/01/1999
Issue Currency Changeover (TR-TM-SE)

1. Before the issue currency changeover (01/01/1999) from DEM to EUR, all securities are managed as local currency securities.
2. In the period between the issue currency changeover and the local currency changeover (01/01/1999 to 01/01/2001), all the securities are managed as foreign currency securities.
3. After the local currency changeover (01/01/2001), the securities are managed as local currency securities again.

4: Issue currency changeover before the local currency changeover
(LC ≠ IC)
LC = DEM / IC = FRF
LC changeover as at 01/01/2001
IC changeover as at 01/01/2000

LC = Local currency
IC = Issue currency
FC = Foreign currency (participating currency)
FC = Foreign currency (participating currency)

1. Before the issue currency changeover (01/01/2000) from DEM to EUR, all securities are managed as foreign currency securities.
2. In the period between the issue currency changeover and the local currency changeover (01/01/2000 to 01/01/2001), all the securities are still managed as foreign currency securities.
3. After the local currency changeover (01/01/2001), all securities are managed as local currency securities.

In examples 1 and 3, a local currency security is temporarily managed as a foreign currency security. If you perform a valuation during this period, this may lead to write-ups/write-downs in the foreign currency (rounding errors). If required, you can set up account determination to post the corresponding flows for foreign currency valuation to a special account. After the second changeover, the foreign currency valuation flows are added to those for valuation of the security.

**Features**

The following sections describe the preparation activities, the conversion process and any cleanup activities required for the issue currency changeover to the euro.
Issue Currency Changeover: Preparations

Prerequisites

The currency changeover is performed across all company codes. The following prerequisites must be fulfilled:

- At the key date for the changeover, you have closed the period for all the positions of the security to be converted.

- There are no ‘closed’ actual records with a position date after the key date for the changeover (exception: reversal flows). A flow is ‘closed’ if you have carried out period-end closing since the posting.

- Before you carry out the local currency changeover or the issue currency changeover, you need to disclose the currency reserves [Page 120]. To do this, use report program RFVWBEW1. You need to run this report at the beginning of the dual currency phase in order to realize the gains and losses resulting from the fixed euro rates.
Conversion of the Issue Currency

Purpose
The issue currency changeover is represented in the system as a special form of corporate action. To convert the currency of a security, define a corporate action in the category Convert issue currency. This definition is kept as a reference for all the flows generated.

Process Flow
1. Define and save the corporate action.
2. Post the corporate action. This converts all the flows and documents. The currency swap posting is made in FI. (For more information about the principle of currency swap postings (T-account example), refer to the end of the section headed Transaction Currency Changeover (TR-TM-MM/FX/DE/CM) [Page 15].) Reconcile the flows and documents in the subledger.

   The system converts the following master data fields:

   **Affected fields for stocks.**
   a) Nominal value per stock
   b) Fund volume
   c) Issue price
   d) Issue currency

   **Affected fields for bonds.**
   a) Issue price
   b) Issue currency
   c) Issue volume
   d) Nominal value
   e) Nominal value per trading unit
   f) Nominal currency
   g) Total issue amount
   h) Minimum assignment amount
   i) Cover amount

3. If necessary, you also have the option of resetting the changeover.

   For details of the exact procedure for the issue currency changeover, see Issue Currency Changeover [Ext.]

Cash Management update
The system converts the update to Cash Management automatically.
Issue Currency Changeover: Cleanup

Purpose

In certain cases, you may need to carry out cleanup activities after the issue currency changeover.

These activities are described in the following sections:

- Nominal Adjustment for Percentage-Quoted Securities [Page 39]
- Adjusting Unit-Quoted Securities [Page 41]
- Adjusting the Class Data [Page 43]
- Check: Conversion complete?
  
  The system runs this check for each security during conversion.
  
  You can use report program RFVWFIWP to check which securities have not yet been converted.
  
  a) In the Securities menu, choose Master data → Class. In the next screen, choose Find.
  
  b) In the Find ID Number via Issuer screen, enter the Issue currency of the security to search for the securities which have not been converted.
Nominal Adjustment for Perc.-Quoted Securities

Purpose
After the changeover, you need to carry out a nominal adjustment for each individual securities account position.

Background
As part of the issue currency changeover to the euro, the positions of bonds that are already on the market need to be converted.

Representation in the SAP R/3 System
In the Securities component, position management is based on flows rather than positions. Thus, when you change over to the euro, the system does not convert the security position using the fixed rate.

Instead, the system converts the position currency amount of all the flows that belong to the corresponding position. After the position changeover to the euro, there are likely to be minor differences between the nominal amount disclosed by the depository bank and the nominal amount calculated by the R/3 System, regardless of whether the issue was converted using the bottom-up or the top-down method. You eliminate these differences by adjusting the data in the SAP R/3 System to correspond to the data of the financial institution.

Before the issue currency changeover, the position data is as follows:

Issue currency: DEM
Flows:
1. Purchase 100,000 DEM (nominal amount)
2. Sale 53,000 DEM
3. Sale 33,000 DEM
→ System position 14,000 DEM = Bank position

After the issue currency changeover DEM → EUR:
(Translation ratio 0.493125)
1. Purchase 49,312.50 EUR
2. Sale 26,135.63 EUR
3. Sale 16,273.13 EUR
→ System position 6,903.74 EUR
Bank position 14,000 DEM * 0.493125 EUR/DEM = 6,903.75 EUR

The difference is added to the most recent sale. The nominal sale amount is reduced by 0.01 EUR to 16,273.12 EUR. In this way, the system position is adjusted to the bank position of 6,903.75 EUR.
Nominal Adjustment for Perc.-Quoted Securities

Eliminating the differences

- Ensure that no “closed” flows exist after the key date for the conversion.
- You do not need to make any special settings in Customizing.

Procedure

1. For each company code and securities account, determine the bank position (in euros) for a converted security on the conversion key date.
2. Start report program RFVWEUR3. Enter the Company code, the ID number, the Securities account and the Key date for the adjustment.
3. The system displays the nominal amount for the corresponding position.
4. Enter the securities account position according to your bank.
5. The system calculates the difference between the bank and system positions. Make sure that the difference can be explained by rounding differences (a maximum of a few euros). If the differences are greater, you need to clarify whether the differences resulted from the currency changeover or whether there are possibly other causes.
6. Choose Save.

   The system adjusts the nominal amount of the existing flow by the difference calculated.

   The system selects the most recent inflow or outflow before the key date as the flow to be modified (the relevant date is the position value date). Discounted securities (zero bonds) that are valued on an individual basis are an exception. For these securities, the system brings up all the inflows that fall before the value date, and you choose the record to be adjusted manually.

After the changeover to the euro, the smallest unit for a posted securities account position will be 0,01 EUR (1 cent method), and amounts will be rounded to the nearest two decimal places. This applies to most of the European exchanges.

In exceptional cases (such as in France), the nominal values are to be expressed without decimal places (1 euro method). The difference is settled by means of a cash settlement, which is represented in the system by a corresponding purchase/sale item.
Adjusting Unit-Quoted Securities

1. Stocks

Features

A range of changeover variants are currently being discussed for stocks. However, these do not affect position management in the SAP R/3 System, since the positions in R/3 are managed on a unit basis.

Changeover variants:

1. Change over to unit stocks without nominal value.
2. Change over to stocks with a nominal value of one euro (or n euros).
   In this case, the public limited company would need to perform a corporate action to adjust for irregular nominal values of a stock.
3. Change over to irregular euro nominal values.

Procedure

- No cleanup activities are necessary for variants 1 and 3, since one unit is still one unit. You only need to adjust the class data.
- For variant 2, you need to carry out a stock split. The following example illustrates the necessary consequences.

  Translation ratio: 1.8525
  A stock with a nominal value of DEM 5.00 = EUR 2.70
  Capital increase from retained earnings: EUR 0.30
  Result → Three stocks at EUR 1.00

You do not need to enter a capital increase from retained earnings in R/3 position management, since the number of units issued does not change.

As an alternative to a capital increase from retained earnings, issuers may carry out a capital reduction. Example:

  Translation ratio: 1.8525
  A stock with a nominal value of DEM 5.00 = EUR 2.70
  Capital increase from retained earnings: EUR 0,70
  Result → Two stocks at EUR 1.00

In R/3 position management, you only need to carry out a stock split, as in the previous example.
2. Shares in funds

Procedure

Since shares in funds are quoted in units, the same applies as for stocks. You do not need to carry out a stock split.
Adjusting the Class Data

Procedure

Adjusting the nominal values manually

You may need to adjust the smallest tradable unit to reflect specific country requirements.

If necessary, adjust the following fields for the class master data:

<table>
<thead>
<tr>
<th>Class</th>
<th>Fields to be adjusted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bonds</td>
<td>Nominal trading unit, nominal value</td>
</tr>
<tr>
<td>Stocks</td>
<td>No. of stocks, nominal value</td>
</tr>
<tr>
<td>Convertible bonds</td>
<td>Conversion premium, currency of conversion premium</td>
</tr>
<tr>
<td>Warrants</td>
<td>Exercise price, exercise price currency</td>
</tr>
<tr>
<td></td>
<td>Reference unit, reference unit currency</td>
</tr>
</tbody>
</table>

Class data conditions

After the changeover, you need to create new condition items with the currency euro and the effective date *one day after the calculation date of the last coupon paid in the old condition currency*.

You need to make any other changes to the conditions (such as reference interest rates or interest calculation categories) manually.
**Contract Currency Changeover (TR-LO)**

**Purpose**

- Within the *Loans* component, the transaction currency (the currency relevant for the customer relationship) is referred to as the contract currency.
- With the contract currency changeover, you convert the loans managed in the currency you want to convert (such as DEM) to the euro.
- In the dual currency phase (from 01/01/1999), the borrower can choose whether the loan is managed in the original currency or in euros.
- In this dual currency phase, you need to differentiate between individual loan processing and mass loan processing [*Page 78*].
- You can change over the contract currency either before or after the local currency changeover.

In the *Loans* application menu, the following functions are available for the contract currency changeover:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio → Contract Currency Changeover to the Euro →</td>
<td>Currency Changeover</td>
</tr>
<tr>
<td>Portfolio → Reset Currency Changeover</td>
<td></td>
</tr>
</tbody>
</table>

The following examples look at four different scenarios for the contract currency changeover:

1: Contract currency changeover of local currency loans after the local currency changeover

LC and CC = DEM before 01/01/1999

LC changeover on 04/18/1999 as at 01/01/1999 (start of fiscal year)

CC changeover on 02/15/2001

```
01/01/1999 01/01/2000 01/01/2001 01/01/2002 06/30/2002
```

```
<table>
<thead>
<tr>
<th>LC</th>
<th>DEM</th>
<th>EUR</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC</td>
<td>DEM</td>
<td>EUR</td>
</tr>
</tbody>
</table>
```

LC = CC

LC = CC

LC = CC

CC = FC
LC = Local currency  
CC = Contract currency  
FC = Foreign currency (participating currency)  

1. Before the local currency changeover (04/18/1999) from DEM to EUR, the loans are managed as local currency loans.

2. In the period between the local currency changeover and the contract currency changeover (04/18/1999 to 02/15/2001), the loans which were originally local currency loans are managed as foreign currency loans.

3. After the contract currency changeover (02/15/2001), the original local currency loans are changed back to local currency loans.

2: Contract currency changeover of foreign currency loans after the local currency changeover

LC ≠ CC  
LC = DEM / CC = FRF before 01/01/1999  
LC changeover on 04/18/1999 as at 01/01/1999 (start of fiscal year)  
CC changeover on 11/18/2000

LC = Local currency  
CC = Contract currency  
FC = Foreign currency (participating currency)  

1. Before the local currency changeover (04/18/1999) from DEM to EUR, the loans are managed as foreign currency loans.

2. In the period between the local currency changeover and the contract currency changeover (04/18/1999 to 11/18/2000), the loans are still managed as foreign currency loans.

3. After the contract currency changeover (11/18/2000), the loans which were originally foreign currency loans are managed as local currency loans. This only applies for foreign currencies participating in EMU.
3: Contract currency changeover of local currency loans before the local currency changeover

LC and CC = DEM before 01/01/1999
LC changeover on 03/15/2001 as at 01/01/2001 (start of fiscal year)
CC changeover on 01/05/1999

Dual currency phase

01/01/1999 01/01/2000 01/01/2001 01/01/2002 06/30/2002

<table>
<thead>
<tr>
<th>LC</th>
<th>DEM</th>
<th></th>
<th>DEM</th>
<th>EUR</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC</td>
<td>DEM</td>
<td></td>
<td>EUR</td>
<td></td>
</tr>
</tbody>
</table>

LC = CC
LC ≠ CC
CC = FC

LC = Local currency
CC = Contract currency
FC = Foreign currency (participating currency)

1. Before the contract currency changeover (01/05/1999) from DEM to EUR, the loans are managed as local currency loans.
2. In the period between the contract currency changeover and the local currency changeover (01/05/1999 to 03/15/2001), the converted loans (as well as new euro loans) are managed as foreign currency loans.
3. After the local currency changeover (03/15/2001), the loans are managed as local currency loans again.

4: Contract currency changeover of foreign currency loans before the local currency changeover

LC ≠ CC
LC = DEM / CC = FRF before 01/01/1999
LC changeover on 03/15/2001 as at 01/01/2001 (start of fiscal year)
CC changeover on 10/12/1999
Before the contract currency changeover (10/12/1999) from DEM to EUR, the loans are managed as foreign currency loans.

2. In the period between the contract currency changeover and the local currency changeover (10/12/1999 to 03/15/2001), the loans are still managed as foreign currency loans.

3. After the local currency changeover (03/15/2001), all the euro loans are managed as local currency loans.

You can also convert the contract currency from a participating EMU currency to the euro if the local currency is not a participating currency.

Features

The changeover involves three steps:

- Preparation activities [Page 49] (general activities and activities per loan contract)
  - Here, you ensure that all the prerequisites for the changeover have been fulfilled.
- Conversion [Page 62]
  - You can convert individual contracts or use the mass processing function to convert several loans at once.
- Cleanup activities [Page 80]
  - Check log
  - Perform balance sheet transfer

Constraints:

The system does not offer a general contract currency conversion function (for example, from USD to FRF). It only supports the changeover of a currency participating in EMU to the euro (according to the settings in Customizing).

Additional Functions

- Reset:
Contract Currency Changeover (TR-LO)

You can only reset the changeover directly after the changeover has been carried out. You should only use this function if no postings have been made since the changeover, or if any such postings have been reversed.

- The reset function reverses the contract currency changeover.
- During the contract currency changeover, all the relevant loan data is saved to backup tables. If the contract currency changeover is reset, the system uses the data from these backup tables.
- You can only reset the changeover if no postings have been made since the changeover.
- You must reverse any postings made after the contract currency changeover.
- The reset function uses the original data from the backup tables, except for payment splitting data and payment advice data. You may need to postprocess this data manually, in which case there will be a corresponding note in the changeover log.
- The system automatically converts the flows that are reversed for the reset and the corresponding reversal flows from euros into the original currency. Any flows in euros that you reverse before the reset must be posted back in the original currency after the reset.

- To reset a contract currency changeover you have already made, choose Loans → Portfolio → Contract Currency Changeover to the Euro → Reset Currency Changeover.

- Enter the selection and control parameters.
- To reset the changeover, choose Execute.

**Correspondence:**

You can generate correspondence with a dual currency display. In this case, the amounts are shown in both the original currency or local currency and in euros.

To make use of this option, you must change the Customizing settings for correspondence accordingly.

The following sections describe the preparation activities, the conversion process and the cleanup activities required for the contract currency changeover to the euro.
Contract Currency Changeover: Preparations

Purpose

The following sections describe the general preparation activities and the preparation activities required for each loan before the loans are actually converted.

- General Preparation Activities [Page 50]
- Preparation Activities per Loan Contract [Page 56]
- Preparation Activities for Mass Processing [Page 59]

To keep your system performance stable, we recommend that you distribute the loan conversions as evenly as possible over the dual currency phase.
General Preparation Activities

Features
This section covers the general preparation activities required to ensure that the contract currency changeover is error-free.

Activities
You need to carry out the following activities before the contract currency is actually converted:

- Set up accounts for the contract currency changeover [Page 51]
- Value foreign currency loans [Page 52]
- Make customizing settings [Page 53]
Contract Currency Changeover: Accounts

Activities

1. Make sure that you can make postings to each balance sheet account in FI in both euros and the original currency. (This is always the case if the currency of the balance sheet account is the local currency. You can use the validation function in FI to restrict the postings to certain currencies.)

2. Set up clearing accounts for the postings from the contract currency changeover, such as:
   - a clearing account for currency swap postings
   - a clearing account for adjustments to capital amounts
   - a clearing account for adjustments to balances

The postings made during the contract currency changeover include the following:

Currency swap postings for:
   - Balance sheet positions
   - Accruals/deferrals (premium/discount)
   - Open items

Adjustment postings (for rounding differences):
   Adjustments to capital amounts
   - Remaining capital
   - Disbursement commitment
   - Interest calculation capital

Balance adjustment
(incoming payment processing in the subledger)
Valuing Foreign Currency Loans

Prerequisites

If you have loans in a participating EMU currency that were originally foreign currency loans, you must carry out a foreign currency valuation before you change over the contract currency.

- If you do not value foreign currency loans before you change over the contract currency, problems arise when you carry on processing the loan. Before the start of the dual currency phase, you must therefore perform a (one-time) foreign currency valuation for all loans in currencies participating in EMU (that differ from the local currency).

- You must value all the relevant foreign currency loans using a one-step valuation principle that calculates the full valuation gain or loss.

Procedure

Valuation

1. Choose Loans → Accounting → Period-End Closing → Valuation of Foreign Currency Loans. Run the valuation for all loans where the contract currency is a participating currency for EMU and differs from the local currency.

2. Maintain the flow types for write-ups and write-downs in Customizing. Assign the flows to the flow category XD and maintain the Customizing settings for accounting.

3. You must also define a corresponding valuation principle in Customizing. The principle you select must disclose the valuation gain or loss up to the key date. You choose this valuation principle on the selection screen for foreign currency valuation.

Special items for gains and losses resulting from fixed euro rates

The system posts gains and losses resulting from the changeover to the euro to the accounts for realized gains and losses.

If you opt to create special items for these gains and losses, you need to do this manually in FI. You also need to write back the special items manually.
Customizing Settings

Prerequisites

Before you can carry out the contract currency changeover, you also need to make some general settings which do not only apply to the Loans component. If you are already using other SAP R/3 modules, you may already have made some of the settings detailed in steps 1. and 2. of the procedure.

Procedure

1. Defining the euro currencies: In R/3 Customizing, choose Global Settings → Currencies.

2. Define the participating currencies and the euro in R/3 Customizing under Treasury Management → Basic Functions → Euro Currencies → Define Participating Currencies for Euro Changeover.

   In the Loans area (TR-LO), you can only change over the contract currency for currencies defined as participating currencies in this table.

   You can only convert the contract currency to the currency that is defined as the target currency in Customizing. When it converts the contract currency, the system also checks whether the currency of the loan to be converted is defined in the translation table in Customizing and whether a fixed rate exists for the currency pair "currency to be converted - target currency".

3. Define the flow types for adjustment postings and currency swap postings.

   In R/3 Customizing, choose Treasury Management → Loans → Transaction Management → Flow Types → Define Flow Types.

Sample Customizing entries delivered with the system (from Release 4.5A):

<table>
<thead>
<tr>
<th>Flow type</th>
<th>Name</th>
<th>Flow category</th>
<th>Calculation category</th>
<th>Activity ID</th>
<th>Activity category</th>
</tr>
</thead>
<tbody>
<tr>
<td>0910</td>
<td>A_Increase disbursement commitment euro</td>
<td>EUA+</td>
<td>NOOP</td>
<td>07</td>
<td>0023</td>
</tr>
<tr>
<td>0915</td>
<td>A_Reduce disbursement commitment euro</td>
<td>EUA-</td>
<td>NOOP</td>
<td>08</td>
<td>0024</td>
</tr>
<tr>
<td>0920</td>
<td>A_Increase remaining capital euro</td>
<td>EUR+</td>
<td>NOOP</td>
<td>07</td>
<td>0023</td>
</tr>
<tr>
<td>0925</td>
<td>A_Reduce remaining capital euro</td>
<td>EUR-</td>
<td>NOOP</td>
<td>08</td>
<td>0024</td>
</tr>
<tr>
<td>0930</td>
<td>A_Increase interest calculation capital euro</td>
<td>EUZ+</td>
<td>AA</td>
<td>07</td>
<td>0023</td>
</tr>
<tr>
<td>0935</td>
<td>A_Reduce interest calculation capital euro</td>
<td>EUZ-</td>
<td>SS</td>
<td>08</td>
<td>0024</td>
</tr>
<tr>
<td>0940</td>
<td>A_Currency swap position inflow</td>
<td>2UBZ</td>
<td>NOOP</td>
<td>07</td>
<td>0023</td>
</tr>
</tbody>
</table>
For the currency swap of the balance sheet position, you need to set the flow categories to 2UBA and 2UBZ. During the changeover, the system changes these flow categories to EUUB. You need to make the settings in this way to enable the system to determine the flow types automatically. The flow categories are replaced to prevent the flows from being taken into account for evaluations.

Flow types for currency swap postings and adjustments to capital amounts: See above.

Flow types for adjustments to balances: See the standard Customizing settings delivered with the system and Note 24254.

4. Before the changeover, you must assign the flow types defined in step 3 to the application function.

   In R/3 Customizing, choose Treasury → Treasury Management → Loans → Transaction Management → Condition Types → Define Condition Groups.

   For the contract changeover, assign all the above flow types to the application function (Appl.func.) 850. To reset the contract changeover, assign all the flow types with the flow categories EUUB, 2UBA and 2UBZ to the application function 851.

5. Make the following settings for currency swap postings for open items:
   - Define two flow types for the currency swap posting for each (original) flow type that generates an open item (such as debit positions, overpayments).
   - Assign the currency swap flow types to the original flow types as offsetting flows.
     Relationships for currency swap postings for accrual/deferral: 100,101
     Relationships for balance adjustments: 102,103
     Relationships for currency swap postings for open items: 104, 105

   See also:
   - Note 111 785: Currency swap postings for accrual/deferral (discount/premium)
   - Note 124 254: Balance adjustments

6. Define account determination for the flow types.

   In R/3 Customizing, choose Treasury → Treasury Management → Loans → Functions → Accounting → General Ledger Update → Define Account Determination.
7. Define a valuation principle that allows write-ups and write-downs up to the key date. In Customizing, choose Treasury → Treasury Management → Basic Functions → Accounting → Valuation → Define One-Step Valuation Principles.

   In the Valuation loss field on the detail screen, choose '2' (Valuation loss up to key date value). In the Valuation gain field, choose '4' (Valuation gain up to key date value).
Preparation Activities per Loan Contract

Features
This section covers the preparation activities per loan contract which are required to ensure that the contract currency changeover is error-free.

Activities
You need to carry out the following activities before the contract currency is actually converted:

- Process suspended data [Page 57]
- Empty the rollover files [Page 58]
Processing Suspended Data

Prerequisites
Data is suspended when the release function is set to active and loans or flow records relating to a loan are in release status.

Procedure
1. If suspended data exists, process and release the data before you convert the loan.
   In the Loans application menu, the following functions are available for releasing suspended data:
   a) Portfolio → Release
   b) Accounting → Release
2. If suspended data still exists when you run the conversion, the system automatically writes a message to the log saying that the loan was not converted.
Emptying the Rollover Files

Prerequisites
This step is only necessary if there are loans in the rollover file.
The system checks for this automatically. If a loan is still in the rollover file, the system displays a message. These loans cannot be changed over to the euro.

Procedure
If you still want to change such a loan, you must remove it from the rollover file first.

1. Choose Portfolio → Roll over.
2. In the rollover screen, choose Rollover → File → Edit.
3. For more information about how to remove a loan from the rollover file, see Editing Files [Ext.].
Preparation Activities for Mass Processing

Use

In order to use the mass processing functions, you need to make additional settings in Customizing for process management. You do not need to change the settings for the contract currency changeover to the euro, assuming the settings have already been made for converting individual contracts.

See also: Customizing Settings for Mass Processing [Page 60].
Customizing Settings for Mass Processing

Procedure

Also refer to the IMG documentation for process management. Choose Treasury → Treasury Management → Loans → Functions → Process Management.

The documentation describes how to define the selection fields for filling the files (Define Logical Fields), how to define the registers and report functions and how to assign the functions to registers.

Example of a possible process flow:

1. Select the loans in the ‘UB’ register.
2. Convert the contract currency to the euro (loans converted successfully are moved to the ‘CO’ register).
3. Send a letter to notify the borrower of the conversion.

Example

Define activity type:

In R/3 Customizing, choose Treasury → Treasury Management → Loans → Functions → Process Management → Define Activity Type.

For the contract currency changeover, you need to create files with activity type E or P (P is possible, but not recommended). If the loan is in a file with a different activity type, the system does not check whether a loan is already in a rollover file or euro file when you convert loans on an individual basis.

Define registers (activity type E):

In R/3 Customizing, choose Treasury → Treasury Management → Loans → Functions → Process Management → Define Register.

<table>
<thead>
<tr>
<th>Register</th>
<th>Name</th>
<th>Short name</th>
<th>Display ranking</th>
<th>Register type</th>
<th>Remove loan</th>
<th>Target reg.</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS</td>
<td>Suspended</td>
<td>Suspended</td>
<td>4</td>
<td>A</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CF</td>
<td>Contract currency changeover to euro completed</td>
<td>Conversion complete</td>
<td>2</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>CO</td>
<td>Print euro contract currency changeover</td>
<td>Correspondence</td>
<td>3</td>
<td>-</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>UB</td>
<td>Not processed</td>
<td>Not processed</td>
<td>1</td>
<td>D</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

Define report functions (activity type E):

In R/3 Customizing, choose Treasury → Treasury Management → Loans → Functions → Process Management → Define Report Functions.
Customizing Settings for Mass Processing

<table>
<thead>
<tr>
<th>FCode</th>
<th>Name</th>
<th>Short name</th>
<th>Function call</th>
<th>Cardinal cat.</th>
<th>Test run ID</th>
<th>Log level</th>
</tr>
</thead>
<tbody>
<tr>
<td>EURO</td>
<td>Contract currency changeover to the euro</td>
<td>Euro changeover</td>
<td>RFVDEMU3</td>
<td>N</td>
<td>C</td>
<td>9</td>
</tr>
<tr>
<td>POFU</td>
<td>Fill file</td>
<td>Fill file</td>
<td>RFVDPSF1</td>
<td>N</td>
<td>B</td>
<td>9</td>
</tr>
<tr>
<td>ADDR</td>
<td>Notification of contract curr. changeover to euro</td>
<td>Notification</td>
<td>RFVDPF01</td>
<td>N</td>
<td>B</td>
<td>9</td>
</tr>
</tbody>
</table>

### Target reg. 

<table>
<thead>
<tr>
<th>Target reg.</th>
<th>Target reg. cat.</th>
<th>Remove loan</th>
<th>Ref. date ID</th>
<th>MFile CoCd cat.</th>
<th>Print date ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>CF</td>
<td>C</td>
<td>C</td>
<td>D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>UB</td>
<td>C</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CO</td>
<td>C</td>
<td>C</td>
<td>D</td>
<td>A</td>
<td></td>
</tr>
</tbody>
</table>

### Assign functions to register (Activity type E):

In R/3 Customizing, choose Treasury → Treasury Management → Loans → Functions → Process Management → Assign Functions to Register.

<table>
<thead>
<tr>
<th>SR</th>
<th>FCd</th>
<th>File</th>
<th>MnF</th>
<th>GnF</th>
<th>Df</th>
<th>DR</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS</td>
<td>MPAV</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>9</td>
</tr>
<tr>
<td>AS</td>
<td>SLG1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>CF</td>
<td>EMU2</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>CF</td>
<td>MPAV</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>9</td>
</tr>
<tr>
<td>CF</td>
<td>SLG1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>CF</td>
<td>VTDR</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>1</td>
</tr>
<tr>
<td>CO</td>
<td>MPAV</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>9</td>
</tr>
<tr>
<td>UB</td>
<td>EMU1</td>
<td>x</td>
<td></td>
<td></td>
<td>x</td>
<td>2</td>
</tr>
<tr>
<td>UB</td>
<td>EURO</td>
<td>x</td>
<td></td>
<td></td>
<td>x</td>
<td>1</td>
</tr>
<tr>
<td>UB</td>
<td>MPAV</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
<td>9</td>
</tr>
</tbody>
</table>

### Check installation parameters:

In R/3 Customizing, choose Loans → Basic Settings → Installation Parameters.

Define the following report parameters for generating the process management log:

<table>
<thead>
<tr>
<th>Description</th>
<th>Report parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>X.65.132</td>
</tr>
<tr>
<td>Number of lines</td>
<td>65</td>
</tr>
<tr>
<td>List width</td>
<td>132</td>
</tr>
</tbody>
</table>
Conversion of the Contract Currency

Purpose
The following sections describe how the relevant tables are converted (report program RFVDEMU1) and how the rounding differences and open items are processed.

- Checking the Incoming Payments Level
- Conversion of Master Data
- Conversion of Flow Data
- Conversion of Borrower's Note Orders
- Loans Rolled Over
- Generating and Posting Adjustment Flows
- Currency Swap Posting: Loan Position
- Currency Swap Posting: Open Items
- Currency Swap Posting: Premium/Discount
- Adjustments to Balances

The system saves the original values in special backup tables.

Updating the cash flow in Cash Management
When you run a planned record update, the cash flow in Cash Management is updated automatically. You can choose to have the planned records updated automatically when the contract currency is converted.

If you run the changeover without the planned record update, the system updates the Cash Management records when you carry out the next planned record update.

To change over a loan, choose Loans → Portfolio → Contract Currency Changeover to the Euro → Currency Changeover.

Also refer to the table described in the section headed Conversion of Drawings on Disbursement [Page 67].

For performance reasons, the number of open items to be converted should be reduced to a minimum.
Checking the Incoming Payments Level

Prerequisites

In order to clear the overpayments for an incoming payment distribution level automatically, all the loans for an incoming payment distribution level must be in the same currency. This means that all the loans in the incoming payment distribution level need to be converted.

Procedure

The system checks whether there are any other loans in the incoming payment distribution level and displays them on the screen. If you confirm that these loans should also be converted, the system converts the additional loans.

You want to convert loan 10000002. The system runs the check and recognizes that loan 10000001 also belongs to the IP distribution level Finance project level in finance project PROJECT1.

<table>
<thead>
<tr>
<th>Loan</th>
<th>Finance project</th>
<th>IP distribution level</th>
</tr>
</thead>
<tbody>
<tr>
<td>10000001</td>
<td>PROJECT1</td>
<td>Finance project variant</td>
</tr>
<tr>
<td>10000002</td>
<td>PROJECT1</td>
<td>Finance project variant</td>
</tr>
<tr>
<td>10000003</td>
<td>PROJECT1</td>
<td>Contract variant</td>
</tr>
<tr>
<td>10000004</td>
<td>PROJECT3</td>
<td>Finance project variant</td>
</tr>
<tr>
<td>10000005</td>
<td>PROJECT1</td>
<td>Customer variant</td>
</tr>
</tbody>
</table>

If you still want to convert an individual loan, choose Change contract and change the IP distribution level to Contract variant. After the changeover, you can only assign the loan to the original IP distribution level when all the related loans have been converted.
Conversion of Master Data

During the changeover, the following master data is converted automatically:

- Loan master data (currency keys, contract currency amounts)
- Condition headers (currency keys, contract currency amounts)
- Condition items (currency keys, contract currency amounts)
- Advice note data
- Data related to payment splitting

For more information on the data for advice notes and payment splitting, see OSS Note 119759.

Changes to the Account Assignment Reference

The currency-dependent settings allow you to define individually which currency is permitted for each balance sheet account.

If the account assignment reference is currency-dependent and the currency is changed, the system writes a record noting the required balance sheet transfer. If no postings have been made for the loan, the system merely changes the account assignment reference.

The system determines the account assignment reference automatically on the basis of the settings in Customizing (Treasury → Treasury Management → Loans → Functions → Accounting → General Ledger Update → Control automatic determination of account assignment ref.).
Conversion of Flow Data

The system converts a loan on a specified key date, taking into account any translation or rounding differences. The contract number stays the same.

After the changeover, only the new flows for the rounding differences indicate that the loan was originally created in a different currency.

In the cash flow, the rounding differences for each type of capital amount (remaining capital, disbursement commitment and interest calculation capital) are displayed using separate flow types.

During the changeover, the following flow data is converted:

- Document items / cash flow:
  - All actual records
  - Planned records not based on conditions are converted.
  - Planned records based on conditions are deleted in the original currency. They are then regenerated using the conditions that have been converted to euros (they are visible in the cash flow when you carry out a planned record update).

- Drawings on disbursements
Conversion of Borrower’s Note Loan Orders

Borrower’s note loan orders are converted in the same way as the flow data.

For more information, see Conversion of Flow Data [Page 65]
Conversion of Drawings on Disbursement

The system converts the following data for drawings on disbursements:

- Currency keys
- Currency amounts

The system does not convert any local currency amounts. Amounts in local currency are converted as part of the local currency changeover.

Tables and fields in the Loans component affected by the contract currency changeover:

<table>
<thead>
<tr>
<th>Table</th>
<th>Objects converted</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDARL</td>
<td>Currency keys, currency amounts</td>
</tr>
<tr>
<td>VZZKOKO</td>
<td>Currency key of condition header, commitment capital of contracts</td>
</tr>
<tr>
<td>VZZKOPO</td>
<td>Currency keys and amounts of condition items</td>
</tr>
<tr>
<td>VDBEPP</td>
<td>Planned flows, currency keys, currency amounts and exchange rates</td>
</tr>
<tr>
<td>VDBEPI</td>
<td>Actual items (document items in the subledger), currency keys, currency amounts and exchange rates</td>
</tr>
<tr>
<td>VDAUSZ</td>
<td>Drawings on disbursement (where drawings exist), currency keys and currency amounts</td>
</tr>
<tr>
<td>VDORDER</td>
<td>Orders (for borrower’s note loans), currency keys, currency amounts and exchange rates</td>
</tr>
<tr>
<td>VDAVIS</td>
<td>Currency amounts (see Note 119759)</td>
</tr>
<tr>
<td>VZZUSP</td>
<td>Currency amounts (see Note 119759)</td>
</tr>
</tbody>
</table>
Rollover

Procedure

- If loans have been rolled over, the system adjusts the commitment capital in euros.
- The commitment capital for the rollover is calculated on the basis of the cash flow for the existing commitment capital and other amounts.
- When the contract currency is converted, the system calculates the commitment capital (for the last rollover) in the same way as it was calculated originally, but this time on the basis of the cash flow in euros. As a result, there are no rounding differences.
Generating and Posting Adjustment Flows

For an example of an adjustment posting, see Currency Swap Posting: Loan Position [Page 72]

Procedure

- When the system converts and adjusts the capital amounts, it takes all the actual records that exist when you run the conversion into account (if there is a disbursement commitment, planned disbursements are also considered). The remaining capital is adjusted to reflect business practice, while the interest calculation capital and disbursement commitment is adjusted for technical reasons.

- Since rounding differences can affect the interest calculation, the system clears the rounding differences by making a one-time adjustment to the interest calculation capital on the conversion key date.

- If the loan was already fully disbursed before conversion, and rounding differences arise, the system generates an adjustment flow to set the value of the disbursement commitment back to zero.

- The system also adjusts the remaining capital amount disclosed to the borrower. Any differences arising from the conversion are adjusted automatically and the corresponding postings transferred to FI.

- When capital amounts are converted (interest calculation capital, disbursement commitment, remaining capital), the system adjusts for any rounding differences.

- Adjustment amounts resulting from adjustment postings for the interest calculation capital and disbursement commitment are only posted in the loans subledger, and not in FI. You must set up account determination for the relevant flows (0930, 0935, 0910, 0915):
  - Clearing account for adjustments to capital amounts to clearing account for adjustments to capital amounts

- Adjustment amounts for adjustment postings for the remaining capital are posted in FI. Account determination for flow types 0920 and 0925:
  - Balance sheet account to clearing account / Clearing account to balance sheet account
Currency Swap Posting: Open Items

Prerequisite
For the currency swap posting, you must be able to make postings to the clearing account for the currency swap and the balance sheet account in both euros and the original currency.

Procedure
The customer open items resulting from a loan may be arrears or overpayments. These open items are converted during the contract currency changeover by means of a currency swap posting. The original amount is taken off the customer account, translated into EUR and then posted back to the customer account in EUR.

For performance reasons, the number of open items to be converted should be reduced to a minimum.

Posting record:

Outflow:
- Debit currency swap clearing account
  - 100.00 DEM
- Credit Customer 1:
  - 100.00 DEM

Inflow:
- Debit Customer 1:
  - 51.34 EUR
- Credit currency swap clearing account
  - 51.34 EUR

The local currency amount is identical for both postings.

No adjustment posting is necessary.

The currency swap postings are made via a currency swap account. For each posting, the balance in local currency is zero.

Balance sheet account:
- The system takes the proportional position off the FI balance sheet account in the original currency and posts it back in euros, adjusting for rounding differences where necessary (remaining capital).

Customer account for open items:
- The system takes the open item in the original currency off the account and posts the corresponding amount in euros.

Accrual/Deferral:
The system takes the portion of the discount/premium that has not yet been written back off the accrual/deferral account in original currency and posts it back in euros.
Currency Swap Posting: Loan Position

Prerequisite
For currency swap postings (for loan positions, open items and discounts/premiums) you must be able to make postings to the clearing account for the currency swap (and other relevant accounts, such as the balance sheet account) in both euros and the original currency.

Procedure
- The system performs a currency swap posting for the proportional loan balance in the balance sheet account in FI.
- The system determines the remaining capital in the original currency via the cash flow and posts this amount from the balance sheet account to a clearing account for currency swap postings.
- The system determines the remaining capital in euros on the basis of the euro cash flow, and posts this value back to the balance sheet account.

Example of a currency swap posting for a loan position

Remaining capital:

<table>
<thead>
<tr>
<th>Rate DEM / EUR</th>
<th>1.95583</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DEM</td>
</tr>
<tr>
<td>Disbursement</td>
<td>100,000.00</td>
</tr>
<tr>
<td>Repayment</td>
<td>- 50,000.00</td>
</tr>
<tr>
<td>Remaining capital (from flows)</td>
<td>50,000.00</td>
</tr>
<tr>
<td>Remaining capital (translated directly)</td>
<td>50,000.00</td>
</tr>
<tr>
<td>Rounding difference</td>
<td></td>
</tr>
</tbody>
</table>

Example of differences for capital amounts:
The system makes the following calculations:
- The capital amounts are calculated on the basis of the cash flow in the original currency:
  Remaining capital (from flows): 50,000 DEM
- The capital amounts in the original currency are translated into euros using the fixed rate (direct currency translation).
  Remaining capital (direct translation): 25,564.59 EUR
- The cash flow is translated from the original currency into euros record by record.
- The capital amounts are calculated on the basis of the cash flow in euros:
  Remaining capital (from flows): 25,564.60 EUR
Calculation of the rounding difference: 0.01 EUR

Relevant capital amount: Remaining capital translated into euros (directly): 25,564.59 EUR

**Posting records in FI in transaction currency:**

**Outflow:**
- Debit currency swap clearing account
  - 50,000 DEM
- Credit balance sheet account
  - 50,000 DEM

**Inflow:**
- Debit balance sheet account
  - 25,564.60 EUR
- Credit currency swap clearing account
  - 25,564.60 EUR

The local currency amount is identical for both postings.

**Post adjustment flow for remaining capital**

**Posting record:**
- Debit clearing account for capital amounts
  - 0.01 EUR
- Credit balance sheet account
  - 0.01 EUR

**Note:**
Since you cannot post a local currency amount of zero in FI, the adjustment comprises two postings for technical reasons. In the first posting, the balance sheet position is posted to a clearing account. In the second posting, the local currency amount is taken off the clearing account, since only the contract currency is to be adjusted.

**Example:**
Aim: Post 0.01 EUR = 0.00 DEM (LC)

**Postings:**
1. 0.01 EUR = 0.02 DEM (clearing account to balance sheet account)
2. 0.00 EUR = 0.02 DEM (balance sheet account to clearing account)

**T-account example:**
## Currency Swap Posting: Loan Position

<table>
<thead>
<tr>
<th>Balance sheet account</th>
<th>Clearing acct for currency swap</th>
</tr>
</thead>
<tbody>
<tr>
<td>230,075.28 DEM ₋</td>
<td>230,075.28 DEM ₋</td>
</tr>
<tr>
<td>118,129.69 EUR ₋</td>
<td>0.01 EUR ₋</td>
</tr>
<tr>
<td>0.01 EUR ₋</td>
<td>118,129.68 EUR ₋</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Clearing acct for changeover</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.01 EUR ₋</td>
</tr>
</tbody>
</table>

① Basis: Position in DEM
① Currency swap outflow
② Currency swap inflow (balance on local currency side after posting = 0)
③ Adjustment posting for remaining capital
④ Position in EUR after the contract currency changeover
Currency Swap Posting: Premium/Discount

Use

- The proportionate premium/discount on the FI account is translated from the original currency into euros by means of a currency swap posting.

- The system determines the remaining premium/discount on the basis of the cash flow in the original currency and posts this amount from the accrual/deferral account to a currency swap account (outflow).

- At the same time, it calculates the remaining premium/discount on the basis of the cash flow in euros and posts this amount from the currency swap account back to the accrual/deferral account (inflow).

- The system only makes currency swap postings for flow types with Flow category "TA" and Calculation category "TA" automatically when you run the contract currency conversion. These flows must be flagged as relevant for accrual/deferral. Flow types with the accrual/deferral method "0" (None or manual) are not taken into consideration.

- No adjustment flow is necessary.
Adjustments to Balances

Use

Document-based balance adjustments are adjustments which can be attributed to a single item. They are only carried out for loans that are managed on the basis of customer accounts.

Account-based balance adjustments cannot be attributed to a single item. They are carried out for loans that are managed on the basis of customer accounts as well as for those that are not.

Adjustments for rounding differences:

Adjustments to capital amounts
- Remaining capital (planned capital / effective capital)
- Disbursement commitment
- Interest calculation capital

Activities

- **Reconciliation:** In the subledger, incoming payments are cleared using the instalment payment procedure. In FI customer accounts, they are cleared using the residual balance procedure. As a result of the different procedures, there may be rounding differences after the contract currency changeover.

- **Document-based balance adjustments:** The system makes document-based balance adjustments for original flows (debit positions, overpayments) if the chain of clearing postings can be tracked using references. The system first tracks the chain of postings using invoice references. If there are no invoice references, the system uses the incoming payment document (RZEBEL) and the account (RSOLL/RHABEN) to track the chain. In this case, residual items are also included. If the balance within a chain is zero in the original currency, the chain is regarded as complete. A document-based balance adjustment is entered as an additional item in the document of the original flow. If adjustments were calculated using an invoice reference, the reference flow type is the same as the flow type for the original flow. Otherwise, the reference flow type is the same as the flow type for the balance adjustment. Balance adjustments can only occur if more than one flow was used to clear the original flow.

- **Account-based balance adjustments:** If document-based balance adjustments cannot be calculated because references are missing or incorrect, the corresponding flows are considered in the account-based balance adjustment. Account-based balance adjustments are only posted in the subledger.

- **Example:**
  Without the balance adjustment, there is a balance of 0.01 EUR in the subledger. In this case, the borrower would have to pay 0.01 EUR (assuming that the subledger shows receivables...
due from the borrower). The customer account, on the other hand, is still cleared. There is no corresponding open item.

- The document-based balance adjustment clears the receivable item by adjusting the amount of the original flow.

- The balance adjustments are only recorded in the subledger. They are not posted in FI.

Example of a document-based balance adjustment (exchange rate 1.90 DEM/EUR)

The original flows (interest debit positions) are reversed after the contract currency changeover. This results in an overpayment of 2 x 5.26 EUR. Without a balance adjustment there would be a residual receivable item of 0.01 EUR that would need to be processed manually. The balance adjustment fully clears the receivable item. If an adjustment is used in a reversal posting, it is also posted in FI.

<table>
<thead>
<tr>
<th>Flow</th>
<th>Doc.</th>
<th>Item</th>
<th>Debit</th>
<th>Credit</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interest deb. pos.</td>
<td>0001</td>
<td>1</td>
<td>20.00 DEM</td>
<td></td>
<td>10.53 EUR</td>
<td>0.01 EUR</td>
</tr>
<tr>
<td>Interest deb. pos.</td>
<td>0001</td>
<td>2</td>
<td></td>
<td>10.00 DEM</td>
<td>5.26 EUR</td>
<td>5.26 EUR</td>
</tr>
<tr>
<td>Interest inc. pmnt</td>
<td>0002</td>
<td>1</td>
<td>10.00 DEM</td>
<td></td>
<td>10.00 DEM</td>
<td></td>
</tr>
<tr>
<td>Interest inc. pmnt</td>
<td>0003</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Balance</td>
<td></td>
<td></td>
<td>0.00 DEM</td>
<td></td>
<td>0.00 EUR</td>
<td></td>
</tr>
</tbody>
</table>
Mass Processing

Use

From Release 4.5B, there is a mass processing function for converting the contract currency to the euro, which uses the existing process management functions.

Features

The use of process management allows you to map a simple conversion process in the system.

In contrast to other process management or rollover functions, loans do not remain in the output register if an error occurs during processing (for example, 'UB: Not processed). Instead, the loans are put into a suspended register. When processing is complete, all the loans which have not been converted are in the suspended register.

See also: Process Management [Ext.].

Activities

- During the changeover, the system generates a four logs.
  a. Process management log:

     This is the existing log for process management functions. When you convert the contract currency to the euro as a background job, the log is written to the spool. If you carry out the conversion online, the log is displayed on the screen.

  b. Log for contract currency conversion to the euro:

     This is the existing log for the contract currency conversion to the euro. You can call up the log via transaction SGL1 and object FTLE. There is a reference to this log in the log for process management.

  c. Posting log:

     This is the same as the log used for posting functions.

  d. Error log (postings containing errors)

     - The function for converting the contract currency is the same, regardless of whether you convert individual loans or use the mass processing option (refer to: Conversion of the Contract Currency [Page 62])

     - On the selection screen for contract currency conversion (individual processing), you can opt to put a loan in a file for mass processing.

     - The remaining capital in original currency on the conversion date is saved with the backup data for the loan and can be used in correspondence. This means that the remaining capital does not need to be recalculated on the basis of the backup data. The other capital amounts are not saved. The remaining capital amount is stored for both individual processing and mass processing.

     - The Test run indicator is not supported for the mass processing conversion option (RFVDEMU3). You should therefore deactivate the indicator when you define the report functions.
If you do set the *Test run* indicator, the system does not convert the loans.
Contract Currency Changeover: Cleanup

Purpose

In certain cases, you may need to perform cleanup activities after the contract currency changeover.

These activities are described in the following sections:

- Checking the Conversion Log [Page 81]
- Balance Sheet Transfer: Cleanup [Page 82]
- Adjusting Selection Criteria (TR-LO)
- Other Cleanup Activities [Page 83]

At the end of the dual currency phase, you need to ensure that all the loans have been changed over to the euro. To check for this, choose Portfolio → Process management in the Loans application menu.
Checking the Conversion Log

Procedure

- The system generates a log automatically during the changeover.
- To display the log at a later point in time, call up transaction SLG1, using the object FTLE.
- If errors occur during the conversion run, the loan is not converted.
- After the conversion run, the conversion log tells you the following:
  - Whether a flag has been set for the balance sheet transfer
  - Whether reference interest rates need to be postprocessed manually
  - Whether an error has occurred
    In this case, the loan has not been converted and is highlighted in red in the log.
- If you select an item in the list and choose Display message, the system displays a list of the steps in the changeover procedure. If errors occurred during the changeover, the corresponding place in the list is highlighted in red.
  If you select an item in this detail list and choose Long text, the system displays more detailed documentation.
  If you choose Back or Exit, you can call the log up again using the above transaction.
Balance Sheet Transfer: Cleanup

Prerequisites
If you have set up the system to determine the account assignment reference automatically on the basis of the currency, the contract currency changeover to the euro may result in a change to the account assignment reference.

Handling during the contract currency changeover:
- The system generates a flag for the balance sheet transfer
- You see that the flag has been set in the conversion log

- After you have run the conversion program, you must trigger the balance sheet transfer that was flagged. You can trigger the transfers individually or as a batch job.
- The balance sheet transfer has the following effect:
  - If the loan has not been posted, the system changes the account assignment reference in the contract data.
  - If the loan has been posted, the system changes the account assignment reference in the contract data and carries out a transfer posting between the corresponding balance sheet accounts in FI.

  See also: Note 126102

Procedure
- Choose Loans → Accounting → General Ledger → Balance Sheet Transfer.
- When you execute this function, the system automatically converts the currency-dependent account assignment reference and displays it on the screen.
- You cannot convert the account assignment reference manually.
Other Cleanup Activities

1. Edit reference interest rates manually.
2. The following are not converted automatically:
   - Collateral
   - Objects
   - Encumbrances
   - Collateral value calculations
   - Credit standing calculations
3. Check the selection criteria for files:
   If selection criteria that relate to amounts and/or currencies have been entered for a rollover or in activity management, you must check these criteria after the contract currency changeover and make any necessary adjustments.

Examples for rollover:
Selection criterion before the changeover:
   - Contract currency and local currency = DEM
   - All loans where the remaining capital amount >50,000 DEM are in file 1.
Selection criterion after the changeover:
   - Contract currency = EUR
   - Actual situation: All loans where the remaining capital amount > 50,000 (DEM) are in file 1.
   - Desired situation: All loans where the remaining capital amount > 25,000 (EUR) are in file 1.
4. Foreign currency loans:
   - In the case of foreign currency loans, changes in exchange rates result in exchange rate gains or losses. In the case of euro loans, the exchange rates are fixed. Despite the fixed rate, rate gains and losses can arise from rounding differences.
   - Examples of rate gains or losses from rounding differences (LC = local currency):
     - LC DEM, new loan is made in EUR
     - LC DEM, existing loan in DEM converted to EUR
     - LC EUR, existing loan in "old" local currency DEM
   - The system uses the existing algorithm with fixed rates to display gains and losses resulting from rounding differences in the cash flow.

Prerequisites:
If, as a result of the contract currency changeover, you have foreign currency loans for the first time, you must make the following Customizing settings:
Other Cleanup Activities

- Define flow types for rate gains and losses
- Assign the flow types to flow categories: Flow category XF - recalculate the capital amounts during the contract currency changeover
- Set up account determination
- If you already have foreign currency loans, you can use the existing Customizing settings for foreign currency loans.
- If no foreign currency loans have been granted so far, some loans may be treated as foreign currency loans in relation to the euro:
  - When the local currency is changed over to the euro, loans that were originally local currency loans become foreign currency loans.
  - When the contract currency is changed over to the euro, loans that were originally local currency loans become foreign currency loans.
  - If new loans are granted in euros before the local currency changeover, these are treated as foreign currency loans (until the local currency changeover).

In all of these cases, you must define flow types for rate gains and losses, assign them to the above flow category and make the settings for account determination.

5. **Updating fields for capital amounts:**

   **Use**

   The capital amounts stored in the file are not updated after conversion and are still displayed in the original currency. For performance reasons, the values are not updated in euros automatically.

   **Procedure**

   1. To update the capital amounts, choose `Portfolio → Rollover → File Processing → Update File`.

   2. The system displays the capital amounts in euros on the `Details about Loan` screen (Goto → Details).
      a. Choose `Rollover → File → Edit` and enter the values for the file in the initial screen.
      b. In the Edit File: File Overview screen, select a loan from the Register overview.
      c. Choose `Goto → Details`. The detail screen with the capital amounts appears.

   In the overview, the system displays the capital amounts in local currency. Since the local currency amounts are calculated by translating the foreign currency amounts, there may be rounding differences. However, these rounding differences are not relevant, since the fields are only descriptive.
Currency Changeover in Logistics
Currency Changeover in Sales and Distribution (SD)

Features

The following functions are available for the dual currency phase in the Sales and Distribution area (SD):

- Currency conversion in sales document processing
- Currency conversion for condition records
- Currency conversion for rebate agreements
- Currency conversion for customers
- Currency conversion for declarations to the authorities

For more information, see the Implementation Guide (IMG) for Cross-Application Components, European Monetary Union and go to Functions and Settings for the Dual Currency Phase → Sales and Distribution.
Currency Changeover in Materials Management (MM)

Use

During the dual currency phase, various data is to be converted, particularly customer and vendor data.

SAP differentiates between the following types of changeover:

- Direct Currency Changeover
- Currency changeover using the Euro Workbench

Features

Direct Currency Changeover

You can change over the currency for one or more vendors, selecting them by purchasing organization and account group.

You can change over:

- the default purchase order currencies in the vendor master record to the euro. The minimum order value is adjusted.
  
  Choose Environment \(\rightarrow\) Currency changeover \(\rightarrow\) Vendor.

- the currency for time-dependent conditions in info records, contracts, and scheduling agreements as well as customer-defined conditions as of a certain key date.
  
  Choose Environment \(\rightarrow\) Currency changeover \(\rightarrow\) Conditions.

Currency Changeover Using the Euro Workbench

Using the Euro Workbench, you can change over master data and transaction data for a certain key date. The Euro Workbench helps you to manage and plan the changeover from national currency to the euro, as well as assign the employees responsible.

You can process the currency changeover directly or create a workflow for currency changeover.

Choose Purchasing \(\rightarrow\) Environment \(\rightarrow\) Currency changeover \(\rightarrow\) Euro workbench.

See also: Euro Workbench [Page 105].
Currency Changeover in Retail (IS-R)

Purpose

In addition to the local currency changeover, your company will be greatly affected by various further changeovers taking place during the dual currency phase (planned for 01.01.1999 - 30.06.2002).

Some of these changeovers will take place outside your company (carried out by business partners) and you will have to plan others within your company. In the first instance, your business partners (vendors or customers) will announce that they wish to start transacting business in euros from a particular date. In addition to master data, there may be movement data, such as orders, as well as prices, conditions and agreements that will have to be converted to euros.

There are also a number of changeovers that need to be taken into account within your company. In some countries (Austria, for example), it is a legal requirement that dual prices (i.e. in euros and in the national currency) are displayed on all articles during the dual currency phase. This dual price display is voluntary in many other countries, but supplying the consumer with additional information could prove to be a strategic advantage for retailers there. In order to make full use of the possibilities offered by dual price displays, POS systems should be supplied with dual prices to make till receipts during this phase more comprehensible to consumers.

The currency that a store uses and in which, for example, the POS business volume is cumulated and the EAN codes are scanned, must also be changed to the euro at a date that you select yourself. This date should not coincide with the local currency changeover.

Your retail company will also have to convert those prices that have been rounded off in the national currency (9.99 DEM, for example), to rounded-off euro prices. In such cases, the calculation must be performed again and reassessed, due to small margins in Retail. Promotions and markdown planning are also affected by this changeover.

SAP Retail offers additional retail-specific functions to support the processes outlined above. Over and above these functions, you have the option of using a convenient Euro Workbench to coordinate the entire changeover process. This is supported by the SAP R/3 Workflow functionality.

Integration

A number of functional areas on different organizational levels within the SAP system are affected by the currency changeover.

The organizational levels affected include:

- Client
- Distribution chain
- Site

The functional areas include:

- Retail pricing (calculation changeover including rounding off to the nearest price point)
- Retail promotion (changeover of planning currency)
- Markdown planning (changeover of planning currency)
Agreements (agreement currency changeover and business volume comparison/agreement changeover)

Master data (e.g. POS currency changeover for a site)

It may be necessary to perform these changeovers at different times, either for logistic reasons (re-labeling, for example), or because business partners’ interests must also be taken into account. The following graphic illustrates this type of complex changeover scenario.

Using the Euro Workbench offers you a high level of integration when dealing with so many changeovers. It enables you to perform changeovers at different times while ensuring that you retain an overview of the whole project. Points to remember about the interplay of the various changeovers are described in the next chapter using detailed examples.

The level of integration in the SAP system becomes particularly clear when you use parallel prices. After a few Customizing changes have been made, this function is available throughout the following areas, for example:

- Labeling
- POS interface - outbound
- Assortment list
- Product catalog
- Sales order
- Delivery

Refer to:
Euro Workbench [Page 105]
ISR – SAP Retail: Currency Conversion (Euro) [Ext.]
Changeovers and Timing of Changeovers in Retail

The timepoints involved in the changeover and how these relate to each other play an important role in the changeover in Retail. The graphic uses an example to show these relationships for the changeover in the following functional areas:

- Sales price calculation
- Labeling
- POS systems
- Scanning

### Timepoints

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Scanning</td>
<td>DEM</td>
<td>Euro</td>
</tr>
<tr>
<td>Data in simple registers</td>
<td>DEM</td>
<td>DEM</td>
</tr>
<tr>
<td>Data in smart registers</td>
<td>DEM</td>
<td>Euro</td>
</tr>
<tr>
<td>Labeling</td>
<td>Compulsory: DEM</td>
<td>Compulsory: DEM</td>
</tr>
<tr>
<td>Prices calculated in new key currency (e.g. at category level)</td>
<td>DEM</td>
<td>Euro</td>
</tr>
</tbody>
</table>

Generally speaking, all changeovers must be completed by the end of the dual currency phase. This is also the only restriction on local currency changeovers, that can be performed at any time during the dual currency phase. The best time to do this is at the end of the business year. Further changeovers in Retail should, however be performed by 01.01.2002, when the euro becomes legal tender. This date should be kept in mind when implementing the three changeover stages described in more detail below.

**Timepoint 1**

By this date you should have set up your SAP system to ensure that parallel sales prices are available throughout. This means, for example, that you will now be able to display dual prices at any time, regardless of whether you do this voluntarily or for legal reasons. Even if your company does not use dual price displays, you should perform this changeover as early as possible, and in any case before 01.01.2002.
This will have the following effects on individual functional areas:

- **Sales price calculation**
  
  Sales price calculation is not yet affected; the calculated sales prices will continue to be rounded off to the nearest price point in the national currency.

- **Labeling**
  
  All sales prices are now available throughout the system in both the national currency and in euros and both forms can therefore be used in labeling. It is recommended that the sales price that has been calculated in the national currency (main sales price) is somehow emphasized on price labels that display dual prices.

- **POS systems**
  
  There is a difference between simple registers, which only recognize a single currency, and smart registers that can deal with several currencies. In the first instance, you must make sure at POS outbound processing that only the price in the national currency (the current main sales price) is used in supplying registers. This problem does not arise in the second instance as both sales prices are stored in the POS system in separate files.

- **Scanning**
  
  Scanning will continue to be performed in the national currencies. In smart registers, the scanner automatically takes the national currency price from the correct file.

**Timepoint 2**

The currency in which the sales prices are calculated and rounded off (main sales price currency) is converted from the national currency to euros for individual areas. As this changeover can be performed differently for different organizational levels (distribution chains, sites and price lists), it is advised that you carry out the changeover at different times for each level. This means that there are actually several versions of timepoint 2 (e.g. 2a, 2b, etc.).

This will affect individual functional areas as follows:

- **Sales price calculation**
  
  All affected sales prices are recalculated in euros, and the relevant parallel prices are then converted back into the national currency using a fixed rate.

- **Labeling**
  
  All sales prices will continue to be available throughout the system in both the national currency and in euros, allowing both forms to be used in labeling. It is recommended that the sales price that has been calculated in euros (the new main sales price) is somehow emphasized on price labels that display dual prices.

- **POS systems**
  
  If you are using simple registers, you must make sure at POS outbound processing that the parallel sales price in the national currency (converted from euros *without* rounding off) is now used in supplying registers.

  The sales price in the national currency is now determined using another condition type (in the standard system, for example, this would be *VKPE* for standard sales prices, and *VKAE* for promotional sales prices). This means that sales price
Changeovers and Timing of Changeovers in Retail

determination at POS outbound processing cannot be performed using condition types, but only using the currency of the POS registers.

- Scanning
  Scanning will continue to be performed in the national currencies.

**Timepoint 3**

At this point, scanner cash registers are to be converted from the national currency to euros.

⚠️

This may not take place before timepoint 1.

- Sales price calculation
  Sales price calculation is not affected.
- Labeling
  If you have not been using dual price displays, you will now need to re-label your stock.
- POS systems
  If you are using simple registers, you will now need to completely re-supply them.
- Scanning
  Scanning will now be performed in euros. In smart registers, the scanner automatically takes the national currency price from the correct file.

As far as the correlation of the timepoints mentioned is concerned, timepoint 1 has to come before timepoint 3, while you can set timepoint 2 for any time.
Site: Currency Conversion

Use
When you change over the currency for a company code, you do not have to convert all the POS systems at the associated sites to the new currency at the same time. You can continue to work in the old currency. The field POS currency is provided in the POS data of the site master in the system for this purpose. In this field, you define the currency in which a site makes the POS data available to the R/3 system.

Features
When you install the R/3 system or when you upgrade to Release 4.0 or higher, this field automatically contains the currency of the appropriate company code. This POS currency applies until you enter a new currency in the field - even if you change the company code currency.

The POS currency makes use of change documents and thus allows a history to be managed. This enables you to determine the currency valid at the time the till receipt was created, even after conversion has taken place.

Activities
1. Enter the new currency in the POS currency field of the site in question when you change over the POS system currency.
2. As far as possible, make sure that all POS documents are processed before the conversion.
3. Make sure that the new prices will be transferred to the POS systems involved once you have changed the POS currency.

You can execute these functions directly using reports, using SAP Business Workflow or the Euro Workbench.

See also:
ISR – SAP Retail: Sites [Ext.]
ISR – SAP Retail: Currency Conversion (Euro) [Ext.]
CA – European Monetary Union: Currency Changeover in Retail (IS-R) [Page 88]
CA – European Monetary Union: Euro Workbench [Page 105]
CA – European Monetary Union: POS Interface-Inbound: Currency Conversion (Euro) [Page 101]
Parallel Prices in the Dual Currency Phase

Use
During the dual currency phase of EMU, your company may have to denominate sales prices in both the national currency and in euros (for legal or competitive reasons).

The two prices are not independent of each other, but are linked by a fixed conversion rate. This means that only one of the two prices can be rounded off to the nearest price point (9.99 DEM, for example) at any one time. The sales price which has been rounded off (in the main sales currency) is called the main sales price, while the converted sales price (in the parallel sales currency) is the parallel sales price.

After you perform the conversion, the main sales price and the parallel sales price “exchange” currencies.

Before conversion:
- Main sales price: DEM 10.99
- Parallel sales price: EUR 5.96

After conversion:
- Main sales price: EUR 5.95
- Parallel sales price: DEM 10.97

Integration
Parallel sales prices are available throughout the system, including in the following applications:
- Labeling
- POS interface - outbound
- Assortment list
- Product catalog
- Sales order
- Delivery

Prerequisites
There must be a fixed conversion rate between the old and the new currency. If there was no fixed rate, fluctuations in the exchange rate would be detrimental to the whole conversion process.

Features
SAP Retail provides suitable settings to support parallel prices. These settings comprise the sales and distribution condition types VKPE and VKAE, the calculation formula 043 and the calculation schema VKP001.
When the system carries out price determination (at POS outbound processing, for example), the parallel prices are set for the aforementioned condition types, whereas VKPE is used for the standard sales price in the parallel sales currency and VKAЕ for the promotion sales price in the parallel sales currency. The currency conversion is carried out by the calculation formula 043 at the fixed conversion rate. Condition types VKPE and VKAЕ must be entered in the sales price calculation schema directly after the previously-used sales price condition types (these are VKP0 or VKA0 in the standard system). The calculation schema VKP001 contained in the system was created as a model and can be used for changing your own schemas.

**Activities**

- Change your own sales price calculation schemas in line with schema VKP001.
- You must enter the condition types for the parallel sales prices as allowed condition types for the POS outbound profile so that the parallel sales prices are also available in the POS systems.

**See also:**

ISR – SAP Retail: [Pricing: Currency Conversion](#)[Page 96]
ISR – SAP Retail: [Currency Conversion (Euro) [Ext.]](#)
CA – European Monetary Union: [Currency Changeover in Retail (IS-R)](#)[Page 88]
CA – European Monetary Union: [Euro Workbench](#)[Page 105]
Pricing: Currency Conversion

Use
Sales prices are usually calculated in the local currency of your company and rounded off to price points (such as 9.99). During the dual currency phase, your company will change over - all at once or in phases - from calculating prices in your national currency to calculating them in euros. You can convert your price calculations on various levels (distribution chain, site or price list level) and for specific merchandise categories, so that you do not have to deal with all the various logistical problems (updating the POS systems, re-denominating price tickets etc.) at one time.

After you convert your price calculations, all further prices are calculated in the new currency.

Prerequisites
There must be a fixed conversion rate between the old and the new currency. This prevents fluctuations in the exchange rate having a detrimental effect on the whole conversion process.

You must create price point groups in the new currency and assign them to the appropriate organizational units to enable you to round off the new prices to price points. You can assign price point groups to an organizational unit for each sales currency involved. This enables you to make the assignment to new price point groups long before you actually convert your price calculations.

Features
You can convert the sales prices of existing calculations at different times for different levels (distribution chain, site, price list) and merchandise categories.

The conversion is carried out in two phases. In the first phase, the system uses pricing documents to identify the calculations affected. It then generates new price calculations, taking the period of validity of the original price calculations into account. The system uses the planned markups already defined to calculate entirely new prices. The sales prices are rounded off to price points in the new currency in line with the price point groups assigned in Customizing.

Activities
To enable you to carefully control the conversion of the price calculations, SAP recommends you use the Euro Workbench to carry out the conversions. In using this interface, you can make use of the SAP Business Workflow to control and coordinate the whole process. As a coordinator, you can make use of a powerful search engine for selecting the price calculations to be converted by choosing New entries → Suggest entries. If you are an agent, you go directly to the price calculations to be converted.

You can use report RWVKP014 to convert price calculation data en masse. You can select price calculations based on a number of criteria, a key criterion being the previous sales currency. The system converts the selected price calculations to euros as described above.

All functions refer to the currency in which the relevant transactions are entered, and can therefore be converted independently of the general currency conversion in Financial Accounting.

See also:
ISR – SAP Retail: Pricing [Ext.]
ISR – SAP Retail: Currency Conversion (Euro) [Ext.]
CA – European Monetary Union: Currency Changeover in Retail (IS-R) [Page 88]
CA – European Monetary Union: Parallel Prices in the Dual Currency Phase [Page 94]
CA – European Monetary Union: Euro Workbench [Page 105]
Subsequent Settlement: Currency Conversion

Use

Arrangements made in Subsequent Settlement have a particular currency in which income and provisions for accrued income are displayed and in which they are updated in the Logistics Information System. The condition records of an arrangement can refer to value of the vendor business volume in terms of the scale basis (which determines the scale level reached) and the condition basis (which determines the income as per the scale level determined). Condition records may have their separate currencies (condition scale currency or condition currency). An arrangement can therefore have any number of different currencies. There is no fixed link, for example, to the company code currency.

When a currency is changed, you must change over the affected currencies for arrangements. You can also do this during the validity period of an arrangement.

<table>
<thead>
<tr>
<th>Reference (scale basis)</th>
<th>Value scale</th>
<th>Calculation rule (condition basis)</th>
<th>Fixed amount</th>
<th>Capability</th>
<th>Condition basis</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>e.g. above DEM 100 000</td>
<td>B</td>
<td>e.g. DEM 1 000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>e.g. DEM 0.01 per piece</td>
<td>C</td>
<td>e.g. DEM 0.01 per piece</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>e.g. DEM 1 per ton</td>
<td>D</td>
<td>e.g. DEM 1 per ton</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>e.g. DEM 1 per ton</td>
<td>E</td>
<td>e.g. DEM 1 per ton</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>e.g. DEM 1 per m³</td>
<td>F</td>
<td>e.g. DEM 1 per m³</td>
<td></td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>e.g. DEM 0.05 per point</td>
<td>L</td>
<td>e.g. DEM 0.05 per point</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The provision for accrued income for calculation rules C, D, E, F and L is also an amount in condition currency; for rule B it is a percentage. These amounts also have to be converted.

Prerequisites

There must be a fixed conversion rate between the old and the new currency. This prevents fluctuations in the exchange rate having a detrimental effect on the whole conversion process.

Features

In the course of a general currency changeover with fixed conversion rates, the following alternatives are possible:

- You convert the arrangement currency at a time of your choice (for example, when it best suits your vendor). After you make the switch, all settlements are made exclusively in the new currency. The basis for scales and conditions remain in the old currency, however. The condition records are not converted. The system operates in the background with the old arrangement currency. This avoids unnecessary recompilation of vendor business volume and income in the Logistics Information System. Since there is a fixed conversion rate between the two currencies, the conversions pose no problems.
You convert the arrangement currency when an arrangement is extended (for arrangements of a more long-term nature, where an arrangement calendar has been defined) and when you create an arrangement with reference. This also applies to changing the condition records and the currencies they contain. Income and provisions for accrued income are updated in the new arrangement currency for the extended arrangement. The currencies in the condition records can be changed at the same time.

The system issues warning messages if, when you are extending an arrangement or creating one with reference, you process an arrangement that contains currencies of the European Monetary Union (i.e. currencies with fixed conversion rates) that have still to be changed over.

### Activities

You can execute the functions required directly using reports, using the SAP Business Workflow or using the Euro Workbench (Convert Arrangement Currency).

All functions refer to the currency in which the relevant transactions are entered, and can therefore be converted independently of the general currency conversion in Financial Accounting.

You can make use of a powerful search engine for selecting the arrangements to be converted by choosing New entries → Suggest entries in the Euro Workbench.

Choose Customer arrangements to access arrangements for a particular condition beneficiary.

### Converting the arrangement currency

You can use program RWMBONE1 to convert the arrangement currency and program RWMBONE3 to convert customer arrangements. You can select arrangements based on a number of criteria, a key criterion being the arrangement currency. Alternatively, you can manually select the arrangements from those found by the system and carry out a test run first.

The report changes the contents of the database field KONA-WAERS. The first time you run it, it stores the old arrangement currency in the database field KONP-KWAEH of each condition record in the arrangement.

You can use the method RebateAgreementPur.ConvertCurrency in SAP Business Workflow. This function is integrated into the Euro Workbench.

Program RWMBONE2 generates work items for changing the arrangement currencies. Use program RWMBONE4 for customer arrangements.

Please note that you cannot change over the currency of arrangements for which final settlement has been carried out. Currencies in the condition records cannot be changed. The condition records are not changed.

The new arrangement currency defined in this function is the only valid currency for the arrangements created in the Extension and Create with reference functions. All the income and provision updates are made in the new currency.

### Currency conversion when arrangements are extended

Arrangements made in Subsequent Settlement that are valid for a longer period of time - for example, for several years or until they are revoked - are modeled in R/3 by several single arrangements (one arrangement per calendar or fiscal year, for example). A reference allows you to see exactly which arrangement is valid in which year.

You can extend arrangements manually or have the system do it for you.
Subsequent Settlement: Currency Conversion

**Manual extension of arrangements**

You can manually change all currencies (arrangement currency, condition scale currency and condition currency). Do not forget to maintain period-specific conditions. You can make use of the mass maintenance functions to change the condition currency. Mass maintenance of scales is not supported.

If, when you save the arrangement, it still contains a currency that has to be converted, the system displays a warning message. It informs you of every currency for which fixed conversion rates are defined.

You can use the method `Arrangement RebateAgreementPur.ExtendManuallyWithMod` in SAP Business Workflow.

No automatic extension is possible for arrangements you have already changed manually.

**Automatic extension of arrangements**

Alternatively, using report `RWMBON03` (or `RWMBON33` for customer arrangements), you can have the system automatically convert currencies in arrangements when they are extended. This procedure is best used for arrangements that only have one currency. You can select the arrangements using various selection criteria, one of the key criteria being the arrangement currency. You have the option of manually pre-selecting the arrangements and carrying out a test run first.

You can also have the system automatically change the scale condition currency and/or the condition currency. This is only possible in the new arrangement currency. You can enter a rounding rule in each case.

You use switches to determine whether condition records that are flagged for deletion may be converted. Other switches are available to enable you to prevent arrangements being converted if they contain a condition record that uses a currency different from the arrangement currency. You can differentiate between EMU and non-EMU currencies.

A currency is considered to be a European Monetary Union (EMU) currency if fixed exchange rates that apply for the whole period of the arrangement have been defined in the system. For information on which currencies this applies to, choose `Euro Currencies`.

You can use a switch to prevent arrangements with EMU currencies being extended if you want to process them manually.

The system checks whether an arrangement that has been extended contains currencies that are still relevant for conversion. It displays warning messages where necessary.

**See also:**

ISR – SAP Retail: [Subsequent Settlement](#) [Ext.]
ISR – SAP Retail: [Currency Conversion (Euro)](#) [Ext.]
CA – European Monetary Union: [Currency Changeover in Retail (IS-R)](#) [Page 88]
CA – European Monetary Union: [Euro Workbench](#) [Page 105]
POS Interface - Inbound: Currency Conversion

Use
For sales transactions, conversion to a new currency can take place at different times for the various parties involved, namely the customer, POS and head office. This creates a number of possible data combinations that need to be taken into account at POS - inbound.

Features
SAP Retail differentiates between the POS currency and the document currency.

- **POS currency**
  Currency in which the R/3 system makes POS data available to head office.
  
  The currency of the appropriate company code is automatically entered in this field when you install the R/3 system or when you upgrade to Release 4. This POS currency applies until you enter a new currency in the field - even if you change the company code currency.
  
  The POS currency makes use of change documents and thus allows a history to be managed. This enables you to determine the currency valid at the time the POS document was created, even after conversion has taken place.

- **Document currency**
  The currency set at the POS for the sales documents. If the POS system is not able to send this currency to head office, the POS currency is used as the document currency.

Activities
1. The system determines the POS currency that was valid when the sales document was created.
2. The system determines the document currency. If this was not entered in the sales document, the system uses the POS currency as the document currency.
3. If the POS currency and document currency are different, the system determines the conversion rate used by the POS. The document is posted in the document currency, but the exchange rate is used to convert the document currency to the POS currency in the document display and the POS statistics.
4. If necessary, the conversion exchange rate for the POS currency is determined for the means of payment. The means of payment are posted without being converted, but the exchange rate is used to convert the values into the POS currency in the document display and POS statistics.

⚠️
If the POS is not able to send the document currency, the document currency must be converted simultaneously in the POS and head office. If this is not done, the sales documents are posted with an incorrect currency.

See also:
ISR – SAP Retail: [Sites [Ext.]]
POS Interface - Inbound: Currency Conversion

ISR – SAP Retail:  
POS Interface - Inbound [Ext.]

ISR – SAP Retail:  
Currency Conversion (Euro) [Ext.]

CA – European Monetary Union:  
Currency Changeover in Retail (IS-R) [Page 88]

CA – European Monetary Union:  
Euro Workbench [Page 105]
Season: Currency Conversion in Markdown Planning

Use
When the currency of the main sales price is changed, prices in markdown planning must be converted to the new currency. This conversion is, however, only necessary for future markdown plans that are still in the planning stages.

Features
Markdown plans can be selected according to different criteria and displayed in a selection list. The prices for these markdown plans can be converted automatically to the new currency. Prices that have not yet been activated are converted to the new currency. Prices that have already been activated are converted to the new currency and then automatically activated.

Activities
- You can use the Euro Workbench to select the markdown plans that you want to convert to the new currency.
- The conversion of the selected markdown plans is performed automatically via the Euro Workbench. This converts all the prices to the new currency and saves them. The system automatically re-activates prices that were activated before the changeover.

See also:
ISR – SAP Retail Season: Markdown Planning [Ext.]
ISR – SAP Retail: Currency Conversion (Euro) [Ext.]
CA – European Monetary Union: Currency Changeover in Retail (IS-R) [Page 88]
CA – European Monetary Union: Euro Workbench [Page 105]
Promotions: Currency Conversion

Use
When the main sales price currency is changed, promotion prices have to be converted to the new currency. The conversion is, however, generally only necessary for future promotions that are still in the planning stages.

For promotions that are running at the time of the currency conversion, you can convert the pricing conditions at the same time as you convert all the other conditions. If prices in the promotion are to be converted, this has to be done separately using this function.

Features
Promotions can be selected according to different criteria and displayed in a selection list. Promotion prices for these promotions can be converted automatically to the new currency. These prices are not activated automatically. The converted prices have to be activated using the promotion follow-up processing.

Activities
- You can use the Euro Workbench to select the promotions that you want to convert to the new currency.
- The conversion of the selected promotions is performed automatically via the currency conversion interface. This converts all the promotion prices to the new currency and saves them.
- You have to activate the converted promotion prices separately in the promotion follow-up processing.

See also:
ISR – SAP Retail Promotion [Ext.]  
ISR – SAP Retail: Currency Conversion (Euro) [Ext.]  
CA – European Monetary Union: Currency Changeover in Retail [Page 88]  
CA – European Monetary Union: Euro Workbench [Page 105]
Euro Workbench

Purpose
The Euro Workbench groups together all the areas that have to be changed over during the dual currency phase, and makes it convenient for you to plan and execute the conversion. The SAP R/3 Workflow functions support you in this.

You can plan the changeovers of the individual areas independently of each other for specific key dates and assign people to be responsible for making the changeover. The system informs the people you assign in advance of the planned key date. They can then carry out the planned conversions using the Euro Workbench.

As the coordinator, you can use the interface to obtain an overview of the status of the project during the conversion phase.

Prerequisites
Two groups of people are involved in the currency changeover process:

- EMU coordinators (one or more people)
- EMU agents (usually more than one person)

Process Flow
1. The EMU coordinators plan the changeover using the Euro Workbench. The data they define includes the date of the changeover for a particular area and the responsible EMU agent.
   See: Preparing for the Currency Conversion [Page 106]

2. The system informs the EMU agents at the right time, and they then carry out the changeover with the help of the Euro Workbench.
   See: Executing the Currency Conversion [Page 107]

3. The EMU coordinators check and confirm the changeovers that have been carried out.
   See: Checking and Acknowledging the Currency Conversion [Page 108]

Result
The prepared changes are activated as planned on a specific key date.
Preparing for the Currency Conversion

Prerequisites
You want to prepare for converting an object as an EMU coordinator.

Procedure
1. Call up the Euro Workbench Graphic [Ext.].
   On this screen, you can call up all the functions required to convert all objects affected. The first row of pushbuttons (client, distribution chains, etc.) represents the conversion level. The second row (master data, price calculations etc.) represents the related conversion functions. These functions depend on the level selected.

2. Create a worklist for carrying out the currency conversions. To do this, first select the required conversion level (e.g. site) and the required conversion function (e.g. calculations) and choose Create.
   A maintenance screen appears. The fields displayed on this screen depend on the conversion object. For the combination of distribution chain/price calculation, for example, the fields Sales organization, Distribution channel and Merchandise category are displayed. This grouping together ensures that planned conversions for the price calculations in a distribution chain are carried out together later on for all the articles in a merchandise category.
   The screen also contains fields that are the same for all objects, such as Conversion date, Currency (before), Currency (after).

   You can make use of a powerful search engine for selecting objects to be converted by choosing Suggest entries.

3. Set the date of the changeover for a particular area and the responsible EMU agent (for example).

4. Save your entries.

Result
You have set both the date of the changeover for the selected object and the responsible EMU agent (for example).
Executing the Currency Conversion

Prerequisites
You want to convert an object as an EMU agent.

Procedure
1. Call up the Euro Workbench Graphic [Ext].
   On this screen, you can call up all the functions required to convert all objects affected. The first row of pushbuttons (client, distribution chains, etc.) represents the conversion level. The second row (master data, price calculations etc.) represents the related conversion functions. These functions depend on the level selected.

2. To select your personal worklist, choose For processing by me and then To be processed.
   An overview screen appears with a list containing variable and fixed columns. The variable columns depend on the conversion object selected. The fixed columns are a sub-set of the fixed fields on the initial screen. For the combination of distribution chain/price calculation, for example, the fields Sales organization, Distribution channel and Merchandise category are displayed. This grouping together ensures that conversions for the price calculations in a distribution chain are carried out together for all the articles in a merchandise category.

3. To execute the conversion directly from the overview screen, select the required lines in the list and choose Execute.
   The processing screen of the area concerned appears. You do not have to enter any data on the selection screen, unlike when you call up the transaction directly. The system determines the necessary data automatically. In Pricing, for example, the system breaks down the merchandise category into its constituent articles and checks whether a price calculation exists at site/article level in each case. Only existing price calculations are taken into account.

4. Process the objects that require processing and save your entries.

   When large volumes of data are involved, you can execute the program in the background.

Result
The selected object has been converted.
Checking and Acknowledging the Currency Conversion

Prerequisites
You want to check and acknowledge the conversion of an object as an EMU coordinator.

Procedure
1. Call up the Euro Workbench Graphic [Ext.].
2. To select your personal worklist, choose Coordinated by me and then Processing is completed.
   An overview screen appears with a list containing variable and fixed columns. The variable columns depend on the conversion object selected. The fixed columns are a sub-set of the fixed fields on the initial screen. For the combination of distribution chain/price calculation, for example, the fields Sales organization, Distribution channel and Merchandise category are displayed.
3. Check the conversions that have been carried out. To do this, branch into the application. However, this is not possible for every conversion object.
4. Acknowledge the conversion. To do this, select the relevant lines in the list and choose Acknowledge.

Result
The conversion was carried out and checked correctly.
Local Currency Changeover (CA-EUR-CNV)

Purpose
If your local currency is the currency of a country which is participating in European Monetary Union, you are legally required to change it over to the euro during the dual currency phase (01.01.1999 to 30.06.2002). For this purpose, you require translation programs which carry out the technical changeover (i.e. converting the local currency into euros) according to the legal translation rules.

Features
The system changes over the following:

- Local currency amounts from all documents in the system, and fixed amounts in Customizing tables
- Currency keys
- Exchange rates

Translating the local currency amounts produces rounding-off differences, which are intercepted and dealt with by reconciliation programs either during or after the changeover. Reconciliation is carried out both within individual documents and between datasets which are saved separately.

The changeover package contains:

- Programs for the local currency changeover.
- Reconciliation programs for dealing with rounding-off differences
- The option of including user-specific tables and user-defined developments in the R/3 System
Local Currency Changeover

Purpose

This process enables local currency to be changed over to the euro. This procedure fulfills all technical requirements, not however all commercial requirements.

You start local currency changeover in the Implementation Guide (IMG) by choosing Cross-Application Components → European Monetary Union: Euro → Local Currency Changeover. Ensure that you carry out all the activities listed in the IMG in the correct order and that you document these activities (by making notes in Customizing). This will help you follow the changeover process and enable you to demonstrate the steps you took.

Prerequisites

You have done the following:

- Analyzed the demands made by the changeover on your company and drawn up an appropriate changeover plan
- Included your various departments in your project plan and informed all affected employees
- Drawn up a schedule of events and allowed for the time that the system is blocked for the user

Process Flow

Prior to the actual changeover in your productive system, SAP recommends that you carry out a test changeover first. To do this, you set up a test system based on your productive system. If possible, copy the current database of your productive system. This will provide you with a realistic simulation of the actual changeover. Any errors and data inconsistencies can be analyzed and resolved in this test environment, without making changes in the productive system.

There are three stages in local currency changeover that are distinct both from an organizational point of view and in terms of the time at which they take place.

1. Preparation [Page 112]

Prior to changeover, your departments carry out preparation work that ensures the changeover process takes place smoothly. This involves general work that takes place regularly such as document archiving and monthly closing. In carrying out these activities, you are both improving your system performance and closing processes (such as batch input transactions) that could lead to problems during changeover.

2. Central Changeover [Page 126]

Your system administration carries out the changeover itself, that is the actual conversion of local currency to euro. A part of the changeover takes place while the system is blocked, during which time the system is blocked for all users meaning no further postings can take place.
The central changeover process is controlled in its entirety by the changeover package. All the programs required to perform the changeover are started in the correct sequence by the system, to which end the changeover process is divided into several phases.

3. **Cleanup [Page 214]**

Your departments carry out settings that are not cleared by the system. This involves maintaining tables that are not converted.

---

**Process Flow for Local Currency Changeover**

**Result**

All those company codes whose local currency was one of the currencies participating in monetary union now have the euro as their local currency. This applies to all R/3 components you have implemented, with the exception of FI-LC and EC-CS.
Preparation

Purpose

Prior to the start of central changeover, certain preparation work must be carried out both in the user departments and in system administration. You will find further information and a description of the activities in the Implementation Guide.

Some preparations must be made in the fiscal year before the local currency changeover, and you should bear this in mind when planning.

In some components, preparations can only be carried out after the work has been completed in other areas, such as after year-end closing. Year-end closing in Financial Accounting cannot be fully completed once closing operations in Assets Management have been brought to a conclusion. You should take these dependencies into consideration when scheduling the preparation.

Document all the activities that you carry out. You should elect persons within your company to be responsible for carrying out each of these activities in the correct fashion.

When all the preparations are complete, the user departments should inform the system administrators that this is the case so that the system administrators can start the central changeover.

Preparation must be carried out in the following components:

- Financial Accounting (FI-AP/FI-AR/FI-GL)
- Consolidation (FI-LC)
- Asset Accounting (FI-AA)
- Special Purpose Ledger (FI-SL)
- Overhead Cost Controlling (CO-OM)
- Product Cost Controlling (CO-PC)
- Profitability Analysis (CO-PA)
- Profit Center Accounting (EC-PCA)
- Consolidation (EC-CS)
- Executive Information System (EC-EIS)
- Real Estate Management (IS-RE)
- Materials Management (MM)
- Project System (PS)

These activities are listed in the Implementation Guide (IMG) under Cross-Application Components → European Monetary Union - Euro → Local Currency Changeover → Preparation.
Preparation in Treasury (TR)

Purpose

The following sections describe the activities that apply solely to the Treasury application component and which must be carried out in addition to the general preparation activities.

- Preparation Activities: Accounting [Page 115]
- Customizing Settings (TR-TM-SE) [Page 116]
- Disclosing Currency Reserves (TR-TM-SE) [Page 120]
- Reconciling TR-TM-SE and FI Balances Manually [Page 121]
- Emptying the Rollover Files (TR-LO) [Page 123]
- Reconciling TR-LO and FI Balances Manually [Page 124]
- Converting Limits Manually [Page 125]

For the money market, forex and derivatives areas, no preparation activities are necessary prior to changing over local currency.
Preparation Activities: Accounting

Procedure

1. Define the new bank relationships, the resulting account structure and the new currency-related payment methods.

2. Adapt the structure of the house banks and financial accounts in SAP R/3 Financial Accounting.

3. Adapt the account assignment references and account determination in SAP R/3 Treasury.

For more information, see the documentation for bank accounting under AC Accounting → FI Financial Accounting → Bank Accounting (FI-BL) → Bank Accounting [Ext].
Customizing Settings (TR-TM-SE)

Prerequisites

Position management in the Securities component makes a strict distinction between local currency and foreign currency securities. After the flows have been converted by the central conversion tool, the new local currency securities need to be reconciled. This is done by report program EWUTFV01, which is part of the central conversion tool and is started automatically.

To ensure that this program runs without error-free, you need to make settings in Customizing before you run the central conversion programs. These settings are described below.

Procedure


2. Use the flow types delivered with the system, or copy the sample settings to create the new flow types.

   The new flow types must be set to not relevant to posting.

   The flow types and the assignment of the flow types to the flow categories are included in the Customizing settings delivered with the system. You may need to copy the flow types from client 000.

<table>
<thead>
<tr>
<th>New flow type</th>
<th>Flow category</th>
<th>Description of flow category</th>
<th>Copy reference of flow type delivered with the system</th>
</tr>
</thead>
<tbody>
<tr>
<td>8311</td>
<td>XA0E</td>
<td>Euro: Transfer security valuation</td>
<td>8111</td>
</tr>
<tr>
<td>8312</td>
<td>XA0E</td>
<td>Euro: Transfer security valuation (local currency only)</td>
<td>8112</td>
</tr>
<tr>
<td>8313</td>
<td>XA1E</td>
<td>Euro: Transfer security valuation (local currency only)</td>
<td>8111</td>
</tr>
<tr>
<td>8314</td>
<td>XA1E</td>
<td>Euro: Transfer security valuation (local currency only)</td>
<td>8112</td>
</tr>
<tr>
<td>8315</td>
<td>XA2E</td>
<td>Euro: Transfer security valuation (position currency only)</td>
<td>8111</td>
</tr>
<tr>
<td>8316</td>
<td>XA2E</td>
<td>Euro: Transfer security valuation (position currency only)</td>
<td>8112</td>
</tr>
</tbody>
</table>

See also: Reconciliation of TR-TM-SE and FI Balances [Page 216]
3. To assign the flow types to the corresponding flow categories, choose Treasury → Treasury Management → Securities → Transaction and Position Management → Basic Settings → Flow Types → Assign Flow Types to Flow Category.

Make the assignment for the condition group 0.

Example: Assigning flow types to a flow categories

<table>
<thead>
<tr>
<th>Cond. group</th>
<th>Flow category</th>
<th>Flow type 1</th>
<th>Flow type 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>XA0E</td>
<td>8311</td>
<td>8312</td>
</tr>
<tr>
<td>0</td>
<td>XA1E</td>
<td>8313</td>
<td>8314</td>
</tr>
<tr>
<td>0</td>
<td>XA2E</td>
<td>8315</td>
<td>8316</td>
</tr>
<tr>
<td>0</td>
<td>XD0E</td>
<td>8321</td>
<td>8322</td>
</tr>
<tr>
<td>0</td>
<td>XE0E</td>
<td>8331</td>
<td>8332</td>
</tr>
</tbody>
</table>
Customizing Settings (TR-TM-SE)

<table>
<thead>
<tr>
<th>Cond. group</th>
<th>Flow category</th>
<th>Description of flow type</th>
<th>Copy reference of flow type delivered with the system</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>XE1E</td>
<td>8333</td>
<td>8334</td>
</tr>
<tr>
<td>0</td>
<td>XE2E</td>
<td>8335</td>
<td>8336</td>
</tr>
<tr>
<td>0</td>
<td>XF0E</td>
<td>8341</td>
<td>8342</td>
</tr>
</tbody>
</table>

(For a description of the flow categories and flow types, see step 2)

**Disclosing Currency Reserves: Customizing Settings**

- Use the flow types delivered with the system, or copy the sample settings to create the new flow types.

  The flow types and the assignment of the flow types to the flow categories are included in the Customizing settings delivered with the system. You may need to copy the flow types from client 000.

- To define new flow types in R/3 Customizing, choose Treasury → Treasury Management → Securities → Transaction and Position Management → Basic Settings → Flow Types → Define Flow Types.

  The new flow types must be set to Relevant to posting. You must also make the corresponding settings in account determination.

<table>
<thead>
<tr>
<th>New flow type</th>
<th>Flow category</th>
<th>Description of flow type</th>
<th>Copy reference of flow type delivered with the system</th>
</tr>
</thead>
<tbody>
<tr>
<td>8325</td>
<td>XF1E</td>
<td>Forex write-down (costs) euro</td>
<td>8125</td>
</tr>
<tr>
<td>8326</td>
<td>XF1E</td>
<td>Forex write-up (costs) euro</td>
<td>8126</td>
</tr>
<tr>
<td>8421</td>
<td>XD1E</td>
<td>Forex write-down (SEC) euro</td>
<td>8121</td>
</tr>
<tr>
<td>8422</td>
<td>XD1E</td>
<td>Forex write-up (SEC) euro</td>
<td>8122</td>
</tr>
</tbody>
</table>

- To assign the flow types to the corresponding flow categories, choose Treasury → Treasury Management → Securities → Transaction and Position Management → Basic Settings → Flow Types → Assign Flow Types to Flow Category.

  Make the assignment for all condition groups.

  ![Example: Assigning flow types to all flow categories]

<table>
<thead>
<tr>
<th>Cond. group</th>
<th>Flow category</th>
<th>Flow type 1</th>
<th>Flow type 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>XF1E</td>
<td>8325</td>
<td>8326</td>
</tr>
<tr>
<td>0</td>
<td>XD1E</td>
<td>8421</td>
<td>8422</td>
</tr>
</tbody>
</table>

**Defining the Euro as a Currency Unit**

If no currency unit exists for the euro, you need to make the corresponding entry in R/3 Customizing.

To do this, choose Securities → Basic Settings → Define currency units. Enter the currency unit for euro (for example, EUR) with the Ratio 1.
Disclosing Currency Reserves (TR-TM-SE)

Prerequisites

The exchange rates between the participating currencies and the euro are fixed. This may lead to a situation where the book exchange rate between the position currency and the local currency for foreign currency positions deviates from the fixed rate (book exchange rate = book value in position currency divided by the book value in local currency).

The current consensus is that these hidden reserves should be calculated and disclosed for all participating currencies as at 01/01/1999. You can either make a corresponding disclosure in the P&L account or create a special reserve. Such reserves would need to be written off during the course of remaining period or by the end of the dual currency phase. You make the postings to write off the special reserve manually in Financial Accounting.

For a detailed list of the positions for which special reserves have been created and the corresponding amounts, refer to the log of report program RFVWBEW1 (how to run the program is described in steps 1. to 3. under Procedure).

If normal spot rate valuation is used before the local currency changeover, the differences between the book exchange rate and the fixed rate only need to be offset by corresponding flows if the book exchange rate lies above the fixed rate. In this case, you write down the currency. If the book exchange rate lies below the fixed rate, you may not be permitted to write up the currency. In this case, the difference would remain as a hidden currency reserve.

For more information about the relevant Customizing settings, see Customizing Settings (TR-TM-SE) [Page 116], under Disclosing Currency Reserves: Customizing Settings.

Procedure

1. After you have carried out the normal key date valuation (report program RFVWBEW0), go to the Securities application menu and choose Back office → Position Management → EMU additional functions → Foreign exchange write-up (report: RFVWBEW1).

2. Under the selection parameters for the program, choose the two-step valuation principle EU which only permits forex write-ups/write-downs and does not permit security write-ups/write downs.

   The positions are valued according to this principle rather than according to the settings made in the master data.

   The valuation principle EU is included in the Customizing settings delivered with the system.
Reconciling TR-TM-SE and FI Balances Manually

Use
The local currency amounts in FI and TR-TM-SE are converted independently of each other. Since the local currency amounts are converted at different summarization levels (at flow level in TR-TM-SE, for the document or account transaction figures in FI), there may be rounding differences when you compare TR-LO and FI resulting from the local currency changeover.

In FI documents, the system clears any difference between the debit and credit sides after the local currency changeover by means of an additional posting item. This posting item does not exist in TR-TM-SE. This may lead to different balances in TR-TM-SE and FI.

Procedure
There is no program that automatically reconciles the balances in the FI general ledger and TR-TM-SE.

However, you can reconcile the balances manually using the posting evaluations in TR-TM-SE and FI. You should carry out the reconciliation before and after the local currency changeover.

Clear any differences that exist before the local currency changeover.

Accordingly, any differences which exist after the local currency changeover are rounding differences resulting from the changeover. You can clear these differences manually in FI after the local currency changeover.

To reconcile the balances manually, proceed as follows:

Determining the amounts posted from the point of view of TR-TM-SE
1. Call up the posting journal for securities and carry out the reconciliation separately for each company code (Treasury → Treasury management → Securities → Information system → Report selection → Accounting → Posting journal).
2. In the posting log, select all the flows which have been posted to FI and which have not been reversed. To do this, set the Flows not reversed and Only flows posted in FI indicators, and deactivate the Flows reversed indicator.
3. Under Output control, set the Output a line for each flow and G/L account indicator.
4. Generate the posting journal.
5. Define a display variant with the following fields:
   – General ledger account (field group: Amounts posted per G/L account)
   – Posting amount in local currency (field group: Amounts posted per G/L account)
   – Local currency (field Currency, field group Amount details)
6. Specify the G/L account as the primary sort variable and create a subtotal of the amount in local currency for each G/L account. For each FI account, the system displays the subtotal posted to the FI account (balance).

Determining the amounts posted from the point of view of FI
1. In the G/L balance display, display the G/L balance for each FI account in local currency.
Reconciling TR-TM-SE and FI Balances Manually

Before the local currency changeover, this balance should match the balance calculated above for each FI account.

You can only follow this procedure if the postings to the relevant FI accounts come exclusively from TR-TM-SE.

2. If this is not the case, you can determine the balances for the postings made to the FI accounts from TR-TM-SE using other FI evaluations. One alternative is to identify the documents posted from TR-TM-SE using a specific document type. To do this, you can use the FI evaluation G/L line items (report program RFSOP000). This evaluation gives you the balance in local currency for the selected documents per FI account. Compare these balances with the balances per FI account calculated above.
Emptying Rollover Files (TR-LO)

Prerequisites

When you execute the local currency changeover, you need to ensure that no loans are in the rollover files:

- Capital amounts in the rollover file (information fields) are not converted.
  
  While the loans in the rollover file are converted, the information fields for the capital amounts are not. When you remove the loans from the rollover file, the system deletes these information fields.

- Removing the loans from rollover files prevents inconsistencies.

Procedure

1. To display all the loans currently in rollover files, go to the Loans menu, and choose Portfolio → Roll over → Rollover → General file → Display.

2. Before the local currency changeover, you need to process any loans still in the files. Choose Portfolio → Roll over → Rollover → File/General file → Edit.
Reconciling TR-LO and FI Balances Manually

Use

The local currency amounts in FI and TR-LO are converted independently of each other.

Since the local currency amounts are converted at different summarization levels (TR-LO document, FI document, FI account transaction figures), there may be rounding differences when you compare TR-LO and FI.

In FI documents, the system clears any difference between the debit and credit sides after the local currency changeover by means of an additional posting item.

If you reverse the original document from TR-LO, the system does not automatically reverse the adjustment item added to the FI document after the changeover. You can take it off the books manually.

Procedure:

1. Before the local currency changeover, reconcile the TR-LO and FI balances to check the consistency of the data.

2. Reconcile the TR-LO and FI balances again after the local currency changeover. If no differences existed before the local currency changeover, any reconciliation differences result from the changeover itself.

3. To eliminate these differences, take them off the books manually in Financial Accounting. However, this is not a prerequisite for using the consistency checks for later postings in FI and TR-LO.
Converting Limits Manually

Procedure

You need to convert the limits manually and keep a record of the effective period.

1. In the Treasury menu, choose Treasury Management → Basic functions → Limit management → Limits → Edit
2. On the Limit: Choose Limit Type screen, select the limit type you want to change and choose Edit.
3. In the next screen, position the cursor on the appropriate list entry and choose Choose.
4. On the Edit Limits for Limit Type XXX: Detail screen, enter the limit amount and currency as required. You can edit the effective period (Effective from and Effective until), the Internal limit amount and the External limit amount for the limit type you have selected.

Conversion of the Currency Key

The following two cases can apply:

a) The currency is not a limit characteristic. In this case, the currency is determined via the client and company code. The system carries out the conversion automatically using report program SEUVTBLV.

b) The currency is a limit characteristic. In this case, you need to set the currency field to ready for input (standard Customizing) and assign the currency key manually.

You can convert limits either before or after the local currency changeover.
Central Changeover

Purpose
Central changeover is carried out by the system administration who performs the individual activities in the IMG in the order described there. The changeover package contains all the programs required to perform the changeover and is started by status management.

Prerequisites
- You must have completed all preparation work in your components.
- The members of the departments responsible for changeover have indicated that all preparation work is complete.
- Changeover within test system: You must ensure that all the data you copied from your productive system is as up-to-date and complete as possible.
- Changeover within production system: You already successfully carried out changeover in your test system.

Process Flow
Central changeover comprises three basic activities:

1. Preprocessing:
   a) You copy the changeover package [Page 128].
   b) Specify the currencies that are to be included for changeover.
   c) Include your own developments.
   d) Analyse your dataset for possible inconsistencies.
   e) Take samples of data so that you can carry out auditing within Financial Accounting later.
   f) Carry out the run time forecast [Page 129].

   ANALYZE Phase
   Analyzing your dataset forms a central part of your preparation activity. You can either have the system start all the analysis programs in the correct sequence automatically, or you can start each program separately. For further information on the sequence in which you run these programs and the names of the report programs started, refer to the IMG.

2. Changeover of Tables:
   a) Carry out the necessary system settings.
   b) Set the system block
   c) Start the changeover.

   FILL Phase
In the R/3 System, the conversion routines for converting table fields are stored in control tables. These control tables are already filled in the standard system. Initially, tables that are not created until you begin customizing your system are not included in the changeover process. During the FILL phase, these tables are then included in the control tables. The loading programs determine configured currency types and currencies and store these in the organization tables.

The individual programs belonging to this phase are listed under Reports in the FILL Phase [Ext.].

**GENERATION Phase**

a) Report program EWUWTLS optimizes the control table entries using the currency types used in the system.

b) Report program EWUGENEW generates a conversion report program for each table using the control tables.

**CONVERSION Phase**

- The generated report programs convert the tables.
- Special report programs take into consideration complex circumstances that can arise during conversion and for which no report programs are generated.
- Report program RFEWUDOC converts all financial accounting documents and reconciles the balances.

**RECON Phase**

The new data records are reconciled.

The individual programs belonging to this phase are listed under Reports in the RECON Phase [Ext.].

**3. Postprocessing:**

a) Carry out auditing in Financial Accounting.

b) Start the postprocessing programs.

Reconciling your dataset forms the major part of your postprocessing activity. You can either have the system start all the analysis programs in the correct sequence automatically, or you can start each program separately. For more information on the sequence in which you run these programs and the names of the report programs started, refer to the IMG.

**Result**

**READY Phase**

Central changeover is complete. The user departments can now begin the cleanup process.
Changeover Package

**Definition**

The changeover package is used to perform technical local currency conversion and starts all those programs necessary to convert local currency. It contains field assignments that define the algorithm by which conversion must take place for each table or field to be converted. This package contains all report programs, together with details on their assignment to individual phases.

Status management ensures that all programs run in the correct sequence and that postprocessing programs are not started until the previous program has run.

**Use**

In the IMG, copy a changeover package from client 000 for each changeover. This is the package with which you carry out the entire changeover.

The standard system contains different changeover packages:

- **Standard package for central changeover**
  You require the standard package regardless of which application components you implement.

- **Package for Consolidation (FI-LC)**
  You require this package if you implement the FI-LC application component.

- **Package for Consolidation (EC-CS)**
  You require this package if you implement the EC-CS application component.

If you implement these above mentioned application components, copy the appropriate packages (in addition to the standard package). You require the standard package regardless of which components you implement.

Changeover is carried out using the active package only, regardless of the number of packages you may have copied. Packages are activated in the Implementation Guide (IMG).

**Integration**

The changeover package forms part of the European Monetary Union - Euro (CA-EUR) application component.
Runtime Forecast

Use
The runtime forecast enables you to predict how long the CONVERSION phase will last and to calculate the amount of time to allow for the system block.

Integration
The runtime forecast is a component of the local currency changeover.

Prerequisites
- You have carried out the preparations in the user departments.
- Preprocessing has been successfully completed for the central changeover (ANALYZE phase).

Features
The runtime forecast is controlled using a separate package. You copy this package from client 0 in the same way as the changeover package. When copying the package for the runtime forecast, the system deactivates the changeover package, simultaneously activating the package for the runtime forecast.

The runtime forecast takes place in several phases, some of which are identical to those in the changeover package.

1. FILL
2. GENERATION
3. TIME
   - The runtime forecast:
     - Starts the generated programs (but does not run them to completion)
     - Counts the number of tables and fields to be converted
     - Calculates the amount of time required for conversion
4. READY

You can use the procedure monitor to check whether all the programs in the forecast are running properly.

Activities
You start the runtime forecast in the Implementation Guide (IMG). You will find the results in the log from report program EWUTIME.
**Procedure Monitor**

**Use**
During the changeover and the runtime forecast, the procedure monitor enables you to see
- which phase the changeover/runtime forecast is in
- whether the program has been run successfully
- which errors have occurred
- whether the changeover/runtime forecast is still running or whether errors have caused it to terminate

**Integration**
The procedure monitor is a component of the changeover package.

**Prerequisites**
You can call up the procedure monitor in any phase you require provided that the package has already been started.

**Activities**
You start the procedure monitor via the Implementation Guide (IMG) using the function...*monitor*. Further information on how to use the procedure monitor can be found in the IMG.
User-Defined Developments

Use
This function enables you to incorporate your own developments into the changeover package and is run during preprocessing for the central changeover, before starting the preprocessing program.

Features
User-defined developments enable you to search your system for the following currency-relevant criteria and to change the following entries:

- Fields in the DDIC
  In an additional step, the system assigns the selected fields to the conversion routines.
- Entries in the source text of your reports
  The system marks the entries which you can then change manually.
- Interface texts
  The system lists the programs to which these texts belong. You can change the entries in the source text.

You will find the technical description under Objects for User-Defined Developments [Ext.].

Activities
For further information on the inclusion of user-defined developments, refer to the Implementation Guide (IMG).
Changeover in Financial Accounting (FI-GL/AP/AR)

Purpose

The system changes over all data in the General Ledger (FI-GL), Accounts Receivable (FI-AR), and Accounts Payable (FI-AP) application components including all dependent value, currency and exchange rate fields. The quantity of data to be converted is calculated as per R/3 instance=client. You cannot limit the amount of data selected.

Process Flow

The following graphic shows the process of local currency changeover in Financial Accounting:

For more information on this topic, see Changeover Procedure in Financial Accounting: Process Flow [Ext.]
Changeover Procedure in Financial Accounting

Use

Technical conversion of local currency takes place at a key date following individual account closing for the fiscal year that was last balanced in national currency. Consolidated financial statements can be drawn up at a later date, independently of this key date. The system changes over the whole local currency dataset in the participating countries’ organizational units.

When changing over documents in Financial Accounting, the following steps must be distinguished:

1. Check and analysis of Financial Accounting
2. Conversion of all documents
3. Recreation of account transaction figures for customer, vendor, and G/L accounts of the current fiscal year
4. Determination of opening balance of current fiscal year
   a) Accounts managed on an open item basis (G/L accounts, customer accounts, vendor accounts)
   b) Reconciliation of balances carried forward in G/L reconciliation accounts
   c) Conversion of G/L accounts not managed on an open item basis
   d) Reconciliation of opening balance
5. Reconciliation of General Ledger I with General Ledger II

During local currency changeover, the system analyzes problems that have arisen up to this point (in the ANALYZE phase). You must resolve these problems prior to actual changeover. This applies to all subledgers that affect Financial Accounting (FI-AR, FI-AP, FI-AA, MM).

Features

Document (BSEG & RFBLG)

Report program RFEWUDOC converts all documents present in your system, simultaneously balancing the amounts within the document (all other report programs perform the changeover only).

Additional Data

All other Financial Accounting data is converted by generated report programs that do not perform any form of reconciliation. This means that you must reconcile Financial Accounting following formal changeover of these fields.

Archived Documents

Document archives are not converted and cannot be included for changeover or reconciliation. It follows that documents in the current fiscal year must not be archived prior to local currency changeover.
Changeover Procedure in Financial Accounting

You can however archive documents belonging to closed fiscal years. Ensure that you do not delete indexes for transactions that were cleared in the current fiscal year since the system requires these indexes for reconciliation purposes.

**Balance Audit Trail and Document Journal**

The balance audit trail and document journal are both an integral part of correct accounting methods. You must document your year-end closing. You must run the balance audit trail and document journal for your old fiscal year. Following changeover, the system reopens the balance audit trail in a new file on the first day of the current fiscal year, and creates a document journal. Immediately prior to changeover, you should save all your system data so that you can recreate the balance audit trail and document journal if necessary. Following changeover, you can create both these items in euro as from the first day of the current fiscal year.

**Notes Regarding Withholding Tax**

If withholding tax (as opposed to extended withholding tax) is implemented in your system, the system does not convert amount fields. Following changeover, you need only adjust those statutory threshold values used for calculation in line with the provisions stipulated by the tax authorities (see also the Implementation Guide (IMG): *Financial Accounting -> Financial Accounting Global Settings -> Withholding Tax*).

If you have implemented extended withholding tax, the system converts the amount fields, since withholding tax base amounts and withholding tax amounts are managed in local currency within the system. The tables that require conversion are WITH_ITEM, WTAK, and WTAD. Whereby the last two tables only apply for withholding tax types with accumulation.

If these withholding tax types are used, rounding differences may lead to the total of individual line items (from the table WITH_ITEM) differing slightly from the corresponding amounts in the totals tables (WTAK, WTAD). For the following transactions, small inaccuracies can arise when calculating withholding tax. These inaccuracies no longer occur once the next accumulation period has started.

To prevent these inaccuracies arising, you should avoid posting any transactions to which withholding tax applies between the time you change over your local currency and the end of the accumulation period following changeover.

Extended withholding tax is predominantly used in Spain, Italy, France, and Portugal.

**Checking Local Currency Changeover**

To check that local currency changeover took place with no errors, carry out the following tests:

- Documents must balance out to zero (corrected by the system in each document).
- Performance reasons prevent you from being able to start an analysis program that checks whether documents balance out to zero.

**Activities**

- Compare the lists that you printed out in the IMG chapters *Enable revision* and *Carry out revision*.
- Report program SAPF070 checks the reconciliation of documents with transaction figures (large reconciliation test)
The total of open items must agree with the transaction figures. For accounts managed on an open item basis, these totals can be checked using the following programs:

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFDOPO00</td>
<td>Customer open items</td>
</tr>
<tr>
<td>RFDSLD00</td>
<td>Customer balance list</td>
</tr>
<tr>
<td>RFKOPO00</td>
<td>Vendor open items</td>
</tr>
<tr>
<td>RFKSLD00</td>
<td>Vendor balance list</td>
</tr>
<tr>
<td>RFSOPO00</td>
<td>G/L account open items (select open items only)</td>
</tr>
<tr>
<td>RFSSLD00</td>
<td>G/L account balance list</td>
</tr>
</tbody>
</table>

The total of customer open items and vendor open items must agree with the balance of the corresponding reconciliation accounts. Compare the results of report programs RFDOPO00 and RFKOPO00 with the results of report program RFSSLD00.

Transaction figures in the G/L accounts must have the balance to zero in the current fiscal year. You can check these figures using program RFSSLD00.

Use report program RFSSLD00 to check the conversion of G/L account transaction figures that are not managed on an open item basis. Compare the converted balances with the balance lists in the system prior to changeover.

Use report program RFBILA00 to compare the balances prior to and post conversion. Use report program RFBELJ00 to check the correct conversion of documents both prior to and post changeover.

**Changeover Restrictions**

**Transaction Figures in Closed Fiscal Years**

Following the changeover to the euro, transaction figures in closed fiscal years no longer agree with those in the documents.

**Balance Carried Forward**

Following changeover, you can no longer start the balance carried forward for closed fiscal years.

**Parked Documents**

Ensure that your system does not contain any parked documents. If parked documents are converted, the Workflow containers (in which document amounts are stored for the release concept) are not automatically converted. Following changeover to the euro, release authorization for the “old” parked documents then takes place using the wrong amounts.

**Held Documents**

Your system should not contain any held documents. These documents are stored in table RFDT and cannot therefore be accessed by the conversion package.

**Payment Runs**

The system does not convert payment run tables. Old payment proposals must either be deleted prior to conversion or closed by a payment run and then archived if necessary.
IDocs and ALE
IDocs are not converted. If several systems are connected, they must all be converted to local currency simultaneously. This also applies to external documents.

Credit Control Area
Credit control area data is converted but no reconciliation takes place. Following local currency changeover, you can reconstruct the data for the credit control area.

Archives
The system does not convert the following archives:

- Check archives
- Transaction figures
- Document archives

Batch Input Sessions
You must have no outstanding batch input sessions.

Dunning and payment runs must be completed and the relevant notices printed prior to changeover. Completed posting periods must be closed.

You can find more information on these topics in documentation for the activity Preparation in Financial Accounting (FI-AP/FI-AR, FI-GL).
Document Conversion and Reconciliation

Use

The documents (BSEG) form part of the RFBLG cluster. The document header (BKPF) and all tables belonging to the RFBLG cluster are converted directly by report program RFEWUDOC. Documents are converted and reconciled simultaneously.

All other Financial Accounting data is converted by further programs. Following conversion of this data, the system then reconciles figures within Financial Accounting itself.

Documents contain fields for the following currencies.

- Document currency
- First local currency of the company code
- Second (parallel) local currency of the company code
- Third local currency of the company code
- The country currency of the company code
- Credit control area currency

The changeover to the euro can affect all currencies except the document currency (the system does not change fields in this currency (transaction currency)). When carrying out processing and analysis activities, it follows that you can still access the original currency in which amounts were entered.

Features

Documents with EUR as Transaction Currency

Following the changeover to the euro, documents originally posted in local currency are local currency documents. For such documents, the system transfers the amount from the transaction currency field to the corresponding local currency field.

Overflow During Conversion

If conversion leads to the field for the converted amount being too small, the system does not convert the document. The system displays this document in the log and the whole program is terminated with ERROR status.

Debit/Credit Reconciliation

Following changeover, rounding differences prevent individual documents from balancing out to zero.

The system corrects these documents by entering additional line items in the document. These new line items are G/L account line items. You define the necessary adjustment account in Customizing prior to local currency changeover. Note that this adjustment account must be created in every company code potentially affected by changeover, namely those company codes in which the first, second or third local currency is converted. You must create this adjustment account in the old local currency, update it in local currency only, and it must not be managed on an open item basis.
Document Conversion and Reconciliation

You must also define a posting key for debit and credit for the G/L account line items (in Customizing).

No more than two new line items can be created in the document if, in two different local currencies, one difference amount arose in debit and in credit respectively.

No such adjustment is possible for documents that already contained 999 line items prior to changeover. The system adjusts these documents so that they balance out to zero by changing an existing G/L account line item. This change does not however reduce the document total. If the document does not contain a G/L account line item, the appropriate debit/credit sign is added to the first line items.

<table>
<thead>
<tr>
<th>Account</th>
<th>Amount (DEM)</th>
<th>Account</th>
<th>Amount (EUR)</th>
</tr>
</thead>
<tbody>
<tr>
<td>113100</td>
<td>100</td>
<td>113100</td>
<td>54.64</td>
</tr>
<tr>
<td>113101</td>
<td>100</td>
<td>113101</td>
<td>5464</td>
</tr>
<tr>
<td>100000</td>
<td>-200</td>
<td>100000</td>
<td>-109.29</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adjustment: 888010</td>
<td>0.01</td>
</tr>
<tr>
<td>Total</td>
<td>0</td>
<td>Total</td>
<td>0</td>
</tr>
</tbody>
</table>

Tax Base Amount and Tax Amount

All amounts for the tax and tax amount in the tax document (table BSET) are converted in accordance with the relevant legislation/rules. Since the system does not carry out any adjustment between BSEG and BSET, the report programs RFUMSV10 and RFUMSV00 arrive at different results. For the purposes of tax on sales/purchases, the result of report RFUMSV00 is relevant here.

Update Currency

The system converts the update currency in the documents, if you set the indicator _Balances in local currency only_ for the corresponding G/L account in the G/L account master record, and the local currency of the G/L account is affected by the changeover.
Conversion and Reconciliation of Transaction Figures

Use
Customer, vendor, and G/L account transaction figures are converted using general report programs.

Converting Transaction Figures

Update Currency
Make a note of the update currency of the G/L account (PSWSL) and the update amount (PSWBT) since this currency is used as a key in table GLT0. If the G/L account in question is managed as Balances in local currency only in the G/L account master record, the system converts the update currency. Amounts are not changed for accounts managed in other ways.

Overflow During Conversion
If the quantity of data saved is too large, the fields in a data record can "overflow". If the system finds that this is the case during changeover, it includes the corresponding record in the log, and does not convert any of the fields in the data record.

To check the changeover process, you can compare the balance lists of the G/L accounts prior to and following changeover.

Reconciling Documents with Transaction Figures

Transaction Figures of Closed Fiscal Years
The system converts transaction figures in closed fiscal years, but does not reconcile them. Following changeover, documents and transaction figures for old fiscal years no longer need to agree.

Transaction Figures for the Current Fiscal Year
The system regenerates transaction figures for the current fiscal year (customer, vendor, and G/L accounts) from the figures in the converted documents, and posts differences arising. Reconciliation program RFEWA009 enters these differences in the corresponding documents in table RFDT and report program RFEWA010 reads this table and corrects these differences by making an additional entry in tables LFC1, LFC3, KNC1, KNC3, and GLT0.

Reconciling Open Items and Transaction Figures
The system reconciles open items with transaction figures as follows:

Reconciling Accounts Managed on an Open Item Basis with the Corresponding Ledger
For accounts managed on an open item basis, local currency changeover can lead to the total of all open items belonging to the old fiscal year differing from the balance carried forward amount for the current fiscal year. The account balance in the current fiscal year would then not agree with the total of the line items in this account.
Conversion and Reconciliation of Transaction Figures

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>Debit (DEM)</th>
<th>Credit (DEM)</th>
<th>Debit (EUR)</th>
<th>Credit (EUR)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>100</td>
<td>200</td>
<td>54.64</td>
<td>109.29</td>
</tr>
<tr>
<td>2000</td>
<td>100</td>
<td></td>
<td>54.64</td>
<td></td>
</tr>
<tr>
<td>Open Items Total</td>
<td>200</td>
<td>200</td>
<td>109.28</td>
<td>109.29</td>
</tr>
</tbody>
</table>

Report RFEWUC0F determines differences between the total of open items and the balance carried forward and adds them to the balance carried forward for this account. It carries out this adjustment for customer and vendor accounts, and for G/L accounts managed on an open item basis.

Reconciling Subledger Accounts with the General Ledger

For G/L reconciliation accounts, you manage the open items in the appropriate subledger (in the same way as for carry forward balances for accounts managed on an open item basis). The total of the line items in the subledger for the old fiscal year must agree with the balance carried forward of the reconciliation account in the current fiscal year. The system adds any difference amounts to the balance carried forward of the reconciliation account.

Report RFEWUC0O adjusts the balances carried forward on the basis of the subledger items.

Open Items Managed in Two Accounts

These accounts are processed during clearing transaction processing when reconciling the general ledger. The GR/IR clearing account is an example of such an account. For further information, refer to the documentation on the changeover procedure in Materials Management (MM).

Reconciling the Opening Balance Sheet

The system reconciles the opening balance as follows:

To ensure accurate G/L account transaction figures, all G/L account totals must balance out to zero, since if this is not the case the system cannot generate a correct balance sheet. Program RFEWA014 enters the adjustments to a G/L account in the balance carried forward field. This G/L account must be defined in Customizing and be created in the company codes potentially affected. (see also the IMG activity Preparation in Financial Accounting).

Once the transaction figures have been regenerated and the carry forward balances adjusted by means of the open items, these balances are then balanced out to zero by report RFEWA014. In so doing, this report treats the transaction figures as one large document.
Reconciling Clearing Transactions

Use

Following the changeover to the euro, documents that previously balanced out to zero no longer do so due to rounding differences. This causes problems if one or more of these documents was posted in the current fiscal year. This problem arises from the method by which transaction figures are corrected.

Features

The system uses the transaction figures from the last closed fiscal year as the basis for the current fiscal year's figures. These transaction figures already include the transactions completed in the old fiscal year and therefore do not need to be corrected. Following changeover, you cannot reset cleared items. All other transactions must be corrected since, in the case of accounts managed on an open item basis for example, the balance of open items and the account balance will otherwise not agree.

Report RFEWUS0C selects the clearing transactions and writes them to table EWUI_SCA. Report RFEWUC0C adjusts and carries out an update posting for these entries.

The transaction was completed in the old fiscal year. The system converts the transaction figures, but does not regenerate them.

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>Debit</th>
<th>Credit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>100</td>
<td>200</td>
<td>54.64</td>
</tr>
<tr>
<td>2000</td>
<td></td>
<td>200</td>
<td>109.29</td>
</tr>
</tbody>
</table>

Clearing Transaction in Closed Fiscal Year

The line items are cleared, but one of the transactions (payment or invoice for example) took place in the current fiscal year.

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>Debit</th>
<th>Credit</th>
<th>Debit</th>
<th>Credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2000</td>
<td>100</td>
<td>200</td>
<td>54.64</td>
<td>109.29</td>
</tr>
<tr>
<td>2000</td>
<td></td>
<td>200</td>
<td>54.64</td>
<td>109.29</td>
</tr>
</tbody>
</table>

Clearing Transaction in Current Fiscal Year
Reconciling Clearing Transactions

Adjustment takes place by posting a new document both to the account in question and to an adjustment account. The system enters the clearing date of the transaction in the line item of the account to be adjusted. This procedure holds for all G/L, customer, and vendor accounts managed on an open item basis.

For these documents, you need to define the corresponding G/L accounts as offsetting accounts and create them in the company codes that are likely to be affected. You do this in Customizing. You must also define a document type and G/L account posting key for debit and credit postings respectively. You should create the document type afresh (using internal number assignment for the number range). Documentation on how to create a document type can be found in the Implementation Guide (IMG).
Changeover in Asset Accounting

Purpose

In the Asset Accounting (FI-AA) component, you can manage your fixed assets in parallel in any number of depreciation areas. Each depreciation area can manage its values in a different currency. During the euro changeover, the system changes over all depreciation areas that use a participating euro currency. For making this change, the system uses the fixed exchange rate specified in the changeover package. After the currency translation, all of the amounts in these depreciation areas are in the system in euros only. Partial changeover of certain depreciation areas according to their own specific criteria is not allowed.

Process Flow

The euro changeover consists of the following three phases:

- In the preparation phase, you meet certain prerequisites for the changeover. For more information on the preparation phase in FI-AA see the Implementation Guide (IMG) for the European Monetary Union: Euro.
- The actual changeover takes place in the preprocessing, changeover and postprocessing steps using the R/3 changeover package. For more information, see Changeover Procedure [Page 145].
- After the euro changeover, you need to do some cleanup. For more information on the cleanup phase in FI-AA see the Implementation Guide (IMG) for European Monetary Union: Euro.

The following graphic shows the phases of the changeover and the FI-AA programs that run during each phase:
Changeover in Asset Accounting

For more a more detailed description of these programs and their functions, see their R/3 online documentation (transaction SE38).

**Result: Tables Converted**

The following tables are converted in Asset Accounting during the euro conversion:

**Tables Affected by the Conversion**

<table>
<thead>
<tr>
<th>Table</th>
<th>Contents of Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANEP</td>
<td>Asset line items</td>
</tr>
<tr>
<td>ANEA</td>
<td>Asset line items proportional values</td>
</tr>
</tbody>
</table>
| ANLA  | Asset master record:  
|       | Property value (EHWRT, WRTMA)  
|       | Leasing values (LBASW, LEGEB, LKAUF, LKZUA, LKUZI, LLAVB)  
|       | Original acquisition value (URWRT) |
| ANLB  | Asset master record - Depreciation terms: Scrap value (SCHRW) |
| ANLC  | Asset value fields |
| ANLP  | Periodic asset values |
| ANLQ  | Periodic values from depreciation posting run for each account assignment level |
| ANLV  | Insurance data |
| ANLW  | Year-dependent insurance values |
| T085  | Investment support measures |
| T085Z | Investment support with time-dependent investment support percentage rates |
| T090M | Maximum depreciation amounts |
| T091C | Changeover variants |
| T093B | Depreciation area specifications related to company code |

The system adopts the currency from table T093B.

A special rule applies to tables T085 and T085Z: Since the entries in these tables are dependent on the chart of depreciation (not on the company code), the system checks if the assigned company codes all have the same currency. If this is not the case, the system checks which depreciation areas use the investment keys. As long as the investment key is assigned to only one depreciation area, and the currency of the depreciation is euro participating, the system translates the values. Otherwise the system does not translate the amount. It then issues a warning to that effect during the analysis phase in program EWUAFPLO.
Changeover Procedure in Asset Accounting

Use

The changeover of FI-AA data is almost completely automatic when you use the R/3 changeover package. This process is described below.

Features

The changeover of FI-AA data follows these steps:

- In the preprocessing phase, the system carries out a depreciation recalculation for all affected assets. It checks the reconciliation of the APC balance sheet accounts with the FI-AA balances (before the changeover).

- After the preprocessing program has run, you have to manually correct any depreciation errors that were found. Start program RAT08401 and process its error log. If there are reconciliation problems, you have to analyze and correct them using the appropriate FI-AA reports (in FI-AA Tools → Problem analysis).

- In the changeover phase, the system translates all asset values and the amount specifications in Customizing to euros. The system then first reconciles the translated values internally within FI-AA.

- In the postprocessing phase, the system reconciles the FI-AA subsidiary ledger balances with the balances of the G/L accounts.

  Do not make any FI-AA postings during the postprocessing phase.

- After the postprocessing programs have run, you have to process their error logs. Analyze the error messages and follow the instructions there for correcting the errors.

  If errors occurred on assets for which you posted retirements, transfers, credit memos, or write-ups, you have to reverse the last of these transactions and enter it again. This applies particularly to settlements from assets under construction to completed assets.

  As part of the changeover, the system corrects inconsistencies between asset line items and the General Ledger. These corrections are made for totals on the G/L account level. Reversing a transaction, therefore, could mean that a new reconciliation is required.

Documentation of the Changeover

In order to document that the changeover is correct, you should run the following asset reports before and after the changeover:

- For asset balances: RABEST01
- For depreciation and value adjustment balances: RAAKTB01
- For depreciation posted in the changeover year: RAGITT01 (using the Posted depreciation selection option)
Changeover Procedure in Asset Accounting

Choose the end of the fiscal year as the report date. For report RAGITT01 specify that the report should output posted depreciation values (not planned depreciation).

Changeover of Amount Specifications

There are certain amount specifications you make in Customizing for Asset Accounting, such as the maximum amount for low value assets, investment support amounts, amounts for depreciation changeover, scrap values, and so on. The system automatically converts these amounts to euros. However, after the changeover, you may have to manually adjust these amount specifications in order to comply with new government regulations that are in euros (Euro Customizing: Cleanup).

Rounding

The problems associated with rounding during the euro changeover are especially complex in the Asset Accounting (FI-AA), since the many different value checks for depreciation calculation cannot be allowed to be violated even after the changeover. The calculation of proportional value adjustments to a given period for asset retirement is also extremely complex. This is one of the reasons that you should keep the number of postings for the new year between the fiscal year change and the euro changeover to an absolute minimum. If you do make postings, then they should be limited to acquisition postings only. (For more information, see Prevention of Errors [Page 155]).

During the changeover, the system rounds to the nearest whole number. The specifications you make for euro rounding in FI-AA Customizing do not take effect in Asset Accounting until after the euro changeover. Logically, these specifications then affect only those values translated to euros in the current year and for future years.

When you compare planned values in the asset list or the asset history sheet before and after the euro changeover, the planned depreciation in the current year cannot be explained simply by the currency translation and possible rounding differences. The reason for this is that the system carries out a recalculation of depreciation after the changeover. As the result of the translation of the base values, it is possible that the system might have made noticeable adjustments to planned depreciation.

### Rounding During Depreciation Calculation

**Amounts Before the Changeover**

<table>
<thead>
<tr>
<th>Value</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>APC</td>
<td>10,000 DM</td>
</tr>
<tr>
<td>Straight-line depreciation 10%</td>
<td>1000 DM</td>
</tr>
<tr>
<td>Net book value</td>
<td>9000 DM</td>
</tr>
</tbody>
</table>

After the conversion, the values are as follows:

**Amounts after the Changeover**

<table>
<thead>
<tr>
<th>Value</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>APC</td>
<td>5143.23 euros</td>
</tr>
</tbody>
</table>
Straight-line depreciation 10%  |  514.23 euros  
| Due to rounding of the net book value!  
Net book value  |  4629 euro 

The translated planned depreciation amount (10% depreciation on APC of 5143.23 euro) should normally have been 514.32 euros. However, the indicator for rounding *Rem. book value at year end* is set in FI-AA-Customizing, which causes the depreciation value to be corrected by 9 cents.

**Memo Values**

The system converts memo values. However, it cannot guarantee that the memo value of a fixed asset will be a specific amount after the changeover (for example, that it will be exactly 1 euro).

For more information on memo values in FI-AA, see the Implementation Guide (IMG) for Euro Customizing.

**Memo Values and Rounding**

If you have set the indicator for rounding *Rem. book value at year end* in FI-AA Customizing, the system rounds any memo values that are less than one euro to zero at the end of the fiscal year. These memo values are thereby lost.

If the memo value is not switched off during the euro changeover, you may be left with a memo value, for example, of 0.51 euro after the conversion. If the indicator for rounding *Rem. book value at year end* is set, then the system rounds the minimum value and the asset is written off to zero.

For more information on rounding options in FI-AA, see the Implementation Guide (IMG) for Asset Accounting. Choose Valuation → Amount Specifications → Specify Rounding of Net Book Value and/or Depreciation.
Reconciliation within Asset Accounting

Features
In the "changeover" phase, the system translates the asset values and the amount specifications to euros and rounds these values as needed. This rounding can cause inconsistencies within the FI-AA tables. After the currency translation, the system therefore automatically reconciles the values described below.

Line Items and Value Fields (Tables ANEP and ANLC)
The system reconciles the asset line items (transactions) with the asset value fields (totals records) by recalculating depreciation. If errors occur during this process, the system corrects the following errors automatically:
- For assets under construction with line item management, the system reconstructs the cumulative acquisition costs based on the open line items at the start of the fiscal year.
- If the total of down payments was zero before the currency translation, the system resets this total to zero after the translation. In addition, the system modifies the last-processed down payment line item accordingly.
- In Customizing, you can specify whether the net book value of an asset can be positive, negative or both. If this rule for the net book value is violated at the start of the fiscal year, the system corrects the error by changing the annual balance forwarded for the asset (not with an adjustment posting). For derived depreciation areas, the system reduces depreciation in the depreciation areas on which the derived area is based (in the same sequence as in the formula for the derived depreciation area).
- The system also makes sure that assets with a book value of zero before the translation have a book value of zero after the translation.

The system creates an asset change document for each error correction that it makes. You can run a report (RAAEND01) on these change documents. The change user in these documents is SAP_EURO.

The system logs errors that cannot be corrected automatically, for you to process later. You can process this log using program RAT08401.

The system does not carry out a reconciliation for closed fiscal years.

Value Fields (Table ANLC)
If errors occur in value fields (totals records) of an asset, the system attempts to correct them by changing planned depreciation in the changeover year. If this attempt is unsuccessful, the system corrects the annual values carried forward.

The system does not reconcile the totals records with previous years (since they are already closed).

Posted Depreciation (ANLP and ANLC)
The system does not carry out any reconciliation for posted depreciation. The depreciation posted in table ANLC is binding.
Table ANLP serves internal system purposes only. Using table ANLP, you can restart depreciation posting runs that have terminated. The fact that this table is not reconciled with table ANLC does not make using ANLP less effective.

After the changeover, it is possible that the asset value display transaction (AW01) could display slightly different depreciation values than in the depreciation reports in the FI-AA Information System. These inconsistencies disappear after the fiscal year change is carried out.

**Insurance Values (ANLW and ANLV)**

The system does not carry out any reconciliation for insurance values. The system does not recalculate the base insurable value, and so on.
Reconciliation with the General Ledger

Features

The system reconciles the asset subsidiary ledger with the General Ledger (FI-GL) for:

- Asset balance sheet accounts (APC, accumulated depreciation)
- Depreciation areas that automatically post their values to the general ledger (according to their Customizing definitions).

There is no automatic reconciliation with profit and loss accounts. There is also no reconciliation for depreciation areas that solely post depreciation to the general ledger. It therefore follows that the system does not reconcile Asset Accounting with the Controlling (CO) components (for example, depreciation on cost centers).

As the result of rounding problems, you can still have reconciliation errors between the FI-AA subsidiary ledger and the General Ledger, even after the translation of the asset subledger balances and their G/L reconciliation accounts during the changeover phase. Therefore, the system reconciles the following G/L balance sheet accounts with the FI-AA subledger balances during the postprocessing phase:

- APC
- Down payments
- Accumulated depreciation
- Investment support
- Special depreciation reserves

The system aligns the FI balance sheet accounts at the start of the fiscal year with the FI-AA subledger balances at the start of the fiscal year (without adjustment postings). The system also reconciles changes to balance sheet values in the current year (up to the changeover). For these changes in the current year, however, the system corrects any rounding differences by posting to the appropriate euro adjustment accounts.

When a document is reversed after the initial reconciliation, new differences arise between FI-AA and FI-GL. When this occurs, you can use program RAEWASA0A to list any documents where differences occur. Check whether any documents in the list were reversed. If so, make an adjustment posting to correct the difference. Another option is to start both of the postprocessing programs (RAEWUS0B and RAEWUC0B) again.

The system does not automatically reconcile the following profit and loss accounts:

- Expense accounts for depreciation
- Expense or revenue from allocation or write-off of special reserves
- Loss from asset retirement
- Gain/loss from asset retirement (sale)

If you followed SAP’s recommendation not to post asset retirements in the changeover year until after the changeover, you do not need to reconcile the retirement accounts. For more
information, see Preventing Errors [Page 155]. If you do not carry out depreciation posting runs until after the changeover, you also do not need to reconcile the depreciation accounts. However, if you do carry out depreciation posting rounds before the changeover, you have to reconcile the depreciation expense account manual after the changeover.

The planned depreciation for Asset Accounting for the changeover year amounts to 10,000 (in your old currency). 3,000 of this planned depreciation was posted before the changeover. After the changeover (at a rate of 2 to 1), the total of posted depreciation is 1,500 euros.

The translation of the posted values in Asset Accounting, however, results in a total of posted depreciation of 1,499 euros, due to rounding. Therefore, the system automatically posts the adjustment posting and credits "accumulated depreciation" while at the same time debiting "differences due to euro changeover" with the amount of one euro.

The accumulated depreciation account is now reconciled with the balance of the corresponding FI-AA subledger account. If you want to reconcile the accumulated depreciation account with the depreciation expense account, you have to do so manually by posting one euro as a credit to "differences due to euro changeover" and a debit to "depreciation expense".

**Manual Reconciliation of Depreciation Expense Accounts**

In order to simplify the graphic, we have assumed that the accumulated depreciation account had a balance of zero at the start of the fiscal year.

The manual reconciliation described here is not mandatory (even if you posted depreciation before the changeover). Bookkeeping consistency is assured even without the manual reconciliation. You only need to reconcile manually in this way if
you will need to reconcile the depreciation expense account with the accumulated depreciation account at the closing of the changeover year.
Changeover of Group Depreciation Areas

Use
Some companies need to manage a corporate group ledger in the General Ledger for the purposes of group consolidation. If you need to do so, you can supply values to the corporate group ledger from specially defined group depreciation areas in Asset Accounting. For the group consolidation, you need the posting amount in the foreign currency, along with the corresponding amount in your local currency. As a result, you need depreciation area 31 in foreign currency (group currency) as well as depreciation area 30, with identical depreciation terms as 31, in the your local currency.

When the system posts depreciation and APC in the group currency of the group depreciation area, it also posts the same amount in the local currency from the group depreciation area to which it is linked. Both of these amounts are posted to the corporate group ledger. The system posts the group currency amount as the transaction currency, and the local currency amount as the local currency in the document.

Features
In Asset Accounting, the system translates the values in all depreciation areas as part of the euro changeover, as long as the depreciation area currency is a participating currency. In some instances, this could mean that the system translates depreciation area 31 to euros, as well as depreciation area 30. In the FI General Ledger, however, the system translates local currencies only, and not transaction currencies. Under certain conditions, therefore, you might not be able to reconcile the group depreciation area in group currency with its accounts. The following explains the possible situations in which this difficulty could arise, and recommended procedures.

Local and Group Currencies Both Euro-Participating
In this case, the system translates both depreciation area 30 (local currency) and depreciation area 31 (group currency) to euros. Afterward, the system reconciles the translated local currency amount of the FI account with the translated group depreciation area 31 (previously the group currency/transaction currency). Then you have the following options:

- If you plan to continue to use depreciation area 31 for the group valuation, you do not have to change anything in FI-AA.
- If you want to use depreciation area 30 for the group valuation in the future, you have to change its definition in the Implementation Guide (IMG) for Asset Accounting under Valuation → Depreciation Areas → Define depreciation areas. Define it as an area to be posted to the General Ledger, and maintain its account determination.

In both of these cases, you have to manage the FI accounts for these depreciation areas in euros following the changeover. To make this change, you have to carry out the following steps for the accounts involved:

- Post the account balance from the transaction currency and the local currency to a clearing account in local currency.
- Change the currency of the corporate group ledger account.
- Enter the balance from the depreciation you chose to be the group valuation area in Asset Accounting (balance is stored in table EWUFIAASUM) back onto the account. You can find this balance using report RA EWSSUM.
Changeover of Group Depreciation Areas

**Only Local Currency is Euro-Participating**

In this case, the system translates only depreciation area 30, and reconciles this depreciation area with the FI accounts affected. You do not have to change anything in Asset Accounting. In the future, the system supplies the corporate group ledger values in the local currency euro (from the translated depreciation area 30). The group currency continues to come from depreciation area 31, which was not affected by the euro changeover.

**Only Group Currency is Euro-Participating**

In this case, the system translates only depreciation area 31, and does not carry out any automatic reconciliation with FI accounts. You have to make the reconciliation manually.

You have to manage the accounts of the corporate group ledger in euros following the changeover. To make this change, you have to carry out the following steps for the accounts involved:

- Post the account balance from the transaction currency and the local currency to a clearing account in local currency.
- Change the currency of the corporate group ledger account.
- Enter the balance from the depreciation you chose to be the group valuation area in Asset Accounting (balance is stored in table EWUFIAASUM) back onto the account. You can find this balance using report RAEWSSUM.
Preventing Errors

The changeover package automatically corrects most of the errors that can arise during the translation to the euro. However, it cannot automatically correct all possible errors. Therefore, you should carry out certain steps before the changeover, in order to prevent as many errors as possible. By doing so, you can considerably reduce the amount of time needed for manual cleanup.

Preventing Errors Related to Postings

In the year of the changeover, you should make the minimum number of postings possible between the fiscal year change and the euro changeover. You should have as few postings as possible with an asset value date between these two dates. In addition, any postings you do make should be acquisition postings only. Other postings (such as, retirements or depreciation posting) can lead to situations that might require you to make manual corrections after the changeover. In many cases, you have to manually reverse the posting that caused the error.

The following postings do not cause problems:

- Acquisition postings
- Down payment postings

The following postings can cause errors under certain conditions:

- The settlement of orders to assets; settlement of credit memos from orders
  
  The settlement of orders to assets can lead to errors when you try to reverse the settlement after the changeover, and if the only acquisition on the asset is from the settlement. In this case, the balance on the asset after the reversal could be negative.

  The same applies to credit memos that you posted for their full amount to an order, and then settled to an asset after the changeover.

  After the changeover: Do not reverse any settlements of CO objects to assets under construction, and do not settle any credit memos for their full amount (as far as possible).

- Down payment clearing
  
  Down payment clearings can lead to errors if you posted several partial clearings for one original down payment.

  Before the changeover, post only complete clearings on assets.

- Complete retirements and complete (intracompany) transfers
  
  Complete retirements and complete (intracompany) transfers can possibly cause inconsistencies between Asset Accounting and the General Ledger at document level.

  The system makes automatic corrections only at the account level.

  Do not post retirements or transfers if at all possible.

- Write-ups and credit memos
  
  Multiple write-ups in one document (that is, write-up to ordinary depreciation and special depreciation when the accounts are the same) can lead to inconsistencies at the document level. Multiple partial write-ups can result in the cumulative amount being exceeded.
Preventing Errors

- Post write-ups by themselves and only for the full amount. Do not post several partial write-ups on one asset. The same applies to credit memos.

- Partial transactions (partial retirement or partial transfer)
  
  Avoid posting several partial transactions that add up to the total value.

  Do not post partial transactions before the changeover.

Postings with a high probability of causing errors:

- Settlement of asset under construction to completed asset, and full settlement of investment measures

  Due to the high volume of transfers that are involved in these transactions, the possibility of an error on the asset is very high. The probability of an error increases if several depreciation types were posted on the investment measure or the asset under construction, or if revaluation was calculated in certain depreciation areas.

  Do not carry out the capitalization of assets under construction, or full settlement of investment measures until after the changeover.

Preventing Errors for Depreciation Posting

In order to reduce the amount of errors as much as possible, do not post any depreciation to the General Ledger in the changeover year before the changeover. Do not start the depreciation posting program in the changeover year until after the changeover. Post depreciation only after the changeover has been completed. To post depreciation to a past periods, open the posting periods in FI, and then start the depreciation posting run for each of these periods.

Preventing Errors for Investment Support

The cautions regarding the depreciation posting run also apply for claiming investment support. Do not post investment support in the phase before the changeover.
Limitations of the Changeover

The following limitations apply to the euro changeover of the Asset Accounting (FI-AA) component:

- The system does not carry out reconciliation with the Controlling (CO) components.
- The system does not carry out any automatic reconciliation with the profit and loss accounts.
- The system does not carry out any reconciliation of table ANLC (asset value fields) with table ANLP (asset periodic values). The posted depreciation in table ANLC is binding.
- The system does not carry out any reconciliation of down payments with down payment clearings using adjustment postings in the General Ledger. If there are inconsistencies, you have to post additional, manual clearing.
- The system does not carry out any reconciliation within documents that affect several assets (such as transfers).
- The system does not guarantee that 100% investment support measures are exactly 100% after the changeover. (In Germany, 100% investment support is common for hospitals.)
- You cannot reload archived Asset Accounting data (in an old currency) back into the system after the changeover. The system does not translate the currency when you reload data. Therefore amounts in the old currency would be written to euro data fields. This does not apply, of course, if you translate the archived data into euros, using a program you write yourself, before you reload it.

💡

You cannot use the R/3 archiving programs to create a kind of data backup in case you need to invalidate the euro changeover. You have to make the data backup you need using the normal system backup procedures.
Changeover in Special Purpose Ledger (FI-SL)

Purpose
The following sections describe the procedure for the changeover to the euro in the Special Purpose Ledger (FI-SL) component.

Implementation Considerations
All the data in all the ledgers in the system for the current fiscal year is converted within the SAP changeover package. Differentiation by ledger or other criteria is not possible.

No pooled tables are converted (table GLT1 in particular). If you are still using pooled tables in production system, you will have to convert them to transparent tables prior to the changeover to the euro. For further details, see the following release note: “Conversion of GLX pooled tables to transparent tables”.

Process Flow
The entire process flow of the changeover can be divided into three basic phases:

1. In the preparation phase, you create certain settings and make advance reconciliations for the changeover. This is described in the Implementation Guide.

2. The actual changeover takes place with the preprocessing, conversion and postprocessing activities. You do not have to perform any special activities in FI-SL during the various phases of the changeover.

3. In the cleanup phase, you make manual reconciliations and adjustments that the system cannot do automatically. This is described in the Implementation Guide. For more information on reconciliation problems, read Changeover Procedure (FI-FM) [Page 160].

The following graphic shows the procedure for local currency changeover in the Special Ledger:
For more information, see Programs for the Changeover in FI-SL [Ext.].

**Result: Converted Tables**

After the changeover, all the currencies in ledgers participating in the monetary union will appear in euro.

The following tables are converted in the Special Purpose Ledger. Additionally, all customer-defined tables (summary, line item, and plan line item tables) are affected.

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURR</td>
<td>T880 (global companies)</td>
</tr>
<tr>
<td>GCURR</td>
<td>T881 (ledger)</td>
</tr>
<tr>
<td>CURR1, CURR2</td>
<td>T882 (company code, ledger)</td>
</tr>
<tr>
<td>• HLSVT to HSL016 (all periods)</td>
<td>GLFUNCT</td>
</tr>
<tr>
<td>• HLSVT to HSL016 (all periods)</td>
<td>GLFUNCP</td>
</tr>
<tr>
<td>• TSLVT to TSL016 (the “Balances only in local currency” indicator must be set in the account in order for conversion to take place; for more information, see the documentation for program EWUTSLO)</td>
<td>GLFUNCA</td>
</tr>
</tbody>
</table>
Changeover Procedure in the Special Purpose Ledger

Use
You want to convert your ledgers in up to three possible currencies with the changeover package.

Each ledger can be kept in up to three currencies:

- Document currency (transaction currency)
- Two other currencies you define, such as group currency and company code currency for local ledgers or global company currency for global ledgers.

Prerequisites
To learn more about the requirements you must complete prior to the changeover to the euro, in the Implementation Guide (IMG) see Preparation in Special Purpose Ledgers (FI-SL).

Reconciliation
Reconciliation operations take place in the cleanup phase after the changeover to the euro.

The question of whether a separate reconciliation is necessary for a ledger depends on how you use the ledger:

- If your ledger contains only purely statistical additional information for certain nodes or cost centers, no further reconciliation is required.
- If you create your balance sheet and income statement with this ledger, a separate reconciliation is necessary. Ledger OF for cost of sales accounting (table GLFUNCT) is an example of a balancing ledger.

Only the current fiscal year - i.e., the year in which the changeover to the euro takes place - is reconciled. The prerequisite for reconciling the current fiscal year is that you have carried forward the balance for the ledger from the previous fiscal year before the changeover to the current fiscal year.

For performance reasons, you should generally only reconcile those ledgers for which reconciliation is absolutely necessary.

You can find more information in the Implementation Guide (IMG) under Cleanup in Special Purpose Ledgers (FI-SL).

Constraints
The following restrictions apply to the changeover to the euro in the Special Purpose Ledger (FI-SL) component:

- The only component with which reconciliation takes place is the general ledger (FI-GL) component.
- Only the current fiscal year is reconciled with the general ledger (FI-GL).
- Planning data is not reconciled.
- FI-SL summary records are not reconciled with FI-SL line items. In other words, the total for line items with a given account assignment may differ from the amount of the
summary record with the same account assignment. This is a result of rounding differences during the changeover to the euro. When you view the line items that belong to a summary record, the information message “The balance is not equal to zero” appears. At the start of the new fiscal year, the difference disappears.

- Archived data in an old currency must not be reloaded into the system after you have performed the euro conversion. Were you reload archived data, no conversion would take place, and the old currency amounts would be entered into the euro data fields.
Changeover in Funds Management (FI-FM)

Purpose

When you change over from national currencies to the euro, all currency data in the system is converted. To do this, the system uses the fixed exchange rate for the conversion package. After conversion, the amounts converted only exist in the system in euros.

Prerequisites

The data to be converted must be consistent. For this reason, you must run the Funds Management reconciliation report program before you change over to the euro, and correct any inconsistencies the program finds.

Process Flow

The euro changeover passes through the following phases:

1. In the preparatory phase, you must ensure all the prerequisites for the actual conversion are met. In Funds Management, this means ensuring that the data to be converted is consistent.

2. The actual changeover takes place with the help of the R/3 changeover package and runs for Funds Management automatically, as part of the central changeover.

3. After the changeover, you may need to carry out further clean up work due to rounding differences. When the changeover is complete, you should run the two reconciliation programs in Funds Management.

For more information, go to the European Monetary Union: Euro IMG and choose Local Currency Changeover → Cleanup → Cleanup in Financial Accounting (FI) → Cleanup in Funds Management (FI-FM).

Funds Management data which was archived in an old currency must not be reloaded into the system after the changeover. The system does not convert this data if you reload it and would write amounts in the old currency in the data fields now maintained in euros. Exception: You convert the data into euros using a program you write yourself before you reload it.

The following graphic shows the process of local currency changeover for Funds Management:
Result

The system converts all FM area currency amounts in Funds Management into euros. The process covers the values in the following tables:

*Funds Reservations*
KBLP, KBLPW, KBLE

*Fiscal Year Change*
FMCFAB, FMCFABS, FMCFAA, FMCFAAS, FMCFBPAKS, FMCFSI

*Revenues Increasing the Budget*
FMDECK3

*Budgeting*
BPEG, BPEJ, BPEP, BPGE, BPJA, BPPE, TBPFE

*Recording Data*
FMIA, FMICOIT, FMIFIIT, FMIOI, FMIT
Procedure for Changeover in Funds Management

Use

Within Funds Management you will need to carry out certain reconciliation programs, which ensure that reconciled data exists both before and after the euro changeover. You must execute these programs during the CLEANUP phase.

Features

Reconciliation in the Actual and Commitment Update

The changeover in Funds Management converts both actual and commitment data into euros. Both line items and totals records are converted. This may lead to rounding differences between the total of the line items and the value in the totals record.

The following line items and totals records are stored in the system for an FM account assignment:

<table>
<thead>
<tr>
<th>Before changeover</th>
<th>FM account assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice 1</td>
<td>100.00</td>
</tr>
<tr>
<td>Invoice 2</td>
<td>1000.00</td>
</tr>
<tr>
<td>Total</td>
<td>1100.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>After changeover:</th>
<th>FM account assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice 1</td>
<td>49.99</td>
</tr>
<tr>
<td>Invoice 2</td>
<td>499.99</td>
</tr>
<tr>
<td>Total</td>
<td>549.99</td>
</tr>
</tbody>
</table>

For this reason, you must run the FI-FM Reconciliation Program: Leveling of Line Items and Totals Records (RFFMRC04) after the changeover.

Reconciliation in Budgeting

If you distributed budget from higher levels to lower levels, the amount distributed must not exceed the budget originally available. The same applies if you work with funds and distribute an overall budget to a number of years. In addition, the released budget for a budget structure...
element (BS element) must not exceed its current budget. To minimize such budget overruns during the euro changeover, budget values are always rounded down.

Nevertheless, a situation may arise where more budget is distributed to a BS element than exists in the higher-level BS element. In this case, the system displays error messages during the budgeting transactions. To clean up such inconsistencies, you should start the RBPEWU1M report program after the euro changeover. This program corrects the budget values in tables BPGE and BPJA if the budget variance in the BS element checked is more than one percent or 10 currency units before the reconciliation.

The following budget values are stored in the system for two FM account assignments:

<table>
<thead>
<tr>
<th>Before changeover</th>
<th>Higher-level</th>
<th>Lower-level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original budget</td>
<td>1000</td>
<td>1100</td>
</tr>
<tr>
<td>Supplement</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>1100</td>
<td>1100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>After changeover:</th>
<th>Higher-level</th>
<th>Lower-level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original budget</td>
<td>499.99</td>
<td>549.99</td>
</tr>
<tr>
<td>Supplement</td>
<td>49.99</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>549.98</td>
<td>549.99</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>After the reconciliation</th>
<th>Higher-level</th>
<th>Lower-level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original budget</td>
<td>499,00</td>
<td>549.99</td>
</tr>
<tr>
<td>Supplement</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>549.99</td>
<td>549.99</td>
</tr>
</tbody>
</table>

The system does not reconcile assigned values. For example, if the budget for an object was 100% exhausted prior to the changeover, the total of assigned funds may overrun the existing budget following the changeover due to rounding differences. Whether further funds assignments are possible depends on the availability control settings.

Budget adjustments that occurred during reconciliation are not passed on to the availability control. If you want to inform availability control of the budget adjustments, you must recreate the assigned values. Access the relevant function in the Funds Management menu by choosing **Budgeting → Tools → Reconstruct assigned values.**
Special points in the fiscal year change

Generally speaking, there are no special points to bear in mind for the fiscal year change in connection with the changeover to the euro. In the following situation, the fiscal year change is not possible with the functions available at this time. You have carried out the fiscal year change, then converted from local currency to the euro. In such a case, you must not repeat the fiscal year change after the changeover. SAP is to make a program available which you can use to repeat the fiscal year change after changing over to the euro.
Changeover for Treasury (TR)

Purpose
The following sections only cover the special requirements for the local currency changeover of the Treasury components.

- Currency Hedge [Page 168]
- Automatic Conversion of Limits [Page 170]
- Changeover in Cash Budget Management [Page 171]
Currency Hedge

Use

If FI documents in foreign currency that are affected by the local currency changeover are linked to foreign exchange transactions, these currency hedges also need to be converted to the euro.

- The system performs the conversion automatically using report program SEUVTBSI, which is started automatically by the central conversion tool.

![Diagram]

After conversion, the references for the currency hedge determine the hedge rate of the FI documents again. Since foreign exchange transactions are not converted (both currencies count as transaction currency!), the exchange rate notation for the currency hedge no longer corresponds to the notation for the foreign exchange transaction.

Despite this, the currency hedge is still valid, since the fixed rate of the new local currency (euro) against the old local currency still eliminates the foreign currency risk.

![Diagram]

You have a customer invoice in a foreign currency (for example, USD) and want to hedge against the exposure of the local currency (for example, DEM). To do this, you conclude a forward exchange transaction to sell the expected incoming payment in USD at a fixed rate (transaction rate).

Before the local currency changeover and the transaction currency changeover (local currency = DEM):

Customer invoice

\[
1,000 \text{ USD} + (\text{document currency} = \text{foreign currency})
\]

\[
(1,800 \text{ DEM local currency})
\]

\[
1.800 \text{ USD/DEM (hedge rate, FC/LC)}
\]

Currency hedge (= links foreign currency transaction and invoice)

\[
1,000 \text{ USD} - (\text{transaction currency})
\]

\[
(1,800 \text{ DEM} + (\text{base currency})
\]

\[
1.800 \text{ USD/DEM (hedge rate, in TR notation)}
\]

Foreign exchange transaction

\[
1,000 \text{ USD} - (\text{sale})
\]

\[
(1,800 \text{ DEM} + (\text{purchase})
\]

at 1.800 USD/DEM (transaction rate, in TR notation)

After the local currency changeover (from DEM to EUR. 1 EUR = 2 DEM):

Customer invoice

\[
1,000 \text{ USD} + (\text{document currency, unchanged})
\]

\[
900 \text{ EUR (new local currency)}
\]
Currency Hedge

0.900 USD/EUR (new hedge rate, FC/new LC)

Currency hedge
1,000 USD - (transaction currency, unchanged)
  900 EUR + (new base currency)
  1.111 EUR/USD (new hedge rate, in TR notation)

Foreign exchange transaction
1,000 USD - (sale, unchanged)
1,800 DEM + (purchase, unchanged)
at 1.800 USD/DEM (transaction rate, unchanged)
Automatic Conversion of Limits

Procedure

If the limits are managed in local currency, they are converted to the euro as part of the local currency changeover.

- The system performs the conversion automatically using report program SEUVTBLV.
- The program is started automatically by the central conversion tool.

Limit amounts managed in the local currency are only converted to the euro automatically if the currency is not a limit characteristic.
Changeover in Cash Budget Management (TR-CB)

Purpose
When you change over from national currencies to the euro, all currency data in the system is converted. To do this, the system uses the fixed exchange rate for the conversion package. After conversion, the amounts converted only exist in the system in euros.

Prerequisites
The data to be converted must be consistent. For this reason, you must run the Cash Budget Management reconciliation programs before you change over to the euro, and correct any inconsistencies the program finds.

Process Flow
The euro changeover passes through the following phases:

1. In the preparatory phase, you must ensure all the prerequisites for the actual conversion are met. In Cash Budget Management, this means ensuring that the data to be converted is consistent.

2. The actual changeover takes place with the help of the R/3 changeover package and runs for Cash Budget Management automatically, as part of the central changeover.

3. After the changeover, you may need to carry out further cleanup work due to rounding differences. For more information, read Cleanup in Cash Budget Management (TR-CB) [Page 219].

Cash Budget Management data archived in an old currency must not be reloaded into the system after the changeover. The system does not convert this data if you reload it and would write amounts in the old currency in the data fields now maintained in euros. Exception: You convert the data into euros using a program you write yourself before you reload it.

Result
The system converts all FM area currency amounts in the Cash Budget Management system into euros. The process covers the values in the following tables:

Funds Reservations
KBLP, KBLPW, KBLE

Planning
BPJA, BPEJ, BPPE, BPEP, TBP0L

Recording Data
FMEP, FMEB
Changeover in Overhead Cost Controlling (CO-OM)

Purpose
When you change over from national currencies to the Euro, all relevant currency data in the system is converted. In Overhead Cost Controlling, the SAP-R/3 System converts the following data:

- Amounts in the controlling area currency
- Amounts in the object currency, such as cost center, order or project currencies
- Activity price units, should significant digits be lost when converting activity prices

You should ensure that reconciled data exists before and after the Euro changeover in Overhead Cost Controlling. To achieve this, SAP provides you with various Reconciliation Programs [Ext.] and reports, which can be executed in various phases of the changeover.

Prerequisites
In the Implementation Guide (IMG) for the Euro changeover, you have made preparations in Overhead Cost Controlling.

Process Flow
The following phases are significant for the changeover in CO-OM:
Changeover in Overhead Cost Controlling (CO-OM)

**Preparation** → see IMG

**Central Conversion**

- **Preparation Program**
  - ANALYZE
    - RKAABR01 (Consistency checks for control tables)
  - FILL
    - RKACOK01 (Key field determination in COKP und COKS)
    - RKASAC01 (Period balance calculation)
  - GENERATION
    - RKASAL02 (Correction of balance of settled CO-Objects)
    - RKACOF12 (Reconciliation of FI documents with the reconciliation ledger)
  - CONVERSION
    - RKACOR10 (Reconciliation of CO line items for payments)
  - RECON
    - RKACOR19

- **Postprocessing**
  - POST
    - RKAABR02 (Reconciliation of control tables with settlement)
    - RKACOR10
    - RKACOR19

**Cleanup** → RBPEWU1P (Correction of budget values)

For more information, see **Programs for the Changeover in Overhead Cost Controlling [Ext.]**.

**Result**

All relevant currency amounts have been changed over to EURO.

After the Euro changeover, you need to make some manual changes in the IMG for the Euro changeover. This is because the system does not convert certain tables.
Changeover Procedure for Overhead Cost Controlling (CO-OM)

Use

Within Overhead Cost Controlling you need to run certain reconciliation programs [Ext.], which ensure that reconciled data is available both before and after the Euro changeover. You need to run these programs in different phases.

Note, certain restrictions [Page 182] apply to the Euro changeover in CO-OM.

Features

Reconciliation for Settled Objects

Special reconciliation programs are required for objects that are credited with each settlement. These reconciliation programs ensure the following consistency conditions:

- If the balance for a settled object was zero before the Euro changeover, it should also be zero following the changeover. This is important as the system can usually only archive an object with a balance of zero.
- Even after the Euro changeover, settlement must be able to settle an object completely. To enable this, you need to reconcile the control tables from the settlement with the actual credit lines for an object.

Balance Reconciliation

To reconcile the balance, the system needs to determine which objects had a balance of zero before the changeover. To do this, start the RKASAL01 program in the FILL phase. For each object that has already been settled at least once, this program determines the balance of every individual posting period, using the COSP and COSS tables. These values are then saved in the EWUCOSUM table. The system does not change the EWUCOSM table during the subsequent changeover.

Once the actual changeover has ended, you must start the reconciliation program RKASAL02 in the RECON phase. For each settled object, the program uses the EWUCOSUM table to determine certain posting periods. These are the posting periods whose cumulated balance was zero before the changeover, cumulated meaning the balance of all the previous periods, and the period being processed. The program recalculates the current balance for each of these periods. If rounding differences occur, the system adjusts the settlement credits so that the balance returns to zero. This adjustment only takes place in the totals records created by the settlement. The program does not change any other totals records, nor does it produce any new line items.

If you have already posted new data after the Euro changeover, you can no longer start the RKASAL02 reconciliation program as the EWUCOSUM table becomes outdated.
The following are the totals records for an object that was already settled completely in a period:

**Before changeover:**

<table>
<thead>
<tr>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debit 1</td>
<td>2.01</td>
<td>3.01</td>
</tr>
<tr>
<td>Debit 2</td>
<td>4.01</td>
<td>0.00</td>
</tr>
<tr>
<td>Credit (settlement)</td>
<td>-6.02</td>
<td>0.00</td>
</tr>
<tr>
<td>Balance (→ EWUCOSUM)</td>
<td>0.00</td>
<td>3.01</td>
</tr>
</tbody>
</table>

**After changeover:**

<table>
<thead>
<tr>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debit 1</td>
<td>1.01</td>
<td>1.51</td>
</tr>
<tr>
<td>Debit 2</td>
<td>2.01</td>
<td>0.00</td>
</tr>
<tr>
<td>Credit (settlement)</td>
<td>-3.01</td>
<td>0.00</td>
</tr>
<tr>
<td>Balance</td>
<td>0.01</td>
<td>1.51</td>
</tr>
</tbody>
</table>

**After the reconciliation:**

<table>
<thead>
<tr>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debit 1</td>
<td>1.01</td>
<td>1.51</td>
</tr>
<tr>
<td>Debit 2</td>
<td>2.01</td>
<td>0.00</td>
</tr>
<tr>
<td>Credit (settlement)</td>
<td>-3.02</td>
<td>0.00</td>
</tr>
<tr>
<td>Balance</td>
<td>0.00</td>
<td>1.51</td>
</tr>
</tbody>
</table>

**Reconciling the settlement control tables**

When you settle an object, the system does not just create credit lines for this object. It also creates special settlement documents (AUAK, AUAA, AUAS, and so on) and creates another object management record (COSPD or COSSD) for each debit line. These control records determine which amount the system has already settled. After changeover, this data is not reconciled again. This could mean that an object can no longer be settled completely. In that case, the system settles either too much or too little.

The RKAABR02 reconciliation report adjusts the control tables for the settlement so that an object can always be settled completely. If you repeat a settlement after the changeover, the system can also create postings for it, providing no postings have meanwhile been made on the object. If the object had more than one settlement receiver or more than one settlement cost element, rounding differences can occur. These require repostings between receivers and/or cost elements.

You can start the RKAABR02 report after production operations resume (POST phase). You must, however, run the report **before the next settlement**. If the system finds rounding differences of more than 10 EUR during the reconciliation, the corresponding object is not reconciled and a message is created in the log. You need to analyze the unreconciled objects closely (if required, in cooperation with the SAP Hotline).
To ensure that inconsistencies were only a result of the Euro changeover, you should check the consistency of the settlement control tables in the analysis phase prior to the changeover. The RKAABR01 report (see "Preparation → Preparation in overhead cost controlling (CO-OM)" executes the same data as the RKAABR02 report, but does not change the data.

**Functionality Principles for the Reconciliation**

For each settled object, the total of the settled amounts in the control records COSPD, COSSD and COSBD, must correspond with the total for the settlement credits (COSP, COSS). If this is not the case, the system distributes the difference proportionally on the control records. The system does not change the credit lines. This procedure ensures that no residual balance exists if you settle the object fully.

For periods in the current fiscal year, where no cutoff period is set for the transaction "Actual settlement" (KOAO), the system compares the settlement credits with the settlement documents, especially with the values in the AUAS file. If the system detects differences, it corrects the AUAS records automatically. This ensures that there is no balance left on an object, even if period-based settlement is repeated.

**Phase Overview**

<table>
<thead>
<tr>
<th>Phase</th>
<th>Program</th>
<th>Observation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANALYZE</td>
<td>RKAABR01</td>
<td>Consistency check for settlement control tables</td>
</tr>
<tr>
<td>FILL</td>
<td>RKASAL01</td>
<td>Balance calculation for settled objects (fills the EWUCOSUM table)</td>
</tr>
<tr>
<td>RECON</td>
<td>RKASAL02</td>
<td>Balance reconciliation for periods, which previously had a cumulative balance of zero</td>
</tr>
<tr>
<td>POST</td>
<td>RKAABR02</td>
<td>Reconciling the settlement control tables</td>
</tr>
</tbody>
</table>

**Reconciling Commitments Totals and Down Payments Totals**

After the changeover, the values in the totals records usually differ from the total for the corresponding line items. However, no differences are allowed to exist between totals records and line items for commitments (COSP, value types 21/22/23) and down payments totals records (COSP, value types 12). Otherwise for commitments, this would mean that even after the complete reduction of commitments to zero, there would be a residual balance in the totals record (in the report). You cannot archive the object.

For down payments, no residual balance may remain in Controlling once the down payment in the FI component has been cleared. This is especially important for capital-investment measures for which down payments are settled to an asset under construction (AUC).

The RKACOR10 report recreates the commitments totals records (COSP) from the commitments line items (COOI). The RKACOR19 report Recreates the down payment totals records (COSP) from the down payment line items (COEP, value type 12) You should start both programs following resumed of production operations in the POST phase. However, these programs should be run at a time in which no postings are being made that change the values of down payments or commitments.
Phase Overview

<table>
<thead>
<tr>
<th>Phase</th>
<th>Program</th>
<th>Observation</th>
</tr>
</thead>
<tbody>
<tr>
<td>POST</td>
<td>RKACOR10</td>
<td>Recreation of commitments totals for CO objects</td>
</tr>
<tr>
<td>POST</td>
<td>RKACOR19</td>
<td>Recreation of down payments totals for CO objects</td>
</tr>
</tbody>
</table>

The Reconciliation Ledger

The reconciliation ledger (COFIT table) contains summarized information regarding all value flows into, within and from Controlling. The system creates the reconciliation ledger using the CO line items (COEP). However, it no longer contains any information about the individual CO objects. It does contain summary of the values for the following characteristics:

- Company code
- Business area
- Functional area
- Cost element
- Object type
- Object class

The reconciliation ledger also registers value flows between these characteristics, such as, between two company codes. You can post these CO internal value flows back to the FI component, either manually or automatically. If you implement cost-of-sales accounting, you can for example, post value flows between functional areas from the CO component back to the cost-of-sales accounting ledger.

After the Euro changeover, the values in the reconciliation ledger no longer agree exactly with the total of the corresponding CO line items. It is possible for you to recreate the reconciliation ledger from the CO line items, but SAP does not recommend this for run-time reasons.

During reconciliation posting from CO to FI, the system posts the value flows from the reconciliation ledger back to FI. It creates control records from the totals records in the reconciliation ledger for this purpose. These control records contain the amounts posted to FI. For legal reasons, the values in these control records must match up to those in the FI documents created after the changeover. To achieve this, you should start the RKACOFI2 report in the POST phase, following the Euro changeover. This report adjusts the control records for the reconciliation ledger (COFIT and COFIS) to the FI documents.

Before you start the RKACOF12 report, include note number 99900.

After the control records from the reconciliation ledger have been matched up to the FI documents, it is still possible that these differ from the totals records in the reconciliation ledger. You can repeat the reconciliation posting to reconcile CO and FI completely.
A value flow has occurred in Controlling between two function areas under two different secondary cost elements. However, the system creates only one FI document. The following data is the result:

**Before changeover:**

<table>
<thead>
<tr>
<th></th>
<th>Value flow (for example, in US $)</th>
<th>Reconciled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost element 1</td>
<td>2.01</td>
<td>2.01</td>
</tr>
<tr>
<td>Cost element 2</td>
<td>4.01</td>
<td>4.01</td>
</tr>
<tr>
<td>Total</td>
<td>6.02</td>
<td>6.02</td>
</tr>
<tr>
<td>FI document</td>
<td>602</td>
<td></td>
</tr>
</tbody>
</table>

**After changeover:**

<table>
<thead>
<tr>
<th></th>
<th>Value flow in EURO</th>
<th>Reconciled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost element 1</td>
<td>1.01</td>
<td>1.01</td>
</tr>
<tr>
<td>Cost element 2</td>
<td>2.01</td>
<td>2.01</td>
</tr>
<tr>
<td>Total</td>
<td>3.02</td>
<td>3.02</td>
</tr>
<tr>
<td>FI document</td>
<td>3.01</td>
<td></td>
</tr>
</tbody>
</table>

During a new reconciliation posting, the system posts the rounding difference of 0.01 EUR to the FI component as an additional value flow.

**After a new reconciliation:**

<table>
<thead>
<tr>
<th></th>
<th>Value flow</th>
<th>Reconciled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost element 1</td>
<td>1.01</td>
<td>1.01</td>
</tr>
<tr>
<td>Cost element 2</td>
<td>2.01</td>
<td>2.00</td>
</tr>
<tr>
<td>Total</td>
<td>3.02</td>
<td>3.01</td>
</tr>
<tr>
<td>FI document</td>
<td>3.01</td>
<td></td>
</tr>
</tbody>
</table>

The system removes rounding differences between the reconciliation ledger and FI in the local currency only. In the controlling area currency and the transaction currency, the documents created have a balance of zero. This means that the system displays them without a value in the overview of the reconciliation postings and in the FI document display.

**Phase Overview**

<table>
<thead>
<tr>
<th>Phase</th>
<th>Program</th>
<th>Observation</th>
</tr>
</thead>
<tbody>
<tr>
<td>POST</td>
<td>RKACOFI2</td>
<td>Reconciles the values of the reconciliation ledger with the FI documents</td>
</tr>
</tbody>
</table>
Reconciliation for Budget Values

Within a budget structure (such as a work breakdown structure) the system can distribute a budget from higher hierarchy levels to lower levels. However, the distributed budget may not exceed the original budget. The same rule applies when an overall budget is distributed over several fiscal years. To minimize such budget overruns during the EURO changeover, the system always rounds budget values down.

Nevertheless, it can still happen that the total of the distributed budget overruns the overall budget of the higher-level nodes. In this case, the system displays error messages during the budgeting transactions. To clean up such inconsistencies, you start the RBPEWU1P report following the Euro changeover. This report corrects the values of the budget hierarchies affected, for work breakdown structures in the BPGE and BPJA tables.

If you use budget distribution from the investment program to WBS elements when you budget investment programs, proceed as follows:

Once you have reconciled the budget values for the WBS elements, restart the reconciliation for budget values for investment programs. (RAIPEWU2 report).

Otherwise, errors in the budget distribution from the investment program position to the WBS elements could occur.

Before changeover:

<table>
<thead>
<tr>
<th></th>
<th>Parent</th>
<th>Child</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original budget</td>
<td>1000</td>
<td>1100</td>
</tr>
<tr>
<td>Supplement</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>1100</strong></td>
<td><strong>1100</strong></td>
</tr>
</tbody>
</table>

After changeover:

<table>
<thead>
<tr>
<th></th>
<th>Parent</th>
<th>Child</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original budget</td>
<td>499.99</td>
<td>549.99</td>
</tr>
<tr>
<td>Supplement</td>
<td>49.99</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>549.98</strong></td>
<td><strong>549.99</strong></td>
</tr>
</tbody>
</table>

After the reconciliation

<table>
<thead>
<tr>
<th></th>
<th>Parent</th>
<th>Child</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original budget</td>
<td>499.00</td>
<td>549.99</td>
</tr>
<tr>
<td>Supplement</td>
<td>50.00</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>549.99</strong></td>
<td><strong>549.99</strong></td>
</tr>
</tbody>
</table>

The system does not reconcile assigned values. For example, if the budget for an object was 100% exhausted prior to the changeover, the total of allotted funds may overrun the existing budget following the changeover, due to rounding differences.
The availability control settings determine whether further funds assignments are possible or not.

The system does not pass budget adjustments that occurred during reconciliation on to the availability control. If you want to inform availability control of the budget adjustments, you must recreate the assigned values.

### Phase Overview

<table>
<thead>
<tr>
<th>Phase</th>
<th>Program</th>
<th>Observation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleanup</td>
<td>RBPEWU1P</td>
<td>Reconcile budget values</td>
</tr>
</tbody>
</table>
Restrictions to the Changeover (CO-OM)

You should note the following restrictions during the Euro changeover.

- The system only converts the following to the transaction currency:
  - Values of cost element planning or detail planning that you manually entered in the controlling area currency (for changeover in a Release prior to Release 4.0 of the R/3 system)
  - Values of cost element planning or detail planning that you manually entered in the object currency (for changeover in a release prior to release 4.0 of the R/3 system)
  - Activity allocations for planning
  - Values in budgeting tables (even if the currency was freely-defined) and values for overall planning
  - Plan values for unit costing on internal orders.

- After the Euro changeover, the following inconsistencies can appear in the converted currency data in CO-OM:
  - The total of the line items no longer equals the value in the totals record.
  - An object whose balance was zero before the changeover has a balance that is not equal to zero after the changeover.
  - The G/L accounts in FI and the sum of the cost elements in CO no longer agree.
  - The sum of the line items in CO no longer matches the values in the reconciliation ledger.
  - The balance of the secondary cost elements in a controlling area is no longer zero.
  - When reversing postings that were created before the changeover, all rounding differences remain the same. The original and the reversal document do not match exactly. The reversal document is consistent, but differences may remain in the totals records.
  - If you repeat certain functions (such as overhead calculation or revaluation of actual activity prices) after the changeover, in a posting period in which these functions were already performed before the changeover, CO documents appear once again with rounding differences or a balance. This leads to new rounding differences in the reconciliation ledger.
  - Values that were calculated in multiple currencies can have different Euro amounts after the changeover. For example, if object currency and controlling area currency differ, but both are changed to Euro, this would lead to different Euro amounts in the object currency and controlling area fields after the changeover.
  - For budgeting, the sum of the fiscal year value is greater than the overall value.
  - Within a budget hierarchy (such as projects or capital investment programs) the sum of the budget values of a hierarchy level varies from the budget of the next-highest level.
  - Plan costs vary from unit costing
The system does not convert report extracts during the changeover. It always displays report extracts in the currency that they were created in, regardless of whether a changeover has taken place or not. Therefore, you should generate the reports after the changeover and recreate the report extracts.
Changeover in Product Cost Controlling (CO-PC)

Purpose
In Controlling, the changeover to the euro converts all values in the controlling area currency and object currency. The values are also partly converted into the transaction currency (with planned activity allocations and planned values in unit costing, for example).

The objects affected are those objects that can carry costs and revenue, such as production orders, sales orders, internal orders, cost objects, and other such objects.

Process Flow

Preparation

Central Changeover

Preprocessing

Conversion of tables (system block)

Postprocessing

Cleanup

Result
It must be assumed that data inconsistencies occur when converting the tables. Values that must be reconciled for technical or legal reasons are corrected using a special reconciliation report.

After the changeover to the euro, the following situations can appear in the converted currency data in CO-PC:

- The sum of the line items no longer corresponds exactly to the value in the totals record or in the cost element interval. This is particularly problematic in commitments management when after canceling a commitment, a difference remains in the totals record, rendering the object unable to be archived. A reconciliation report is available to solve this problem.
An object whose balance was zero before the changeover has a balance that is not equal to zero after the changeover. It must be guaranteed, however, that a settled order also has a balance of zero after the changeover. A reconciliation report helps achieve this goal.

The G/L account balances in FI and the sum of the cost elements in CO no longer agree. This can be the case, for example, with the data from results analysis (such as when WIP on order does not agree with WIP in Financial Accounting). Before performing the changeover, you can use a reconciliation report to determine whether particular differences exist that must be eliminated using manual postings. The same reconciliation report is used after the changeover to determine whether differences between the results analysis data from CO and the corresponding postings in FI were produced by the changeover. These must be corrected manually, as well.

When reversing postings that were created before the changeover, all rounding differences remain. The original and the reversal document do not agree exactly. The reverse document is consistent in itself, though differences can originate in the totals records.

If you repeat functions (such as overhead calculation or recalculation of actual activity prices) after the changeover in a posting period in which these functions were already performed before the changeover, controlling documents appear once again with rounding differences or a balance.

Values that are updated in multiple currencies can have different amounts after the changeover to the euro. This affects the different material prices, for example, that are updated in the Material Ledger and the planned values in unit costing. These differences are caused by the fact that the changeover to the euro takes place at a fixed exchange rate, while foreign currency translation takes place in the past at historical exchange rates.

You must be ready to deal with rounding differences between the prices in the material master (for materials with price control S) and the standard prices produced by the relevant standard cost estimates. Rounding differences can also appear in costed multilevel BOMs as well as in comparisons of itemizations and cost element itemizations or cost component splits.

This applies only to Release 4.0A and 4.0B:

The summarization levels for the product drilldown must be rebuilt after the changeover. Therefore, it is necessary to perform new data retrieval runs for the drilldown reports after the changeover.

Rounding differences between the individual objects in the summarized analysis may occur.

You summarize data with the use of an order hierarchy using the characteristics: plant and order type. After the changeover, it is possible for the sum of all costs in plant 0001 and the sum of all costs for order types in plant 0001 to be different.

You can eliminate the rounding differences by performing a new data retrieval after the changeover.

Quantity-based overhead is not converted to the euro. It is interpreted with the transaction currency upon overhead calculation and translated into the controlling area.
Currency. If you want to calculate quantity-based overhead using the euro, you must make the appropriate settings in Customizing after the changeover.

See also:
For further information, see the Implementation Guide (IMG) in the following sections:

- Preparing Product Cost Controlling
- Cleanup Product Cost Controlling
Changeover Procedure for Product Cost Controlling

Reconciliation

In the following, you will see an overview of all reconciliation programs that concern Product Cost Controlling. Please note that some reconciliation problems are not restricted to the area of CO-PC, but rather, are valid globally for all of Controlling. These reports must therefore be run **only once for Controlling**, but they are all mentioned here for the sake of completeness. Examples include programs for settlement or for commitments management. In addition, your system contains detailed report documentation about these programs.

<table>
<thead>
<tr>
<th>Application</th>
<th>Report name</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settlement (CO-wide)</td>
<td>RKAABR01</td>
<td>Checks the consistency of the settlement control tables in the analysis phase before the changeover.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Executes the same reconciliations as RKAABR02. However, it does not change the data.</td>
</tr>
<tr>
<td></td>
<td>RKAABR02</td>
<td>Adjusts the control tables for the settlement so that an object can always be settled completely.</td>
</tr>
<tr>
<td></td>
<td>RKASAL01</td>
<td>Determines, for each object that has already been settled at least once, the balance of every individual posting period, using the tables COSP and COSS. These values are then saved in the EWUCOSUM table.</td>
</tr>
<tr>
<td></td>
<td>RKASAL01</td>
<td>Uses the EWUCOSUM table to determine, for each settled object, those posting periods for which the cumulated balance (that is, the balance of all the previous periods, including the period being processed) was zero before the conversion.</td>
</tr>
<tr>
<td>Commitments Management (CO-wide)</td>
<td>RKACOR10</td>
<td>Recreates the commitments totals records (COSP) from the commitments line items (COOI).</td>
</tr>
<tr>
<td>Down Payments (CO-wide)</td>
<td>RKACOR19</td>
<td>Recreates the down payment totals records (COSP) from the down payment line items (COEP, value type 12)</td>
</tr>
<tr>
<td>Results Analysis Data (only for Cost Object Controlling)</td>
<td>SAPKKAE0 (up to 3.1x)</td>
<td>Compares the data from WIP calculation/results analysis in Cost Object Controlling with the amounts posted in FI, and it displays the differences. The report should be run before as well as after the changeover. Adjustment postings related to this must be performed manually.</td>
</tr>
</tbody>
</table>
Changeover Procedure for Product Cost Controlling

<table>
<thead>
<tr>
<th>SAPKKA14 (from 4.0X)</th>
<th>This is identical to SAPKKA0E0. In Release 4.0 the report name was changed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>RKKPERF</td>
<td>After distribution, the balance of the cost object hierarchy nodes must equal zero. This must not be the case after the local currency changeover. The program checks this, and sets the balance to zero if required. The program is available from Release 4.6A, and can be installed for Releases 4.5 and 4.0.</td>
</tr>
<tr>
<td>EWUMMCHK</td>
<td>Displays possible inconsistencies between the material stock accounts in Materials Management and Financial Accounting before the changeover to the euro.</td>
</tr>
<tr>
<td>EWUMMBST</td>
<td>Reconciles the material stock accounts of Materials Management with those of Financial Accounting in case you are upgrading from Release 3.0 or 3.1 to Release 4.0 as well as changing over to the euro.</td>
</tr>
</tbody>
</table>

In the following, you will see a description of the changeover procedure that is particular to the components of Product Cost Controlling.

**Product Cost Planning**

Material and unit cost estimates are converted automatically. However, rounding differences during changeover can cause inconsistencies between the sum of the individual line items and totals record. This is due to the fact that these values are converted individually.

You can correct the rounding differences in material cost estimates with quantity structure by creating the important standard cost estimates and costing runs again.

You can remove rounding differences in unit cost estimates by reevaluating [Ext.] the costing items after conversion.

⚠️ For items in category V, the total value is calculated with the new price (see example 1). The smaller the prices, the larger the rounding difference (see example 2).

When the prices are very small, it is possible that the value of the price in euro will be rounded to zero, causing the total value to be set to zero upon revaluation (see example 3).

You can prevent this problem by increasing the price unit for the euro before the changeover (see example 3A).
<table>
<thead>
<tr>
<th>Example 1:</th>
<th>Item</th>
<th>Price unit</th>
<th>Quantity</th>
<th>Price</th>
<th>Total value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before conversion</td>
<td>V</td>
<td>1</td>
<td>10</td>
<td>10 DM</td>
<td>100 DM</td>
</tr>
<tr>
<td>After conversion</td>
<td>V</td>
<td>1</td>
<td>10</td>
<td>5.13 euros</td>
<td>51.32 euros</td>
</tr>
<tr>
<td>After revaluation</td>
<td>V</td>
<td>1</td>
<td>10</td>
<td>5.13 euros</td>
<td>51.30 euros</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example 2:</th>
<th>Item</th>
<th>Price unit</th>
<th>Quantity</th>
<th>Price</th>
<th>Total value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before conversion</td>
<td>V</td>
<td>1</td>
<td>1000</td>
<td>0.15 DM</td>
<td>150 DM</td>
</tr>
<tr>
<td>After conversion</td>
<td>V</td>
<td>1</td>
<td>1000</td>
<td>0.07 euros</td>
<td>75 euros</td>
</tr>
<tr>
<td>After revaluation</td>
<td>V</td>
<td>1</td>
<td>1000</td>
<td>0.07 euros</td>
<td>70 euros</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example 3:</th>
<th>Item</th>
<th>Price unit</th>
<th>Quantity</th>
<th>Price</th>
<th>Total value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before conversion</td>
<td>V</td>
<td>1</td>
<td>1000</td>
<td>0.01 DM</td>
<td>10 DM</td>
</tr>
<tr>
<td>After conversion</td>
<td>V</td>
<td>1</td>
<td>1000</td>
<td>0 euros</td>
<td>5.13 euros</td>
</tr>
<tr>
<td>After revaluation</td>
<td>V</td>
<td>1</td>
<td>1000</td>
<td>0 euros</td>
<td>0 euros</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Example 3A:</th>
<th>Item</th>
<th>Price unit</th>
<th>Quantity</th>
<th>Price</th>
<th>Total value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before conversion</td>
<td>V</td>
<td>1000</td>
<td>1000</td>
<td>10 DM/1000 PC</td>
<td>10 DM</td>
</tr>
<tr>
<td>After conversion</td>
<td>V</td>
<td>1000</td>
<td>1000</td>
<td>5.13 euros/1000 PC</td>
<td>5.13 euros</td>
</tr>
<tr>
<td>After revaluation</td>
<td>V</td>
<td>1000</td>
<td>1000</td>
<td>5.13 euros/1000 PC</td>
<td>5.13 euros</td>
</tr>
</tbody>
</table>

When dealing with **currency translation for unit costing** the system proceeds as follows:

- If both currencies are converted, the exchange rate is automatically set to 1.
  - Example: 1 DEM = 0.4 x 2.5 FFR → 0.5 euro = 1 x 0.55 euro
- If only one of the two currencies is converted, the exchange rate is automatically adjusted.
  - Example: 1 DEM = 0.4 x 2.5 GBP → 0.5 euro = 0.162 x 2.5 GBP
Changeover Procedure for Product Cost Controlling

Cost Object Controlling: Reconciliation Program **SAPKKAEO or SAPKKA14**

This is the same program that had the name SAPKKAEO up until Release 3.1I. For Release 4.0A, the name of the program was changed to SAPKKA14.

Prerequisites

The balance carried forward must already be in the balance sheet account in Financial Accounting.

Use

1. Run reconciliation program SAPKKAEO or SAPKKA14 in Cost Object Accounting **before** the local currency changeover from your country currency to the euro. This report compares the results analysis data calculated in Cost Object Accounting (work in process or reserves for unrealized costs, for example) with the corresponding material stock accounts in Financial Accounting. Differences are listed for you in a log, and can be corrected manually. This way you avoid having the changeover from your country currency occur based on different values.

2. **After** the changeover from your country currency to the euro, perform a WIP calculation or a results analysis and settle the current period. Afterwards, run the reconciliation program again to determine if rounding errors resulted from the conversion. Differences are again listed for you in a log, and must be corrected manually.

The following can be reconciled with the reconciliation program:

- The results analysis data of WIP calculation in the *Product Cost by Order* and *Product Cost by Period* components
- The results analysis data in *Product Cost by Sales Order*

Integration

The reconciliation program compares the results analysis data from Cost Object Controlling with the values for the work in process and the automatically created reserves in Financial Accounting. There is no reconciliation against the data in *Profitability Analysis* (CO-PA) or *Profit Center Accounting* (CO-PCA).

Features

You run the reconciliation program SAPKKAEO or SAPKKA14 for each controlling area.

For each company code and (optionally) for each business area, the reconciliation program reads the postings according to the posting rules in Cost Object Controlling and the values posted to the accounts in Financial Accounting. The reconciliation program will indicate if the results analysis data calculated in Cost Object Controlling does not match the values posted to the balance sheet accounts in Financial Accounting.

Activities

1. Run the reconciliation program.

2. If the reconciliation program finds differences, you can correct them by means of manual repostings.

3. Perform the local currency conversion.
4. Run the reconciliation program again.
5. If the conversion resulted in rounding differences, you must correct these with manual postings.

**Cost Object Controlling: Reconciliation Program RKKPERF**

**Prerequisites**
You are using a cost object hierarchy to which actual costs are distributed (cost object hierarchy with distribution).
You have distributed the actual costs from the cost object nodes to the assigned objects. The balance on the cost object nodes is zero.

**Use**
The purpose of reconciliation program RKKPERF is to ensure that the balance of the cost object nodes remains at zero after the local currency conversion.

**Activities**
1. Perform the actual costs distribution.
2. Perform the local currency conversion.
3. Run reconciliation program RKKPERF.

**Actual Costing/Material Ledger**
Because this component was only available to pilot customers before Release 4.0A, the conversion only refers to release levels from 4.0A onwards.

If you are using the Actual Costing/Material Ledger component, you can carry out the conversion using reports in Materials Management.

**Use**
1. **Before** the conversion, run report EWUMMCHK to find the differences between the material stock accounts in Materials Management and Financial Accounting.
2. **During** the conversion, the following data are converted automatically:
   - Material ledger documents (report SEUZCKML1)
   - Material ledger data (report SEUZCKML2)
3. **After** the conversion, run report EWUMMBST to find and deal with differences and to check the account maintenance.
Changeover in Profitability Analysis (CO-PA)

The documentation on the currency changeover in Profitability Analysis is divided into separate sections for account-based and costing-based CO-PA.

The procedure for converting these two forms of CO-PA is identical. The currency conversion is performed exclusively using the EURO conversion tool. This program converts all the currency-relevant CO-PA tables by completed fiscal year. No program modifications in CO-PA are necessary.

The differences arise only in the tables and objects that are converted.
Changeover in Costing-Based Profitability Analysis

Purpose
The currency changeover in Profitability Analysis (CO-PA) is carried out exclusively using the EURO conversion tool. This program converts all the currency-relevant CO-PA tables by completed fiscal year. No program modifications in CO-PA are necessary. Moreover, special programs are available for providing the conversion tool with the information necessary for the conversion. These programs are executed automatically. All you need to do in CO-PA is carry out the preparation and cleanup manually (see the relevant sections in the IMG for European Monetary Union).

Process Flow
The following CO-PA specific programs are called up during the corresponding phases of the general changeover:

1. **Preparation**
   - See IMG

2. **Central changeover**
   - **Preprocessing**
     - ANALYZE RKEB0902_40 (Analysis of report data to be changed over)
   - **Conversion of tables (system lock)**
     - FILL EWUCOLS_40 (Provision of control tables for conversion of the CE* table and summarization levels)
     - GENERATION CONVERSION RECON
   - **Postprocessing**
     - POST RKEB0902_40 (Changeover of report data)

3. **Cleanup**
   - See IMG

💡 Brief documentation has been produced for each of these programs (transaction SE38 - Enter Program Name - Display 'Documentation'). This can be if errors occur, for example.

The **WAERS** field in table **TKEB** contains the currency for tables CE1xxx, CE2xxx, and CE3xxxx in operating concern xxxx. The conversion tool uses this table to interpret the values posted in tables CE1-CE3, and then converts those values into the new currency (euros). Likewise, the exchange rate (field **KURSF**) in the actual line item table CE1xxxx is converted to
Changeover in Costing-Based Profitability Analysis

the new operating concern currency. The summarization levels contained in the operating concern are also converted. Then the new currency is entered in table TKEB.

If your data in CO-PA is updated in both the operating concern currency and the company code currency, these values are distinguished by the field PALEDGER in tables CE1-CE3. These records are translated to the new currency (euros) if the corresponding company code is converted. This is also true for any existing summarization levels.

Also, the field REC_WAERS, which stores the currency of the line items posted in Profitability Analysis starting in Release 4.0, is converted if it is not empty. This applies to line items that were posted before Release 4.0.

Result

The following tables in costing-based CO-PA are converted during the currency changeover:

- CE1xxxx Actual Data, Costing-Based CO-PA
- CE2xxxx Plan Data, Costing-Based CO-PA
- CE3xxxx Segment Level, CO-PA
- K81xxxx Summarization Levels, Costing-Based CO-PA
- TKEB Currency of Operating Concern, Costing-Based CO-PA
- COIX_DATA_40 Report Data (only converted in costing-based CO-PA)
- TKEBZ Exceptions for Reports

Converting Stored Report Data

Constraints

Report data is only converted in costing-based CO-PA for reports that only contain data in the operating concern currency!

Report data for reports that display both the operating concern currency and the company code currency is not converted. You can find further information in the IMG for European Monetary Union, under Local Currency Changeover → Cleanup → Cleanup in Controlling → Cleanup in Profitability Analysis → Reconstruct Report Data.

Process Flow

Report data is converted after the central changeover, following the so-called “system lock” in the POST phase. The report data is then automatically changed over to the new currency. This applies to both “frozen” report data and summarization data.

All reports are regenerated during conversion. Exceptions in reports are likewise converted.

⚠️

You cannot call up any reports until conversion of the reports has been completed.

You can find further information about converting reports in the IMG for European Monetary Union, under Local Currency Changeover → Preparation → Preparation in Controlling → Preparation in Profitability Analysis → Preparation in Reporting.
Condition Tables

Condition tables are not converted, since it may make sense to keep the condition records in the old currency. An example of this would be if you have customer-specific conditions for customers that still use the old currency.

You can handle condition tables in a number of ways following the currency changeover. For more information, see the IMG for European Monetary Union, under Cleanup in Profitability Analysis → Process Conditions (Costing-Based CO-PA).

Rounding Differences in Translation

Because line items and totals records (and segment level) are converted separately, inconsistencies may arise due to rounding differences.

These rounding differences do not impair the functionality of CO-PA and so do not pose a problem that needs to be resolved. This problem does not arise with data posted after the conversion.

Two actual line items are posted in table CE1xxxx that are merged to form one totals record in the segment level CE3xxxx.

The exchange rate for the currency conversion is 1.81238 DEM/EUR.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Value</th>
<th>Value following conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE1xxxx</td>
<td>Line item 1</td>
<td>100.00</td>
<td>55.18 EUR</td>
</tr>
<tr>
<td>CE1xxxx</td>
<td>Line item 2</td>
<td>15.00</td>
<td>8.28 EUR</td>
</tr>
<tr>
<td></td>
<td>Total of line items 1 and 2</td>
<td>115.00</td>
<td>63.46 EUR</td>
</tr>
<tr>
<td>CE3xxxx</td>
<td>Record in segment level for line items 1 and 2</td>
<td>115.00</td>
<td>63.45 EUR</td>
</tr>
</tbody>
</table>

Following the changeover, the sum of the line items is no longer equal to the sum in the segment level.
Changeover in Account-Based Profitability Analysis

Purpose

The currency changeover in Profitability Analysis (CO-PA) for the local currency is carried out exclusively using the EURO conversion tool. This program converts all the currency-relevant CO-PA tables by completed fiscal year. No program modifications in CO-PA are necessary. Moreover, special programs are available for providing the conversion tool with the information necessary for the conversion. These programs are executed automatically. All you need to do in CO-PA is carry out the preparation and cleanup manually (see the corresponding sections on EMU in the IMG).

Process Flow

The conversion programs for Overhead Cost Controlling (CO-OM) also convert the data in account-based CO-PA.

In tables COEJ, COEP, COSS, and COSP, the fields for the controlling area currency and the object currency are translated to the new currency (euros), though only if the company code or controlling area to which they belong is participating in European Monitory Union (EMU).

Summarization levels are likewise converted.
Result
The following tables in account-based CO-PA are converted during the currency changeover:

- COEJ  Actual/Plan Line Items (by Year), Account-Based CO-PA
- COEP  Actual/Plan Line Items, Account-Based CO-PA
- COSS  Totals Records, Account-Based CO-PA
- COSP  Totals Records, Account-Based CO-PA
- K82xxxx Summarization Levels, Account-Based CO-PA

Converting Stored Report Data
Report data for reports in account-based CO-PA is not converted. This data is set to the status “inactive” and needs to be rebuilt from the line items before it can be used again in reports. If you call up one of these reports without first creating the report data, the system tells you that no such data was found (if it was defined to do so in Customizing).

You can find further information in the IMG for European Monetary Union, under Local Currency Changeover → Cleanup → Cleanup in Controlling → Cleanup in Profitability Analysis → Reconstruct Report Data.

Translation Differences
Because line items and totals records (and segment level) are converted separately, inconsistencies may arise due to rounding differences.

These rounding differences do not impair the functionality of CO-PA and so do not pose a problem that needs to be resolved. This problem does not arise with data posted after the conversion.
Changeover in Real Estate Management (IS-RE)

Purpose

During the changeover to euro, all condition amounts for which the currency participates in the euro are converted. To do this, the system uses the fixed exchange rate for the conversion package. After the conversion, all condition amounts only exist in euro (rental unit, rental agreement, historical conditions).

Rental agreements

The changeover of rental agreements is the key aspect of local currency conversion. The changeover of the rental agreement currency is carried out uniformly for all rental agreements at one particular time. It is not possible to convert rental agreements individually. Consequently all rental agreements in the system that originally belonged to the euro currency group are now maintained in euro after the changeover date.

Rental units and management contracts

The changeover of the conditions is carried out in the same way as for the rental agreements.

Service charge settlement

The service charge settlement uses totals records from CO files. The changeover of the totals records is carried out using the Controlling changeover programs.

Input tax treatment

During changeover to the euro, the tables containing information on the breakdown of the tax amounts into deductible and non-deductible portions are also converted. The changeover of the related documents in financial accounting is carried out using the Financial Accounting changeover programs.

Prerequisites

The changeover of local currency for IS-RE can only be carried out at the same time as the changeover of the Financial Accounting and Controlling application components.

Process Flow

The actual changeover is carried out in three stages: "preprocessing", "changeover" and "postprocessing" using the R/3 changeover package (see the graphic below).

💡 In the preparatory phase, you must ensure all the prerequisites for the actual changeover are met.

After the changeover to the euro, you have to carry out certain cleanup activities.

The following graphic shows the process of local currency changeover for Real Estate Management:
Preparation

See Implementation Guide

Central changeover

Preprocessing

No specific programs required

ANALYZE

FILL
GENERATION
CONVERSION

SEUBBPRE (Line items for correction items)
SEUVIBEP (Flowdata – rental agreement/rental unit/management contract)
SEUVZZUS (Rental agreement subsidy data)
SEUVZSOR (Rental agreement user values)
SEUVZZKO (Conditions for rental agreement/rental unit/management contract)
SEUVIKOK (Rental agrmt and related data)
SEUBBPOS (Rounding of correction items)

Table conversion (system lock)

RECON

Postprocessing

No specific programs required

POST

Cleanup

See Implementation Guide

Result

Tables affected by the conversion:

<table>
<thead>
<tr>
<th>Phase</th>
<th>Program</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILL</td>
<td>SEUBBPRE</td>
<td>VITAXA: Line items for correction items</td>
</tr>
<tr>
<td>CONVERSION</td>
<td>SEUVIBEP</td>
<td>VIBEPP: Flow data - planning items for Real Estate Management</td>
</tr>
<tr>
<td>CONVERSION</td>
<td>SEUVZZUS</td>
<td>VZZUSP: Payment splitting</td>
</tr>
<tr>
<td>CONVERSION</td>
<td>SEUVZSOR</td>
<td>VZSORT: Sorting values for objects (object user fields)</td>
</tr>
<tr>
<td>CONVERSION</td>
<td>SEUVZZKO</td>
<td>VZZKOPO: Condition items table</td>
</tr>
<tr>
<td></td>
<td>SEUVIKOK</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>CONVERSION</td>
<td>VIKOKO: Real Estate condition header</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VIMI25: Sales reports</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VIMI33: Offers for rental units</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VIMIMV: Rental agreements</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VIMIUH: Sales-based commercial RA header (agreements on sales volume)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VIMIU: Sales-based commercial RA items (agreements on sales volume)</td>
<td></td>
</tr>
<tr>
<td>RECON</td>
<td>SEUBBPOS</td>
<td>VITAXA: Line items for correction items</td>
</tr>
</tbody>
</table>
Changeover in Materials Management (MM)

Purpose
In the Materials Management (MM) component, materials management data can be managed in various organizational units, for example, company code or purchasing organization. These can have various currencies.

During the changeover to the euro, the amounts of all the documents in the system in local currency are converted to the euro for those organizational levels that you have defined in Customizing. Archived documents are not converted.

For all valuation areas in which currency is being changed over to the euro, the stock values of the materials are also converted.

No provision has been made for changing over individual valuation areas.

Process Flow
The following graphic shows the procedure for local currency changeover in Materials Management:

For more information on the programs, refer to the Implementation Guide (IMG) for European Monetary Union: Euro.

Result
Tables Affected by the Changeover in Materials Management:

Development Class ME
## European Monetary Union: Euro (CA-EUR)

### Changeover in Materials Management (MM)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EBAN</td>
<td>Purchase requisition</td>
</tr>
<tr>
<td>EBKN</td>
<td>Purchase requisition account assignment</td>
</tr>
<tr>
<td>EINE</td>
<td>Purchasing info record - purchasing organization data</td>
</tr>
<tr>
<td>EIPA</td>
<td>Order price history record</td>
</tr>
<tr>
<td>EKAB</td>
<td>Release documentation</td>
</tr>
<tr>
<td>EKBE</td>
<td>Purchasing document history</td>
</tr>
<tr>
<td>EKBEH</td>
<td>Purchase order history records removed from storage</td>
</tr>
<tr>
<td>EKBBZ</td>
<td>Purchasing document history - delivery costs</td>
</tr>
<tr>
<td>EKKN</td>
<td>Account assignment in purchasing document</td>
</tr>
<tr>
<td>EKKK</td>
<td>Purchasing document header</td>
</tr>
<tr>
<td>EKPO</td>
<td>Purchasing document item</td>
</tr>
<tr>
<td>T161I</td>
<td>Determination of release strategy</td>
</tr>
</tbody>
</table>

### Development Class MCE

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCEKS</td>
<td>R/2 EKS data (status of last data transfer)</td>
</tr>
</tbody>
</table>

### Development Class ML

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESKL</td>
<td>Account assignment specification for service line</td>
</tr>
<tr>
<td>ESKN</td>
<td>Account assignment in service package</td>
</tr>
<tr>
<td>ESLH</td>
<td>Service package header data</td>
</tr>
<tr>
<td>ESLL</td>
<td>Lines in service package</td>
</tr>
<tr>
<td>ESSR</td>
<td>Service entry sheet header data</td>
</tr>
<tr>
<td>ESUK</td>
<td>External Services Management. Unplanned limits for contract item</td>
</tr>
<tr>
<td>ESUH</td>
<td>External Services Management. Unplanned service limits header data</td>
</tr>
<tr>
<td>ESUP</td>
<td>External Services Management. Unplanned limits for service packages</td>
</tr>
<tr>
<td>ESUS</td>
<td>External Services Management. Unplanned limits for service types</td>
</tr>
</tbody>
</table>

### Development Class MB

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISEG</td>
<td>Physical inventory document items</td>
</tr>
<tr>
<td>MSEG</td>
<td>Document segment: material</td>
</tr>
<tr>
<td>MKP_F</td>
<td>Document header: material document</td>
</tr>
</tbody>
</table>

### Development classes MG, MGAD, MGA

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAPE</td>
<td>Material master: Export control file</td>
</tr>
<tr>
<td>MARC</td>
<td>Material master-C-segment</td>
</tr>
<tr>
<td>MARC_TMP</td>
<td>File for incorrect data during direct input</td>
</tr>
<tr>
<td>MARD</td>
<td>Material master warehouse/batch segment</td>
</tr>
<tr>
<td>MARD_TMP</td>
<td>File for incorrect data during direct input</td>
</tr>
<tr>
<td>MBEW</td>
<td>Material valuation</td>
</tr>
<tr>
<td>MBEW_TMP</td>
<td>File for incorrect data during direct input</td>
</tr>
<tr>
<td>MDIP</td>
<td>Material: MRP profiles (field contents)</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>MKOP</td>
<td>Consignment price segment</td>
</tr>
<tr>
<td>EBEW</td>
<td>Valuation of sales order stock</td>
</tr>
<tr>
<td>QBEW</td>
<td>Valuation of project stock</td>
</tr>
</tbody>
</table>

Development class MR, MRM

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSIM</td>
<td>Secondary index - documents for material</td>
</tr>
<tr>
<td>MYMFT</td>
<td>FIFO Results table</td>
</tr>
<tr>
<td>MYML</td>
<td>LIFO material layer</td>
</tr>
<tr>
<td>MYMLM</td>
<td>LIFO material layer (monthly)</td>
</tr>
<tr>
<td>MYMP</td>
<td>LIFO period stocks, single material</td>
</tr>
<tr>
<td>MYMP1</td>
<td>Receipt data LIFO/FIFO valuation</td>
</tr>
<tr>
<td>MYPL</td>
<td>LIFO pool layer</td>
</tr>
<tr>
<td>MYPLM</td>
<td>LIFO Pool layer (monthly)</td>
</tr>
<tr>
<td>RBCO</td>
<td>Document item, incoming invoice account assignment</td>
</tr>
<tr>
<td>RBDIFFKO</td>
<td>Invoice Verification - conditions</td>
</tr>
<tr>
<td>RBDIFFME</td>
<td>Invoice verification in background - quantity differences</td>
</tr>
<tr>
<td>RBDRSEG</td>
<td>Invoice verification in background - invoice document items</td>
</tr>
<tr>
<td>RBKP</td>
<td>Document header: incoming invoice</td>
</tr>
<tr>
<td>RBKP8</td>
<td>Invoice document header (invoice verification in background)</td>
</tr>
<tr>
<td>RBTX</td>
<td>Taxes: incoming invoice</td>
</tr>
<tr>
<td>RBVD</td>
<td>Invoice document - summarization data</td>
</tr>
<tr>
<td>RBVDMAT</td>
<td>Invoice Verification - summarization data, material</td>
</tr>
<tr>
<td>RBWT</td>
<td>Withholding tax: incoming invoice</td>
</tr>
<tr>
<td>RKWA</td>
<td>Consignment withdrawals</td>
</tr>
<tr>
<td>RSEG</td>
<td>Document item, incoming invoice</td>
</tr>
</tbody>
</table>

For exact rules on the conversion of tables, refer to table EUSH.

There is a special rule for the table EBAN, the tables belonging to development class ML, and the corresponding conditions (in table KONV).

This is because services can have a different currency type (transaction currency or local currency), depending on whether they are listed in purchase requisitions or purchase orders.

See also:

Changeover Procedure in Materials Management [Page 204]
Changeover Procedure in Materials Management

Use
Most of the Materials Management data is converted automatically by the R/3 changeover package. This carries out the preprocessing, conversion, and postprocessing steps.

Features

Preprocessing
During this phase, the system checks whether the material stocks (MM) are the same as the material stock accounts in the general ledger (FI) for all company codes that are included in the changeover to the euro (report EWUMMCHK_40).

The system usually carries out the analysis for inconsistencies in the preprocessing phase, i.e. normally there are no differences. If there are still differences in the system, it cannot begin the conversion of the tables. The system issues an error log of all differences.

In this case, carry out the steps described in the Implementation Guide for European Monetary Union: Euro under Local Currency Changeover → Preparation → Preparation in Materials Management (MM).

During preprocessing, the system also starts reports to insert the missing data required by the reports in purchasing tables (EWUMEBAN_40, EWUMPOHD_40, EWUMEKAB).

Conversion
During this phase, the system converts the following data to the euro:

- local currency amounts, exchange rates, and pricing conditions for all MM documents, including the purchase order history
- stock values and material prices
- specifications of amounts in Customizing for MM
- LIFO layers, FIFO results records, receipt data

Postprocessing
During this phase, the system clears up any differences arising from the changeover from local currency to the euro:

- For split valuation, the system replicates the values in the totals record of table MBEW from the total of the individual valuation records for the current period, the previous period and the previous year (report EWUMMBEW).
- The system recalculates the moving average prices from the stock value and the stock quantity in the valuation segment for Materials Management (table MBEW). (report EWUMMPRS).
- The system replicates the balances between MM and FI. During this process, the system compares the total values of the material valuation segments for a stock account with the balance of this stock account and outputs the difference. The rounding differences that the system determines are written in database table EWUMMFI and are used as the basis for manual postings in MM sub-ledger accounting (report EWUMMBST).
The system then corrects the purchase order history.

- The system compares the purchase order history records with the line items in the GR/IR clearing account. If it finds any differences, it saves them in table EWUMMFI with the allocation number from the purchase order number and the item number. The system later reconciles the GR/IR account on the basis of these entries.

  This also applies to the clearing account for delivery costs.

- The system replicates the goods receipt and invoice receipt values in the purchase order history. If the total of the quantity calculated and the goods receipt quantity are the same, the system corrects the purchase order history records so that the totals of the goods receipt and the invoice values correspond.

Note that you cannot carry out FI-MM postings during postprocessing.

The system issues a log for each report. This informs you about the procedure and possible differences. The differences themselves are recorded in table EWUMMFI.

Differences that arise should be cleared immediately after the changeover. For more information, refer to the European Monetary Union: Euro Implementation Guide under Local Currency Changeover \rightarrow Central Changeover \rightarrow Central Changeover: Postprocessing \rightarrow Postprocessing \rightarrow Start Postprocessing Programs Individually \rightarrow EWUMFPST: Clear Differences

Reconciliation

Very small differences may occur because amounts are rounded to the nearest cent. If this leads to inconsistencies (for example, the stock value is not equal to the quantity x the price), a reconciliation is required after the local currency changeover.

If necessary, differences that occur are taken into account during the changeover procedure and corrected automatically.

After the changeover, the following reconciliations are carried out:

- Comparison of valuation segments (MM) with Financial Accounting (FI).
- Reconciliation of totals segment from the valuation segments for split-valuated materials.
- Reconciliation between material price and stock value and quantity in the valuation segment.
- Reconciliation of purchase order history records with the line items of the GR/IR clearing account and the clearing account for delivery costs.

The reconciliation of the balances to zero in the accounting documents is taken into account during the reconciliation in Financial Accounting.

The LIFO/FIFO receipt data is not reconciled with the material documents and accounting documents that have been converted. Provided that no material documents or settlements have been archived for production orders, if required, the LIFO/FIFO receipt data can be recompiled via a document extract after the changeover.

Dealing With Archived MM Documents

Archived documents are not converted because the reloading of documents is not supported in Materials Management.
However, you can recompile statistics files from the archive whenever you wish. Whenever you recompile, the system reads the archived documents and converts the amounts in local currency to the euro for the statistics file.
Changeover of the Executive Information System

The local currency changeover converts all of the local currencies participating in EMU to the Euro. All of the currency types that are valid as local currencies, such as the company code currency, are contained in the delivered Customizing for the local currency changeover. There are no currency types in EC-EIS, but there different ways of determining the currency of a key figure, that can be translated 1:1 into currency types.

Currencies in EC-EIS are stored EIS-specifically. In the 4.0 release of EC-EIS there are three possible ways of determining in which currency data should be stored for a key figure. You can find further information on these possibilities in the section [Currencies in EC-EIS [Ext].] The following section explains how the currency type is determined in the currency changeover:

1. Currency established using aspect
   The currency type AS is determined from the central table.

2. Fixed currency for basic key figure stored
   The currency type KF is determined from the central table.

3. Attach currency to characteristic value
   Currency is attached to a characteristic value of another application (so-called reference currency):
   In EC-EIS you have the possibility of defining a currency reference on currency-bearing characteristics from other applications, such as the company code. In this case the currency type of the original field is determined and assigned to the key figure field (for example, currency type ‘10’ company code currency).
   Key figures whose currencies depend on the characteristic data area also belong to this category.

   Currency attached to characteristic value of an EC-EIS characteristic:
   It is also possible to define a currency reference to a currency-bearing characteristic created in EIS. In this case a new currency type is generated and assigned to the key figure field. The currency types are E*, where the * is replaced by a counter.

The currency type of the central local currency changeover corresponds to the reference table and the reference field of the key figure in EC-EIS. Using the following example you can see the connection between the currency type and the currency stored in EC-EIS:

<table>
<thead>
<tr>
<th>Currency in EC-EIS established using</th>
<th>Reference characteristic</th>
<th>Reference table RFTAB</th>
<th>Reference field RFFIE</th>
<th>Currency type in central table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect</td>
<td>-</td>
<td>T242A</td>
<td>ACUKY0</td>
<td>AS</td>
</tr>
<tr>
<td>Basic key figure</td>
<td>-</td>
<td>TKCF</td>
<td>CUKY0</td>
<td>KF</td>
</tr>
<tr>
<td>Characteristic from another application</td>
<td>BUKRS, company code</td>
<td>T001</td>
<td>WAERS</td>
<td>10</td>
</tr>
<tr>
<td>Characteristic</td>
<td>VERSO, Data area</td>
<td>T242V</td>
<td>WAERS</td>
<td>VS</td>
</tr>
</tbody>
</table>
We recommend that where possible you carry out the currency changeover for the data in EC-EIS within the framework of a changeover of the entire system.

However, the possibility for a separate conversion of EC-EIS does exist. Please note that a changeover of all of the EC-EIS data separate from other applications is only possible if no key figures use a reference currency, meaning that no key figures are assigned to another application using a currency-bearing characteristic, such as BUKRS.

The currency changeover in EC-EIS takes place for all fiscal years. Archives are not converted.

The EC-EIS-specific restrictions in the local currency changeover are dealt with in section Restrictions to the Changeover [Page 210].

**Prerequisites**

You have carried out the necessary Preparation.

As the database tables are not created in EC-EIS until the system is set up, the EC-EIS Customizing tables for the changeover to the Euro must be imported and all created aspects with their fields made known to the central local currency changeover programs. The loading reports EWUEISLO and EWUEISLS are available for this.

The loading reports start the conversion of all generated aspect tables in EIS as well as the currency key in the check tables generated in EC-EIS, the version table and the key figure currency. Therefore, all data is converted with the central local currency changeover by default.

Programs EWUEISLO and EWUEISLS are automatically started during the local currency changeover. You can find further information on this in the online documentation that comes with the programs.
**Process Flow**

After you have carried out the preparation, carry out the central local currency changeover. The loading programs then run automatically. You can find further information on the central changeover in the section Central Changeover [Page 126].

**Result**

The data in EC-EIS is converted into the Euro. The steps to be carried out after the changeover are described in the section Cleanup in the Executive Information System.
Constraints on the Changeover (EC-EIS)

The following restrictions apply to the local currency changeover in the Executive Information System (EC-EIS):

Variations from the EC-EIS currency concept

If your system does not adhere to the currency concept described in the section Changeover of the Executive Information System [Page 207], please note that the relevant data is not converted in the course of the central local currency changeover. An example of such a development would be the storing of a currency key as a characteristic (with characteristic values DEM, FRF etc.) and the use of this characteristic as a reference for the currency of the key figures. Fields of type CHAR cannot be recognized by the system as currency-relevant fields, the system only recognizes CUKY fields as being currency-relevant. In such cases you must take care of the translation of your data.

Rounding-off differences and agreement with other components

Rounding-off differences that exist in the local currency changeover can mean that the EC-EIS data varies slightly from the data of other applications, such as FI.

Currency keys in translation types and transfer rules

The system cannot convert to the currency derived in the translation types and transfer rules because it cannot recognize the currency type. In the transfer rules an automatic decision cannot be made as to whether the source currency (for example, a file to be imported) is still in DEMs or whether the data should be transferred in Euros in the future. In reporting, number displays and exceptions are also not adjusted. You can find further information on the necessary cleanup steps in Cleanup in the Executive Information System.
Changeover in Profit Center Accounting (EC-PCA)

Purpose

The local currency changeover converts all profit center data stored in the local currency and profit center currency fields. If the local currency or profit center currency fields contain a currency not affected by the changeover (such as “USD”), the system does not convert this data.

Both the amount fields and the currency keys are converted in Profit Center Accounting. Information on how the currency key and currency type are to be converted is stored for each affected field.

The currency key of the local currency is found based on the company code (currency type 10, HSL fields).

The currency key of the profit center currency is dependent on the currency type (KSL fields). The profit center currency can be one of the following currency types:

- Controlling area currency (currency type 20)
- Group currency (currency type 30)
- Any specially defined profit center currency (currency type 90)

Note that the transaction currency is only converted if the balances for the respective account are only stored in the local currency (TSL fields). Also, note that plan data in the transaction currency is not converted. The currency key of the transaction currency is found based on the field RTCUR.

It is recommended that you carry out the currency changeover in EC-PCA during the system-wide changeover.

The currency changeover in EC-PCA applies to all fiscal years. Archives are not converted.

The limitations in EC-PCA with regard to the local currency changeover are discussed in the section Constraints on the Changeover [Page 213].

Prerequisites

You have carried out the preparatory steps for changing over the profit center data.

Process Flow

The following graphic shows the process for changing over the local currency in Profit Center Accounting:
1. First, you must carry out preparatory steps for Profit Center Accounting (see Preparation in Profit Center Accounting in the Implementation Guide (IMG)).

2. Carry out the central changeover of the local currency. For more detailed information, see Central Changeover.

3. To reconcile the actual data in Profit Center Accounting with the data in Financial Accounting (FI), execute program RCOPCA44 again with the option of carrying out the reconciliation. For more information, see Cleanup in Profit Center Accounting in the Implementation Guide (IMG).

**Result**

The data in Profit Center Accounting is translated to euros.

Note that inconsistencies are likely to arise due to rounding differences. For more information, see Constraints on the Changeover [Page 213].
Constraints on the Changeover (EC-PCA)

Inconsistencies are likely to arise in several instances due to rounding differences. This can occur in the following instances:

- The sum of the line items may not correspond precisely to the value in the totals record.
- A profit center that had a balance of 0 before the conversion will have a value following the conversion.
- The balance of all secondary cost elements in one controlling area may no longer be 0.
- Reversing postings created before the conversion may not result in a balance of 0.
- Values stored in difference currencies before the conversion (for example profit center currency FRF and local currency DEM) may show different amounts in euros after the conversion.
- Period data will be consistent again starting with the first period following the local currency changeover.
- The G/L account balances in FI and EC-PCA are no longer consistent.

You can find and reconcile rounding differences between FI and EC-PCA using program RCOPCA44. For more information, see Postprocessing in Profit Center Accounting in the Implementation Guide (IMG).
Cleanup

Purpose
Following local currency changeover, the user departments must carry out certain reconciliation tasks manually. This primarily involves maintaining those tables that were not taken into account during the central changeover.

Prerequisites
- The system administration must have completed the central changeover.
- The changeover package is in the READY phase.

Process Flow
The activities are described in the Implementation Guide.

Cleanup is necessary in the following components:
- Local currency changeover (FI-AP/FI-AR/FI-GL)
- Asset Accounting (FI-AA)
- Special Purpose Ledger (FI-SL)
- Funds Management (FI-FM)
- Overhead Cost Controlling (CO-OM)
- Product Cost Controlling (CO-PC)
- Profitability Analysis (CO-PA)
- Profit Center Accounting (EC-PCA)
- Executive Information System (EC-EIS)
- Real Estate Management (IS-RE)
- Project System (PS)

Result
Once all cleanup activities have been completed, the whole process of local currency changeover is then finished.
Cleanup in Treasury (TR)

Purpose
If you are using the components TR-TM-SE, TR-LO or TR-CM, you will need to carry out cleanup activities after the local currency changeover.

Prerequisites
Your system administrators must have successfully completed the central changeover.

Process Flow
The respective procedures are described in the following sections.

- Reconciling TR-TM-SE and FI Balances [Page 216]
- Adjusting Selection Criteria (TR-LO) [Page 217]
- Data Correction in Cash Management (TR-CM) [Page 218]

In the money market, foreign exchange and derivatives areas, no cleanup activities are necessary after changing over the local currency.

Result
Once you have completed the cleanup process, you have finished the local currency changeover for the Treasury component.
Reconciling TR-TM-SE and FI Balances

Use

If you carry out the local currency changeover after the issue currency changeover, and securities which were formerly in foreign currency have already been converted to euros, there may be differences in the balances. The system carries out the required cleanup activities automatically using report program EWUTFV01.

If you carry out the local currency changeover before the issue currency changeover, no such cleanup activities are required in TR-TM-SE after the local currency changeover.

In this case, you make any adjustments as part of the issue currency changeover [Ext.] (Section 3: Reconciliation of documents/flows in the subledger).

If you reverse reconciliation flows at a later point in time, you must regenerate them again using report program RFVWEUR1.
Adjusting Selection Criteria (TR-LO)

Prerequisites
You have already assigned the relevant selection criteria to all files and methods in the Loans component.

Procedure
After you have changed over the local currency and the contract currency, you must check and, if necessary, change the selection criteria. Choose Portfolio → Roll over and/or Process management.

Selection criteria:
Exchange ratio: 1:2
Selection criterion before the changeover:
  Contract currency and local currency = DEM
  All loans where the remaining capital amount >50,000 are in file 1.
Selection criterion after the changeover:
  Contract currency and local currency = EUR
  Actual situation:
    All loans where the remaining capital amount >50,000 are in file 1.
  Desired situation:
    All loans where the remaining capital amount >25,000 are in file 1.
The selection criteria need to be changed.
Data Adjustment in Cash Management (TR-CM)

Use

Parts of Cash Management need to be regenerated after the local currency changeover. This only affects the bank accounts (G/L accounts not managed on an open item basis), since the bank accounts are updated in Cash Management in the currency of the G/L account, and this G/L account currency changes when you change over to the euro.

You do not need to regenerate the bank clearing accounts (G/L accounts managed on an open item basis) and the subledger accounts.

Procedure

To regenerate the bank accounts:

1. Call up transaction FDFD (Cash Management Implementation Tool).
2. In the Activate CM and forecast dialog box, enter the corresponding Company code.
3. In the next screen, choose Correct data.
4. In the next screen, set the All G/L accounts without open items indicator in the Limits on corrections section.
5. In the Job parameters section, choose Schedule correction to schedule the data correction job.
Cleanup in Cash Budget Management (TR-CB)

Use

The changeover process in Cash Budget Management converts both line items and totals records into euros. This may lead to rounding differences between the total of the line items and the value in the totals record. After the changeover, run reconciliation program RFFMS002.

Process

For information on the program, refer to the program documentation. Alternatively, go to the European Monetary Union - Euro IMG and choose Local Currency Changeover → Cleanup → Cleanup in Treasury.
Changeover in Consolidation

Purpose
This component changes over the data in Consolidation to the euro currency (euros).

Implementation Considerations
You need this component if you use the Consolidation component FI-LC or EC-CS in your R/3 System. The standard package in the central R/3 changeover component does not cover the Consolidation data. Instead, additional changeover packages are available for Consolidation.

The separate treatment of Consolidation is necessary because the changeover of Consolidation differs from that of the other R/3 components with respect to the following:

- Consolidation must be changed over after the year-end consolidated statements have been created.
- Consolidation can require a changeover of the data in stages in the sense that the local currencies of the companies and the ledger currencies might have to be changed over one step at a time.

Integration
Bear in mind the following when considering the timing of the Consolidation changeover with respect to the central changeover:

- The local currencies of the companies or consolidation units that are integrated with transaction-processing SAP applications must only be changed over in the Consolidation system after the central changeover.
- The local currencies of the companies or consolidation units that are not integrated can be changed over in the Consolidation system at any time.
- The reporting currencies of the Consolidation ledgers can be changed over as follows:
  - At any time before, after or at the same as the changeover of the local currencies of the companies or consolidation units
  - At any time before, after or at the same as the central changeover

In most cases, the Consolidation component is changed over at a date subsequent to the central changeover. This staggered approach has the following advantages and disadvantages when compared to the simultaneous approach:

Advantages of a Staggered Changeover

- The effort involved for the central changeover increases in proportion to the time elapsed since the end of the fiscal year of the company’s financial statement. This is due to the volume of documents posted in the original currency in the new (or current) year, which need to be converted.

Therefore, the central changeover should be started as soon as possible after the creation of the group’s annual consolidated statements, or it can even take place prior to the creation of the said statements, that is, before the Consolidation changeover.
A staggered Consolidation changeover has a shorter “down-time” as the central changeover of the rest of the R/3 System. However, this advantage is not very relevant because Consolidation has a relatively small volume of data.

**Disadvantages of a Staggered Changeover**

- A staggered changeover of Consolidation has the following disadvantage: If you use the *realtime update* transfer method, any G/L-related documents, which have been posted after the changeover-relevant carrying forward of balances in Consolidation, need to be re-posted during the postprocessing part of the Consolidation changeover is done. During such a subsequent posting to Consolidation, the postings in all other R/3 applications must be stopped.

- A staggered changeover of Consolidation also has the disadvantage that it spreads the unavoidable, minimal inaccuracies that are part of the euro changeover over additional time periods, or possibly even additional fiscal years. Then these inaccuracies become harder to distinguish from other errors.

**Features**

The system supports a changeover of consolidation data in multiple stages:

- **Changing over the reporting currency for consolidated financial statements**
  
  Some corporate groups may prefer to disclose their external consolidated statements in euros as soon as possible. To do this, you must change over the reporting currency prior to the changeover of the reported financial data of the group parent company and its subsidiaries.

  You change over the reporting currency by changing over the relevant ledgers to euros. This changeover only concerns the ledger currency.

- **Changing over the reporting currency of individual companies**
  
  This changeover focuses on the requirements and capability of individual companies to change over their accounting systems to the euro. Each company can be changed over individually. This changeover concerns the local currency of the companies.

  The timeframe for changing over all companies can exceed one year.

- **If the changeover of the reporting currency and the reported financial data does not need to be done in stages, you can also change over the entire data of Consolidation in a single step.**

  You control the changeover of the data by assigning the ledgers (for the ledger currency changeover) and the companies or consolidation units (for the local currency changeover) to the Consolidation changeover package.

  The changeover of consolidation data must occur after the closing of the fiscal year of the group. The balances are still carried forward in the previous currency. Then, the data is converted for all of the years. Finally, the carried-forward balances are reconciled within Consolidation as well as against other SAP components, with which Consolidation is integrated.

  Only in rare cases do the first (interim) consolidated statements of the new year need to be disclosed before the completion of the annual statements of the prior year. If this is indeed necessary, the statements will reflect a pure income statement consolidation because the balance sheet has not yet been carried forward. This is why the changeover does not take into consideration any data, which you still have reported in the previous currency for the new year, or
Changeover in Consolidation

which has even already been consolidated. Instead, the system deletes this data in the totals database and the journal entry database, and requires that you once again report (collect) the data, this time in euros, and consolidate the data. An exception are the journal entries of the prior year entries made by automatic reversals. Instead of being deleted, these entries are used to reconstruct the totals records after the changeover.

**Constraints**

See [Constraints for the Changeover][ConstraintPage] and [Cleanup in the Next Closing][CleanupPage].
Changeover Objects

Definition

The EC-CS component features the organizational units consolidation unit and consolidation group for portraying corporate structures. The FI-LC component uses the organizational units company and subgroup. Currencies are allocated to these organizational units, either directly or indirectly.

The following describes for the various components which organizational units and currencies are affected by the euro changeover in Consolidation.

The tables that are affected by the changeover are also listed.
European Monetary Union: Euro (CA-EUR)

Currencies and Organizational Units to be Changed Over

**Component Preparation for Consolidation**

The consolidation staging ledger is always changed over during the central changeover with the standard package.

**Component FI-LC Consolidation**

<table>
<thead>
<tr>
<th>Org unit</th>
<th>Currency</th>
<th>Changeover in Consolidation?</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>Local currency</td>
<td>Yes</td>
<td>see 1.</td>
</tr>
<tr>
<td>Ledger</td>
<td>Ledger currency</td>
<td>Yes</td>
<td>see 2.</td>
</tr>
<tr>
<td>Subgroup</td>
<td>Subgroup currency</td>
<td>No</td>
<td>see 3.</td>
</tr>
<tr>
<td>Client</td>
<td>Group currency</td>
<td>No</td>
<td>see 4.</td>
</tr>
<tr>
<td></td>
<td>Transaction currency</td>
<td>No</td>
<td>see 5.</td>
</tr>
</tbody>
</table>

**Explanations:**

1. The system changes the local currency of the companies selected for the changeover. It does this in all ledgers in which the companies concerned post data.

   When integrated companies have corresponding company codes in the same R/3 System, the company currency is usually identical to the company code currency. During the central changeover, the currency keys in the company master data are converted. To ensure uniformity, this is also done for companies that do not have a corresponding company code.

   The system internally retains the company’s original local currency until the company has been converted for consolidation.

2. The system changes the ledger currency of the ledgers selected for the changeover.

   After a ledger is changed over, all corporate groups assigned to the ledger that do not report in local currency automatically report data in the new currency.

3. A ledger is assigned to each subgroup for each version. The subgroup currency is the same as the ledger currency and, hence, is converted during the changeover of the ledger currency.

   For example, if two subgroups are managed in the same ledger with the ledger currency DEM, you cannot continue to manage one subgroup in DEM and start managing the other in euros.

4. The group (or client) currency is also used by other SAP components. This is why it is not converted during the Consolidation changeover.

5. The transaction currency is generally not changed over in the SAP System.

   Transaction currency values in Consolidation are changed over as follows:
Currencies and Organizational Units to be Changed Over

- Transaction currency values for financial data are converted if no breakdown by transaction currency is specified for an item in Customizing.
- Transaction currency values for standardizing or consolidation entries are converted if the document type used for the entry concerned does not support posting in transaction currency.

In both of the above cases, transaction currency values are only changed over in the balance carryforward for the changeover year.

This ensures that no values originating from previous local currency values are entered in the transaction currency field of current-year records.

Component EC-CS Consolidation

<table>
<thead>
<tr>
<th>Org unit</th>
<th>Currency</th>
<th>Changeover in Consolidation?</th>
<th>Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cons unit</td>
<td>Local currency</td>
<td>Yes</td>
<td>see 1.</td>
</tr>
<tr>
<td>Ledger</td>
<td>Ledger currency</td>
<td>Yes</td>
<td>see 2.</td>
</tr>
<tr>
<td>Cons group</td>
<td>Cons group currency</td>
<td>No</td>
<td>see 3.</td>
</tr>
<tr>
<td>Client</td>
<td>Group currency</td>
<td>No</td>
<td>see 4.</td>
</tr>
<tr>
<td></td>
<td>Transaction currency</td>
<td>No</td>
<td>see 5.</td>
</tr>
</tbody>
</table>

Explanations:

1. The system changes the local currency of the consolidation units selected for the changeover.
2. The system changes the ledger currency of the ledgers selected for the changeover.
   After a ledger is changed over, all consolidation groups assigned to the ledger that do not report in local currency automatically report data in the new currency.
3. A ledger is assigned to each consolidation group for each version. The consolidation group currency is the same as the ledger currency and, hence, is converted during the changeover of the ledger currency.
   For example, if two cons groups are managed in the same ledger with the ledger currency DEM, you cannot continue to manage one cons group in DEM and start managing the other in euros.
4. The group (or client) currency is also used by other SAP components. This is why it is not converted during the Consolidation changeover.
5. Transaction currency values in Consolidation are changed over as follows:
   - Transaction currency values for financial data are converted if no breakdown by transaction currency is specified for an item in Customizing.
   - Transaction currency values for standardizing or consolidation entries are converted if the document type used for the entry concerned does not support posting in transaction currency.
In both of the above cases, transaction currency values are only changed over in the balance carryforward for the changeover year.

This ensures that no values originating from previous local currency values are entered in the transaction currency field of current-year records.

If a consolidation processing ledger is set to currency type 30 (group currency), its currency type must be changed to 80 (ledger currency) before the first euro changeover takes place. Otherwise, the Consolidation changeover cannot correctly process the ledger if the reporting currency (used by the Consolidation system) is based on the client (group) currency. The client currency is already converted by the standard package during the central changeover.

The system automatically changes currency type 30 to currency type 80. When the first euro changeover package is started – regardless of which package, the program RGCEUR40 is executed during the FILL phase. This program changes any consolidation processing ledgers with currency type 30 to currency type 80, and sets the ledger currency to the client currency.
Tables Affected by the Changeover

In general, the changeover only involves data that belongs to the R/3 System. These tables and their affected fields are listed below.

### Component FI-LC

#### Local currency of a company

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local cur. in company master records</td>
<td>T880</td>
</tr>
<tr>
<td>Local cur. in totals records</td>
<td>FILCT</td>
</tr>
<tr>
<td>Local cur. in journal entry records</td>
<td>FILCA</td>
</tr>
<tr>
<td>Local cur. of inventory managing company</td>
<td>T868B</td>
</tr>
<tr>
<td>Local cur. of supplying company</td>
<td>T868L</td>
</tr>
<tr>
<td>Local cur. in changes in investments</td>
<td>T851</td>
</tr>
<tr>
<td>Local cur. in changes in investee equity</td>
<td>T871</td>
</tr>
<tr>
<td>Local cur. in equity holdings adjustments</td>
<td>T872</td>
</tr>
<tr>
<td>Local cur. in hidden reserves (fair value adjustments)</td>
<td>T873</td>
</tr>
<tr>
<td>Nominal value of investment in parent company</td>
<td>T851</td>
</tr>
<tr>
<td>Currency of local currency groups</td>
<td>T852</td>
</tr>
<tr>
<td>Currency of local currency groups, version-based</td>
<td>T852V</td>
</tr>
</tbody>
</table>

#### Ledger currency

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ledger cur. in ledgers</td>
<td>T881</td>
</tr>
<tr>
<td>Ledger cur. in totals records</td>
<td>FILCT</td>
</tr>
<tr>
<td>Ledger cur. in journal entry records</td>
<td>FILCA</td>
</tr>
<tr>
<td>Ledger cur. in changes in investments</td>
<td>T851</td>
</tr>
<tr>
<td>Ledger cur. in changes in investee equity</td>
<td>T871</td>
</tr>
<tr>
<td>Ledger cur. in equity holdings adjustments</td>
<td>T872</td>
</tr>
<tr>
<td>Ledger cur. in hidden reserves (fair value adjustments)</td>
<td>T873</td>
</tr>
<tr>
<td>Ledger cur. in eliminated hidden reserves</td>
<td>T874</td>
</tr>
<tr>
<td>Ledger cur. in transferred assets</td>
<td>T875D</td>
</tr>
</tbody>
</table>
Tables Affected by the Changeover

<table>
<thead>
<tr>
<th>Local cur. in depreciation of transferred assets</th>
<th>T875E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency of groups</td>
<td>T852</td>
</tr>
<tr>
<td>Currency of groups, version-based</td>
<td>T852V</td>
</tr>
</tbody>
</table>

Exchange rates

Exchange rate data in additional financial data tables is automatically recalculated after changeover and reconciliation (tables T851, T871, T872, T873).

Component EC-CS

Local currency of a consolidation unit

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local cur. of consolidation units</td>
<td>TF164</td>
</tr>
<tr>
<td>Local cur. in totals records</td>
<td>ECMCT</td>
</tr>
<tr>
<td>Local cur. in journal entry records</td>
<td>ECMCA</td>
</tr>
<tr>
<td>Local cur. in changes in investments</td>
<td>TF620</td>
</tr>
<tr>
<td>Local cur. in changes in investee equity</td>
<td>TF630</td>
</tr>
<tr>
<td>Local cur. in equity holdings adjustments</td>
<td>TF660</td>
</tr>
</tbody>
</table>

Ledger currency

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ledger cur. in totals records</td>
<td>ECMCT</td>
</tr>
<tr>
<td>Ledger cur. in journal entry records</td>
<td>ECMCA</td>
</tr>
<tr>
<td>Ledger cur. in changes in investments</td>
<td>TF620</td>
</tr>
<tr>
<td>Ledger cur. in changes in investee equity</td>
<td>TF630</td>
</tr>
<tr>
<td>Ledger cur. in equity holdings adjustments</td>
<td>TF660</td>
</tr>
<tr>
<td>Ledger cur. in changes in goodwill</td>
<td>TF635</td>
</tr>
</tbody>
</table>

Exchange rates

Exchange rate data in additional financial data tables is automatically recalculated after changeover and reconciliation (tables TF620, TF630, TF660).
**Changeover Packages**

**Definition**
For each of the components Consolidation (FI-LC) and Consolidation (EC-CS), the standard SAP R/3 System contains a package which consists of the programs for converting the data of the respective Consolidation system.

Thus, the standard package contained in the standard system does not cover the Consolidation components.

**Structure**
As in the standard package, you must copy the relevant package for Consolidation from client 0 to either the test client or the production client. During preparations for the changeover to euros, you determine which ledgers and companies/consolidation units the package is to convert. See the Implementation Guide (IMG).

By explicitly including the ledger(s) in the changeover, you can exclude entire individual ledgers from the changeover of the ledger currency. For instance, this allows you to retain an additional copy of a ledger in DEM, which you created prior to the euro changeover, to keep historical data for purposes of DEM comparisons.

As a rule, you assign to only one package all ledgers that – because of their currency – qualify for the changeover and need to be changed over.

**The FI-LC package**
- The Complete and FI-LC changeover packages slightly overlap each other. This is because user-defined ledgers in the FILCT totals database can be used in the component FI-LC as well as the Special Purpose Ledger (FI-SL) component. SAP cannot automatically determine which component uses which user-defined ledger. Only the standard ledgers in the FILCT totals database can be deemed to belong to Consolidation.

For this reason, if you use FI-LC you must specify all FI-LC ledgers (once only), standard and user-defined, prior to any changeover activities. Those ledgers in the FILCT database not specified are converted as part of the complete package.

- For each FI-LC changeover package you define:
  - The ledgers to be changed over
  - The companies to be changed over

**The EC-CS package**
- For each EC-CS changeover package you define:
  - The ledgers to be changed over
  - The consolidation units to be changed over
Changeover Packages

Integration

- An integrated company or consolidation unit can never be changed over in an FI-LC or EC-CS package before the central changeover has taken place, that is, before the company code is changed over.

  The order pertains to both the actual date of the changeover as well as the ends of the fiscal years.

  On the other hand, the changeover of an integrated company or consolidation unit must always take place before the individual statement data enters a new fiscal year.

  Say, a company code and its corresponding company have different fiscal year variants:

  - Company code end of fiscal year: 31 Dec 1999
    Company code changeover: 15 Feb 2000
  - Company end of fiscal year: 30 Sep 1999

  In this case, the company must be changed over in the consolidation system as of 30 Sep 2000. The company cannot be changed over at 30 Sep 1999 because this date is prior to the changeover of the company code (31 Dec 1999). A changeover at 30 Sep 2001 is too late because then the individual statement data in euros would already be within a ‘euro fiscal year’.

- In FI-LC (only), a company can only be converted from a local currency group if all of the other companies that belong to the local currency group are converted at the same time. In other words, all of these companies must be included in the package.

- In FI-LC, you can assign a rollup company to a subgroup on a version basis. If this is done, subgroup currency (which is found in a version of the ledger) should be the same as the currency of the rollup company.

  To prevent the euro changeover from disrupting this status, you need to ensure that the ledger and the rollup company are included in the same package.

- In EC-CS, a rollup consolidation unit is automatically assigned to each consolidation group. While the consolidation group can have multiple currencies (via the version-based ledger assignment), the rollup unit has only one fixed currency.

  To ensure that the rollup is feasible, the consolidation group must use the same currency as the rollup unit in at least one version. The package must be created in a way in which this condition is met.

- All consolidation units (EC-CS only) that were established from one and the same company – for example, when combining the company with a business area or profit center – must run their local currency changeover in the same package.
Changeover Scenarios

Various scenarios are conceivable for the euro changeover, depending on the method used to transfer company or consolidation unit data into the Consolidation application.

This section describes the different scenarios and explains the processing required before and after a changeover in Consolidation.

For information on changeover activities for the Consolidation application, see the documentation Changeover Process in Consolidation [Page 241].
Scenario when Using Periodic Extracts

Purpose

This scenario applies if at least one company or consolidation unit transfers its data to the Consolidation application in the form of a periodic extract.

It requires activities both during the central changeover and the changeover of the Consolidation application.

The consolidation staging ledger used for a periodic extract (ledger 09 with totals table GLT3) is converted during the central changeover using the standard package. During postprocessing for the central changeover, the staging ledger is reconciled with the general ledger and, if specified in Customizing, with the subsidiary ledgers in order to reconcile account assignments.

Reconciliation takes place in local currency, and not in ledger currency. For more information, see the documentation Reconciliation with Applications Supplying Data [Page 253].

Preconditions

- Individual accounts are closed for the prior fiscal year in General Ledger Accounting.
- Balances have been carried forward in General Ledger Accounting and in the consolidation staging ledger.
- In the current fiscal year, entries are made to the general ledger and consolidation staging ledger.
- The General Ledger Accounting department wants to changeover to euros.

Process Flow

You perform all changeover activities using the Implementation Guide (IMG). The programs that you need to run before and after the changeover are also listed below.

1. For the prior fiscal year, you generate a periodic extract in the consolidation staging ledger and post this to the consolidation processing ledger.
   Program: RFBILA00 (General Ledger Accounting application menu)

2. During preparations for the central changeover, you specify how the consolidation staging ledger is to be reconciled with the general ledger and, if required, with the subsidiary ledgers after the changeover. You specify the following:
   - Whether additional account assignments should be reconciled using the subsidiary ledgers
   - The transaction type to be assigned in adjustment records
   IMG activity: Local Currency Changeover → Preparation → Preparation in Financial Accounting → Prepare reconciliation of the consolidation staging ledger

3. You perform a central changeover using the standard package. The following are changed over:
   - Company code currency
   - Company currency
Scenario when Using Periodic Extracts

- General ledger data (FI-GL, FI-AR, FI-AP, FI-AA)
- Consolidation staging ledger data

4. During postprocessing for the central changeover, consolidation staging ledger data is reconciled with general ledger and, if specified, subsidiary ledger data. Reconciliation takes place in the balance carryforward period.
   Program: RGCEUR50

5. During the cleanup after the central changeover, you ensure that data in the consolidation staging ledger for the current period of the fiscal year are also consistent with the general ledger. To do this, you proceed as follows:
   - You delete data in the consolidation staging ledger that exists for periods after the balance carryforward period.
     IMG activity: Financial Accounting → Preparation for Consolidation → Tools for Creating Beginning Balances → Delete Transaction Data from Periodic Extract
   - You repost the balance of all documents to the consolidation staging ledger in the current fiscal year.
     Program: RGUREC10 (IMG for euro changeover)

6. You create consolidated financial statements for the prior fiscal year in the original currency.

7. You run a balance carryforward in Consolidation.
   Program: RGCVTR00 (FI-LC application menu) or Program: FICBCF00 (EC-CS application menu)

8. You change over integrated companies in Consolidation.

9. During postprocessing for the changeover of Consolidation, you generate a periodic extract in the consolidation staging ledger in the balance carryforward period (program: RFBILA00) and post this to the consolidation processing ledger in the balance carryforward period.
   Program for posting to FI-LC: RGCMBUEU
   Program for posting to EC-CS: FICMBU00

Result

In Consolidation, you can create consolidated financial statements for the current fiscal year in euros. The periodic extract provides values in euros for integrated companies.
Scenario when Using Realtime Update

Purpose

This scenario applies if at least one company or consolidation unit transfers its data by means of realtime updating.

It requires activities to be performed both during the central changeover and during the changeover of the Consolidation application.

During preparations for the central changeover, you specify the level of detail at which integrated data is to be reconciled after the changeover of the Consolidation application. You can specify the following:

- Reconciliation of consolidation data with the general ledger at the level of items
- Additional reconciliation with subsidiary ledgers at the level of transaction type and partner

If you specify reconciliation at the level of transaction type and partner, the system generates a carryforward balance in the consolidation staging ledger (ledger 09 with totals table GLT3) from the general and subsidiary ledgers. It does this during postprocessing for the central changeover. Carryforward balances are generated in local currency for each company code to which a company is assigned and which has been converted to euros. No ledger currency amounts are included.

Integrated data is reconciled with the general ledger and, if appropriate, with the subsidiary ledgers during postprocessing for the changeover of the Consolidation application. For further information, see the documentation Reconciliation with Applications Supplying Data [Page 253].

The consolidation staging ledger is not normally used for realtime updating. During the euro changeover, it is used only to reconcile integrated data, if you specify reconciliation at the level of transaction type or partner.

Preconditions

- Individual accounts are closed for the prior fiscal year in General Ledger Accounting.
- Balances have been carried forward in General Ledger Accounting.
- In the current fiscal year, entries are made to the general ledger and to the Consolidation application.
- The General Ledger Accounting department wants to run a conversion.

Process Flow

You perform all changeover activities using the Implementation Guide (IMG). The programs that you need to run before and after the changeover are also listed below.

1. During preparations for the central changeover, you specify the level of detail at which you want to reconcile integrated data.

   IMG activity: Local Currency Changeover \(\rightarrow\) Preparation \(\rightarrow\) Preparation in Financial Accounting \(\rightarrow\) Prepare reconciliation of the consolidation staging ledger
Scenario when Using Realtime Update

2. You perform a central changeover using the standard package. The following are changed over:
   - Company code currency
   - Company currency
   - General ledger data (FI-GL, FI-AR, FI-AP, FI-AA)

3. If you specified a reconciliation of integrated data at the level of transaction type or partner in step 1, the system generates a carryforward balance from FI data in the consolidation staging ledger during postprocessing for the central changeover.
   
   Program: RGCEUR50

4. You create consolidated financial statements for the prior fiscal year in the original currency.

5. You carry forward balances in Consolidation.
   
   Program: RGCVTR00 (FI-LC application menu) or
   Program: FICBCF00 (EC-CS application menu)

6. You run the changeover in Consolidation.

7. During postprocessing for the changeover, you reconcile integrated consolidation data with data supplied by other applications.
   
   Program (FI-LC): RGCEUR30
   Program (EC-CS): FICEUR20

8. During postprocessing for the changeover, you run a check on contra items and recalculate retained earnings.
   
   Program (FI-LC): RGCHPEU
   Program (EC-CS): FICCHI00

9. You call a posting stoppage for transaction systems.

10. You repost all FI documents for the current fiscal year in Consolidation.
    
    Program RGUREC10 (IMG for euro changeover)

Result

In Consolidation, you can create consolidated financial statements for the current fiscal year in euros.
Scenario when Using a Rollup

Purpose
This scenario applies if at least one company or consolidation unit transfers its data by means of a rollup.

Preconditions
- The balance carryforward is already reconciled in the rollup source ledger.
- You have ensured that all significant account assignments in Consolidation are correct. For example, if the source ledger contains transaction types, these must have been carried forward in accordance with settings in Consolidation Customizing.

Process Flow
You perform a reconciliation with the Consolidation application by restarting the rollup in period 0 (zero).

Result
The values calculated in Consolidation during the changeover are no longer relevant. Final values (and their additional account assignments) are provided by the rollup.
Scenario when Using Offline Data Entry

Purpose
This scenario applies if at least one company or consolidation unit transfers its data by means of the offline PC data entry program on the basis of Dbase (FI-LC) or Microsoft Access (FI-LC and EC-CS).

Process Flow
Data entered in the offline PC data entry program using Dbase and Access are not converted during the changeover of the Consolidation application, although you can convert them indirectly to some extent.

Dbase

Case 1: Decentralized data entry in euros after changeover of R/3 Consolidation
In order to enter new financial data, you need to assign the new local currency key ‘euro’ for a company in the data entry program.

To do this, you download master data from the R/3 System and import it into the data entry program.

Case 2: Decentralized data entry in euros before changeover of R/3 Consolidation
It no be possible to wait until R/3 Consolidation is changed over before entering data. In order to enter data offline in euros before the R/3 System is changed over, you can temporarily set the local currency key of a company to ‘euro’ for the download.

Note that in this case you cannot use comparison values or carryforward values from the prior year.

Microsoft Access

Changeover of local currency key

- Case 1: Decentralized data entry in euros after changeover of R/3 Consolidation
  In order to enter new financial data, you need to assign the new local currency key ‘euro’ for a company in the data entry program.

  To do this, you download master data from the R/3 System and import it into the data entry program.

- Case 2: Decentralized data entry in euros before changeover of R/3 Consolidation
  It no be possible to wait until R/3 Consolidation is changed over before entering data. In order to enter data offline in euros before the R/3 System is changed over, you can temporarily set the local currency key of a company to ‘euro’ for the download.

  Note that in this case you cannot use comparison values or carryforward values from the prior year.

Download and import of converted financial data in R/3
You can download financial data transferred to R/3 from decentralized data entry, and import it back into the offline program.
Scenario when Using Offline Data Entry

This function enables you to transfer euro values into the offline program after changing over local currency in R/3 Consolidation. You can thereby analyze past values and use comparison and carryforward values as a reference when entering data for the current fiscal year.

You download and import data for a particular year and consolidation unit (company in FI-LC, group of consolidation units in EC-CS). Local valuation data and standardizing entries in local currency are downloaded.

**Entry of additional financial data (FI-LC)**

As of Release 4.0B, you can also enter additional financial data required for the elimination of intercompany profit/loss and for the consolidation of investments.

Additional financial data for the elimination of intercompany profit/loss can be transferred in the same way as other financial data, by downloading it from the R/3 System and importing it into Access. This function is not available for additional data relevant to consolidation of investments, however.

**Entry in group currency (EC-CS)**

In order to enter data in group currency, you need to transfer the ledger currency (which may have been changed over) and the exchange rates by downloading master data from the R/3 System and importing it into Access.

**Reporting**

- In order to use group currency in Access reporting, you need to transfer the ledger currency (which may have been changed over) and the exchange rates by downloading data from the R/3 System and importing it into Access.

- If you summarize data by means of a rollup in order to increase reporting efficiency, you need to identify the relevant rollups and repeat them in order to receive summarized data in euros.

**Use of Microsoft Excel (FI-LC)**

If you use Excel in addition to Access for entering data and creating reports, you can transfer values in euros from Access to Excel.
Scenario when Using Step Consolidation

Implementation Considerations
This scenario applies if you use step consolidation with rollup companies.

Process Flow
The subgroup currency and local currency of rollup companies used in step consolidation should be identical. To ensure that these currencies are identical after the changeover to the euro, you need to assign the ledger and rollup company to the same package.

Reconciliation for step consolidation in a single R/3 System
The following values are reconciled in the balance carryforward:

- Ledger currency amounts
- Local currency amounts for the rollup companies

Reconciliation does not ensure that ledger currency values and local currency values are consistent, because the values have different levels of detail:

- Values for the rollup company are summarized subgroup values. Detailed values for companies and posting levels are lost.
- Values in ledger currency are detailed.

After the changeover to the euro, you can check for any differences between ledger currency values and local currency values for the rollup company. You do this by generating a report to compare subgroup values and rollup company values.

You correct any differences by generating a new extract from step consolidation for the next closing.

Reconciliation for step consolidation between two different R/3 Systems
As with step consolidation in a single system, ledger currency amounts in the system supplying data to Consolidation only match local currency amounts of the rollup company in the system receiving data from Consolidation, when a new extract is generated in step consolidation and imported into the receiving system. This happens during the next closing.
Changeover Process in Consolidation

In this section, the changeover processes for the components FI-LC and EC-CS are discussed separately.

For more information about reconciliation during the changeover process, see Reconciliation [Page 252].
Changeover Process for FI-LC

Purpose
You want to change over all or a portion of the data of the Consolidation system to the euro currency.

Prerequisites

Prerequisites in the applications that supply the data
If a company code transfers data to the Consolidation system using the data transfer methods periodic extract or rollup, you must ensure that no errors occurred in the closed fiscal year prior to the central changeover.

You therefore need to generate all of the extracts and rollups that you require for creating consolidated financial statements in the previous currency, before the central changeover takes place. After the central changeover, no extracts or rollups can be generated in the previous currency.

This same requirement also applies to data transfers to non-SAP consolidation systems.

Prerequisites in the Consolidation application

- The generation of the consolidated annual financial statements for the prior fiscal year must be completed.

- You need to document the consolidated financial statements for auditing purposes. You have the following options:
  - You need to print and save the audit trails for the time period required by accounting regulations.
  - You can copy the required data to a new ledger (using the same ledger currency) that you exclude from the changeover.
  - Totals record reports
    You select the relevant reports, and store them on the database MCDX. This database is only used by the Consolidation application, and so your consolidation data is saved securely.
  - Report Writer reports
    You select the relevant reports and generate extracts from the. These extracts are stored on the database INDX (database GREP, as of Release 4.0). Note that this database is used by multiple applications.

Also bear in mind that the local currencies in this ledger are changed over, although the ledger itself is excluded from the changeover.

The new local currency key (euro) may, in some cases, be dynamically displayed in the report columns. Note that the decimal places for the amounts are determined by the currency key. For example, 1000 Italian lire are displayed as 10 euros.

You cannot use this procedure to save all reports. For example, you cannot save changes in investment or investee equity reports. Report data should not only be
saved in electronic form, you should also print out and archive all reports before the changeover.

- You copy the client to create a backup in which you save all of the data.

- The balances must be carried forward from the prior fiscal to the current fiscal year. The system checks this during preprocessing for the changeover.

**Process Flow**

As in the central changeover, the entire process of the Consolidation changeover is divided into three fundamental phases:

- In the *Preparation* phase, you make certain settings for the changeover.
- In the actual *Changeover* phase you change over currencies to euros in the steps *Preprocessing*, *Conversion* and *Postprocessing*.
- In the *Cleanup* phase, you do manual reconciliation and adjustments, which cannot be automatically performed by the system.

You make all of the settings and run all of the programs for the changeover within the Implementation Guide (IMG).

**Preparation**

You must make the following preparations prior to the changeover in the IMG:

1. The user-defined ledgers in the totals database *FILCT* can be used by the FI-LC component as well as the *Special Purpose Ledger* (FI-SL) component.

   For this reason, you must specify all standard and user-defined ledgers that are used by FI-LC (once only) prior to any changeover activities.

   All other user-defined ledgers in the *FILCT* totals database are converted as part of the standard package during the central changeover.

2. You prepare the changeover package as follows:

   - You copy package 002 from client 0 to the client in which the changeover is being made.

     Note that the package must be copied from client 0 every time a changeover is to be performed.

   - You specify which currencies the package is to change over.

   - You specify which ledgers and companies the package is to change over.

3. You define which financial statement items are to be posted with any differences that arise during reconciliation runs.

   You specify an item for balance sheet differences and an items for income statement differences. Whether or not the corresponding adjustment entries have an affect on net income depends on whether you have selected adjustment items in the balance sheet or income statement.
Changeover Process for FI-LC

Changeover

Preprocessing

You can perform the following checks in the IMG before converting the tables:

- You check that the balances are carried forward to the current fiscal year.

  When changing over companies, the program checks status management to make sure that activities for all subgroups containing companies that are being changed over are closed in the prior year.

  When changing over ledgers, the program also checks to make sure that all subgroups using the ledger are closed.

  Program: RGCEUR02

- You check whether the totals records that were carried forward are consistent in the currencies to be changed over.

  Program: RGCEUR00

- You check whether any archiving objects that could cause problems for the conversion exist in the system. You cannot start the conversion if these objects exist.

  Program: EWUARCHI and EWUARCH2

Conversion

In the IMG, you lock the system and start the conversion, which automatically runs all of the necessary programs. The following list shows the phases and the most important programs executed in each of the phases:

1. FILL

<table>
<thead>
<tr>
<th>Program</th>
<th>Activities of the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>EWUFISLO and EWUFISLS and EWUFISLT</td>
<td>Loads the organizational units for the conversion.</td>
</tr>
<tr>
<td>RGCEUR40</td>
<td>Checks which consolidation processing ledgers have currency type 30 (group currency), and changes the currency type to 80 (ledger currency).</td>
</tr>
<tr>
<td>RGCEUR02</td>
<td>Checks whether the balances are carried forward. It also checks status management (see the information for preprocessing.</td>
</tr>
<tr>
<td>RGCEUR60</td>
<td>Deletes the financial data and journal entries that have already been entered/posted in the current year, along with the corresponding totals records.</td>
</tr>
<tr>
<td>EWUORGLO</td>
<td>Loads the tables for controlling the conversion.</td>
</tr>
</tbody>
</table>
2. GENERATION

<table>
<thead>
<tr>
<th>Program</th>
<th>Activities of the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>EWUGENEW</td>
<td>Generates the conversion programs for the following tables: FILCT FILCA T851 T871 T872 T868B T868L T873 T874 T875D T875E</td>
</tr>
</tbody>
</table>

3. CONVERSION

The tables listed under step 2 are converted by the generated programs.

4. RECONCILIATION

<table>
<thead>
<tr>
<th>Program</th>
<th>Activities of the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGCEUR00</td>
<td>Reconciles the euro values in the totals records affected by the carrying forward of balances.</td>
</tr>
<tr>
<td>RGCEUR60</td>
<td>Reconstructs the totals records of period 1 from the journal entries resulting from automatic reversals.</td>
</tr>
<tr>
<td>RGCEUR61</td>
<td>Executes the program RGCEUR00 for period 1 of the current year. This reconciles the totals records reconstructed by RGCEUR60.</td>
</tr>
</tbody>
</table>

Postprocessing

In the IMG, you start the postprocessing programs. Some of the programs are only required if you use the integration feature in conjunction with the data transfer methods periodic extract and realtime update.

1. If you use realtime update, you reconcile integrated consolidation data with the data supplied by other applications, and you run a program to process contra items and retained earnings.
   
   Programs: RGCEUR30, RGCEUR00, and RGCHPEU

2. If you use periodic extract, you create an extract from the consolidation staging ledger for the carryforward period, and update the consolidation processing ledger in the carryforward period.
   
   Programs: RFBILA00 and RGCMBUEU

   
   Program: RGCEUR00

4. You reconcile the additional financial data with the totals database of Consolidation.
   
   Program: RGCEUR10

5. If you use realtime update, you re-post the FI document entries of the current year.
European Monetary Union: Euro (CA-EUR)

Changeover Process for FI-LC

Program: RGUREC10

6. You confirm that you have run the postprocessing programs. The system then switches to the Ready phase.

Program RGCEUR90

Cleanup

A successful changeover and reconciliation in the Consolidation system does not yet guarantee a correct “Euro Opening Balances”. In general, you still need to do a Cleanup in the Next Closing [Page 269].

Result

After the changeover, all of the data changed over by the package exists in euros. Note the following points:

- Old annual closings

If you rerun the consolidation functions in test mode for the fiscal years preceding the changeover, most likely you will encounter warning messages or even error messages with program terminations. Even if the programs do not generate any errors, bear in mind that the data for the years preceding the changeover is not reconciled and contains rounding differences.

Rounding a figure in currency translation produces the error Difference in local currency.

- New annual closings after the changeover

  - Postings

    You can no longer reverse the documents that were posted in years prior to the changeover. The reversal programs checks whether the entry contains a company or a ledger that was changed over in a year after the document year.

    Instead, you can post a document using a reference to the document being reversed and then manually reverse the debit/credit sign in the document.

  - Currencies shown in EC-EIS

    In general, the Executive Information System (EC-EIS) component does not convert any data to euros, but instead collects the data again. The currency key, which optionally can be shown in the EIS reports, comes from the master data of the respective application that supplies the data. Because of this, the EIS reports may show an erroneous currency.

The complete package is changed over, thereby changing over the company currency to euros. However, the EIS data still stores the currency DEM.
Changeover Process for EC-CS

Purpose
You want to change over all or a portion of the data of the Consolidation system to the euro currency.

Prerequisites

Prerequisites in the applications that supply the data
If a company code transfers data to the Consolidation system using the data transfer methods *Periodic Extract* or *Rollup*, you must ensure that no errors occurred in the closed fiscal year prior to the central changeover of the company code.

You therefore need to generate all of the extracts and rollups that you require for creating consolidated financial statements in the previous currency, before the central changeover takes place. After the central changeover, no extracts or rollups can be generated in the previous currency.

This same requirement also applies to data transfers to non-SAP consolidation systems.

Prerequisites in the Consolidation application

- The generation of the consolidated annual financial statements for the prior fiscal year must be completed.

- You need to document the consolidated financial statements for auditing purposes. You have the following options:
  - You need to print and save the audit trails for the time period required by accounting regulations.
  - You can copy the required data to a new ledger (using the same ledger currency) that you exclude from the changeover.
  - Report Writer reports
    You generate extracts from the relevant reports, and store them on the database INDX (database GREP, as of Release 4.0). Note that this database is used by multiple applications.
  - Drilldown reports
    You save the relevant reports. These snapshots are not converted during the changeover.

Also bear in mind that the local currencies in this ledger are changed over, although the ledger itself is excluded from the changeover.

The new local currency key (euro) may, in some cases, be dynamically displayed in the report columns. Note that the decimal places for the amounts are determined by the currency key. For example, 1000 Italian lire are displayed as 10 euros.

You cannot use this procedure to save all reports. For example, you cannot save changes in investment or investee equity reports. Report data should not only be
Changeover Process for EC-CS

- saved in electronic form, you should also print out and archive all reports before the changeover.
  - By creating a client copy, you keep a backup client in which you save all of the data.
- The balances must be carried forward from the prior fiscal year to the current fiscal year. The system checks this during preprocessing for the changeover.

Process Flow

As in the central changeover, the entire process of the Consolidation changeover is divided into three fundamental phases:

- In the **Preparation** phase, you make certain settings for the changeover.
- In the actual **Changeover** phase, you change over currencies to euros in the steps **Preprocessing, Conversion and Postprocessing.**
- In the **Cleanup** phase, you do manual reconciliation and adjustments, which cannot be automatically performed by the system.

You make all of the settings and run all of the programs for the changeover within the Implementation Guide (IMG).

Preparation

You must make the following preparations prior to the changeover in the IMG:

1. You prepare the changeover package as follows:
   - You copy package 003 from client 0 to the client in which the changeover is being made.
     - Note that the package must be copied from client 0 every time a changeover is to be performed.
   - You specify which currencies the package is to change over.
   - You specify which ledgers and consolidation units the package is to change over.

2. You define which financial statement items are to be posted with any differences that arise during reconciliation runs.

Changeover

Preprocessing

You can perform the following checks in IMG before converting the tables:

- You check that the prior fiscal year is blocked against postings, that the balances are carried forward, and that the carryforward task is closed.
  - Program: FICEUR51
- You check whether the totals records that were carried forward are consistent in the currencies to be changed over.
  - Program: FICEUR00.
Conversion
In the IMG, you lock the system and start the conversion, which automatically runs all of the necessary programs. The following list shows the phases and the programs executed in each of the phases:

1. **FILL**

<table>
<thead>
<tr>
<th>Program</th>
<th>Activities of the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGCEUR40</td>
<td>Checks which consolidation processing ledgers have currency type 30 (group currency), and changes the currency type to 80 (ledger currency).</td>
</tr>
<tr>
<td>FICEUR51</td>
<td>Checks that the prior fiscal year is blocked against postings, that the balances are carried forward in the current year, and that the carryforward task is closed.</td>
</tr>
</tbody>
</table>
| FICEUR30         | Deletes the financial data and journal entries that have already been entered/posted in the current year, along with the corresponding totals records.  
Exception: The program does not delete prior-year journal entries that have been posted by the automatic reversal function in subsequent periods to the current fiscal year. |
| EWUORG3LO_40     | Loads the tables for controlling the conversion.                                           |
| EWUORGLO         |                                                                                          |

2. **GENERATION**

<table>
<thead>
<tr>
<th>Program</th>
<th>Activities of the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>EWUGENEW</td>
<td>Generates the conversion programs for the following tables:</td>
</tr>
<tr>
<td></td>
<td>ECMCA  ECMCT  T881  TF164  TF620  TF630  TF635  TF660  TF661</td>
</tr>
</tbody>
</table>

3. **CONVERSION**
The tables listed under step 2 are converted by the generated programs.

4. **RECONCILIATION**

<table>
<thead>
<tr>
<th>Program</th>
<th>Activities of the program</th>
</tr>
</thead>
<tbody>
<tr>
<td>FICEUR00</td>
<td>Reconciles the euro values in the totals records affected by the carrying forward of balances.</td>
</tr>
<tr>
<td>FICEUR30</td>
<td>Reconstructs the totals records of period 1 from the journal entries resulting from automatic reversals.</td>
</tr>
</tbody>
</table>
Changeover Process for EC-CS

| FICEUR01 | Executes the program FICEUR00 for period 1 of the current year. This reconciles the totals records reconstructed by FICEUR30. |

**Postprocessing**

In the IMG, you start the postprocessing programs. Some of the programs are only required if you use the integration feature in conjunction with the data transfer methods *periodic extract* and *realtime update*.

1. If you use *realtime update*, you reconcile integrated consolidation data with the data supplied by other applications, and you run a program to process contra items and retained earnings.
   Programs: FICEUR20, FICEUR00, and FICCHI00

2. If you use *periodic extract*, you create an extract from the consolidation staging ledger for the carryforward period, and update the consolidation processing ledger.
   Programs: RFBILA00 and FICMBU00

3. If you state the appropriation of retained earnings in the income statement, you reconcile *Retained Earnings on the Balance Sheet* with *Retained Earnings on the Income Statement*.
   Program: FICEUR00

4. You reconcile the additional financial data with the totals database of Consolidation.
   Program: FICEUR10

5. If you use realtime *update*, you re-post the FI document entries of the current year.
   Program: RGUREC10

6. You confirm that you have run the postprocessing programs. The system then switches to the *Ready* phase.
   Program: RGCEUR90

**Cleanup**

A successful changeover and reconciliation in the Consolidation system does not yet guarantee a correct opening balance in euros. In general, you still need to do a Cleanup in the Next Closing [Page 269].

**Result**

After the changeover, all of the data changed over by the package exists in euros. Note the following points:

- **Old annual closings**
  
  If you rerun the consolidation functions in test mode for the fiscal years preceding the changeover, most likely you will encounter warning messages or even error messages with program terminations. Even if the programs do not generate any errors, bear in mind that the data for the years preceding the changeover is not reconciled and contains rounding differences.

  Example: Rounding a figure in currency translation produces the error *Difference in local currency*.
New annual closings after the changeover

- Postings
  You can no longer reverse the documents that were posted in years prior to the changeover. The reversal programs checks whether the entry contains a company or a ledger that was changed over in a year after the document year.

  Instead, you can post a document using a reference to the document being reversed and then manually reverse the debit/credit sign in the document.

- Currencies shown in EC-EIS

  In general, the Executive Information System (EC-EIS) component does not change over any data to euros, but instead collects the data again. The currency key, which optionally can be shown in the EIS reports, comes from the master data of the respective application that supplies the data. Because of this, the EIS reports may show an erroneous currency.

  Example: The complete changeover package has been processed, upon which the company currency has been changed to euros. However, the EIS data still stores the currency DEM.
Reconciliation

Use
Rounding differences can occur as a result of the changeover of data to euros. These differences make data inconsistent and must be corrected by means of reconciliation and adjustment entries.

Features
The euro changeover involves a linear conversion of currency amounts, and resulting rounding differences can be the only cause of inconsistencies in the database. The reconciliation procedure enables you to identify these differences and remove most of them automatically.

Reconciliation does not necessarily produce a balance carryforward in euros that meets all the requirements that a carryforward in the previous currency would meet, and so a completely accurate opening euro balance cannot be guaranteed. Some of the effects of the euro changeover can only be reversed in the next closing. However, after the next closing at the latest, all data will be correct. For more information, refer to the documentation Cleanup in the Next Closing [Page 269].

The effects of the changeover will be minimal in the Consolidation application, however, because in reconciliation always takes place on the level of account balances.

Reconciliation activities take place in the following sequence:

1. Between the Consolidation application and the applications or systems that supply it with data
2. Within the Consolidation application
3. Between the Consolidation application and applications or systems to which it forwards data (only during the next closing)

Activities
The changeover procedure is dependent on the fiscal year and period of the data requiring conversion:

- Data for the year prior to the euro changeover is not reconciled.
- Data for the year of the euro changeover is reconciled using the balance carryforward. Therefore, you should not carry forward balances again after a successful changeover and reconciliation.
- Data for subsequent periods of the changeover year is reposted (if affected by the changeover). No additional processing is required.
Reconciliation with Applications Supplying Data

Features

During the changeover of local currency in the Consolidation application, data is reconciled with that of other SAP applications in the same R/3 System that supply Consolidation with data. Preparatory reconciliations are also required during the central changeover.

If you only change over reporting currencies in Consolidation (without a prior central changeover using the standard package), no specific reconciliations are required with applications that supply Consolidation with data. Any differences in the data of companies that supply data in reporting currency are only corrected during the next closing.

Reconciliation takes place if the following conditions are given:

- Supplying applications have performed their own reconciliations and transferred correct carryforward values.
- As a result of the above, the total value in the totals database differs from the value transferred from other systems, and therefore must be adjusted.

However, totals records are often more detailed in the Consolidation application than in the supplying applications, for example if realtime updating is used. In this case, the large majority of additional account assignments in Consolidation are retained and only the differences in comparison with the total value supplied by other applications are posted.

Reconciliation with other SAP systems does not occur at the same time as the euro changeover in your own system. Any differences in balance carryforward values must be taken into account until the next closing, when they are reversed by (cumulative) reported data.

Data in the PC offline data entry program are not reconcile. For more information, see the section Scenario when Using Offline Data Entry [Page 238].

Reconciliation of the consolidation staging ledger with the general ledger and subsidiary ledgers

You need to perform this reconciliation when using periodic extracts or realtime updating. To do this, you use the program RGCEUR50.

- If you use periodic extracts, the system reconciles the carryforward balances in the consolidation staging ledger (totals table GLT3) with the following ledgers during postprocessing for the central changeover:
  - General ledger (totals table GLT0) on account level
  - Subsidiary ledgers (FI-AR, FI-AP, FI-AA) at the level of transaction type and partner, if you specified this during preparation for the central changeover
    Reconciliation takes place in local currency.

- If you use realtime update, carryforward balances are generated in the consolidation staging ledger during postprocessing of the central changeover (if you specified reconciliation at a transaction type and partner level during preparation for the central changeover).
  In principle, carryforward balances are also generated as a result of the reconciliation between the consolidation staging ledger and the general and subsidiary ledgers. The balances of the general and subsidiary ledgers are determined and posted to the staging...
Reconciliation with Applications Supplying Data

ledger as the total difference. Carryforward balances are therefore reconciled at all levels of detail with the general and subsidiary ledgers before it is written to the consolidation staging ledger.

Reconciliation with Asset Accounting (FI-AA)

- Asset Accounting supplies data with company code, business area, and account information. Each account is identified as an acquisition and production cost (APC) account or accumulated depreciation account. In Customizing, you can define one transaction type for each of these accounts so that the consolidation staging ledger can be reconciled on account/transaction type level. If necessary, adjustment records are generated for the staging ledger.
- If records exist in the staging ledger with transaction types other than space, APC or accumulated depreciation, the relevant account is not reconciled on transaction type level.
- For more information about other account assignments in the adjustment record, see the section Further breakdown information in the consolidation staging ledger.

Reconciliation with open items (FI-AR, FI-AP)

- For each company code, business area and account, the subsidiary ledgers supply a breakdown of the balance carryforward value by trading partner and transaction currency.
- Reconciliation takes place on this level of detail, and an adjustment entry is generated for the consolidation staging ledger if required.
- For more information about other account assignments in the adjustment record, see the section Further breakdown information in the consolidation staging ledger.

Reconciliation with general ledger (FI-GL)

- General Ledger Accounting supplies balance carryforward values for each company code, business area, account, and (partially) transaction currency.
- Reconciliation takes place on this level of detail, and an adjustment entry is generated for the consolidation staging ledger if required.
- For more information about other account assignments in the adjustment record, see the section Further breakdown information in the consolidation staging ledger.

Further breakdown information in the consolidation staging ledger

In the consolidation staging ledger, some breakdown information may not be reconcilable with the general ledger and subsidiary ledgers.

In General Ledger Accounting, an entry with transaction type assignments is posted against a provisions account.

In the consolidation staging ledger, the transaction types assignments in entries are posted to the account. They are not, however, posted to the general ledger, because in General Ledger Accounting they are required in documents for informational purposes only.

In this case, the breakdown information exists in the staging ledger, but cannot be reconciled with the general ledger or subsidiary ledgers.
The following is an overview of standard account assignments that are used for adjustment records in the above cases:

<table>
<thead>
<tr>
<th>Breakdown</th>
<th>Account assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction type</td>
<td>Standard value (defined in changeover Customizing)</td>
</tr>
<tr>
<td>Trading partner</td>
<td>999999</td>
</tr>
<tr>
<td>Period of acquisition</td>
<td>012</td>
</tr>
<tr>
<td>Year of acquisition</td>
<td>Year prior to changeover</td>
</tr>
<tr>
<td>Trading partner business area</td>
<td>‘Space’ if not identical in all staging ledger records</td>
</tr>
</tbody>
</table>

For the purposes of documentation, adjusting entries posted by the program RGCEUR50 are saved in version EUR as well as version 001.

**Reconciliation between the consolidation staging ledger and data supplied by other applications (in the case of realtime update)**

You need to perform this reconciliation when using realtime updating. To do this, you use the program **RGCEUR30** (FI-LC) or **FICEUR20** (EC-CS).

Reconciliation takes place during postprocessing for the changeover of the Consolidation application.

If you want to reconcile integrated data at the level of items only, and specified this during the preparation for the central changeover, the program RGCEUR30 (FI-LC) or FICEUR20 (EC-CS) reconciles consolidation data with the general ledger on an item level.

However, if you specified reconciliation of integrated data at the level of transaction type or partner, a carryforward balance is generated in the consolidation staging ledger from the general and subsidiary ledgers during postprocessing (program RGCEUR50 mentioned above). In this case, the program RGCEUR30 (FI-LC) or FICEUR20 (EC-CS) reconciles consolidation data with the consolidation staging ledger.

The carryforward balance of the consolidation staging ledger is compared and reconciled with the carryforward in the converted Consolidation totals database, after the following conversions have been made:

- Accounts to financial statement items
- Transaction types to subitems (EC-CS)
- Company codes to companies
- Company codes/business areas to consolidation units
- and so on
Reconciliation with Applications Supplying Data

Reconciliation takes place per item, and depends on the item’s breakdown indicator:

- Transaction types (FI-LC) or subitems (EC-CS) are reconciled if both of the following apply:
  - You specified reconciliation on a transaction type level during the preparation for the central changeover, and the item has the appropriate breakdown indicator.
  - Transaction types or subitems contained in the converted extract are identical to those for consolidation totals records for the individual items.

In this case, an adjustment entry is posted for a transaction type or subitem if the balance is other than 0 (zero).

- If no reconciliation takes place on transaction type or subitem level but instead by partner, and the item supports a breakdown by trading partner, reconciliation takes place for each trading partner or partner unit, and transaction currency, and an adjustment entry is posted if required.

  However, this procedure does not apply for those partners in the carryforward balance in the consolidation staging ledger, which are used as additional account assignments in the consolidation processing ledger records that are compared.

- If a reconciliation does not take place due to the conditions mentioned above, it is automatically started for transaction currencies if the appropriate breakdown indicator is set.

- If a reconciliation not take place due to the conditions mentioned above, it is automatically started for years/periods of acquisition if the appropriate breakdown indicator is set.

- If a reconciliation not take place due to the conditions mentioned above, the converted value only is entered in the consolidation database.

- Breakdowns not reconciled according to any of the above conditions (for example a combination of partner and transaction type breakdowns) are allocated account assignments in the adjustment entry as follows:

  - If a single account assignment is used for an account in Consolidation, this assignment is also posted in the adjustment entry.
  - In the case of multiple account assignments, the following account assignments are used:

<table>
<thead>
<tr>
<th>Breakdown</th>
<th>Account assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction type (FI-LC)</td>
<td>Standard value (defined in euro Customizing)</td>
</tr>
<tr>
<td>Subitem (EC-CS)</td>
<td>Standard value (defined in euro Customizing)</td>
</tr>
<tr>
<td>Trading partner (FI-LC)</td>
<td>999999</td>
</tr>
<tr>
<td>Partner unit (EC-CS)</td>
<td>9999* (number of 9s reflects the length of the consolidation unit ID in the dimension)</td>
</tr>
<tr>
<td>Period of acquisition</td>
<td>012</td>
</tr>
<tr>
<td>Year of acquisition</td>
<td>Year prior to changeover</td>
</tr>
</tbody>
</table>
Reconciliation with Applications Supplying Data

<table>
<thead>
<tr>
<th>Ledger</th>
<th>Record</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cons staging ledger</td>
<td>Transaction type = 100</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>Partner = space</td>
<td></td>
</tr>
<tr>
<td>Cons processing ledger (FI-LC)</td>
<td>Transaction type = 100</td>
<td>499</td>
</tr>
<tr>
<td></td>
<td>Partner = GS01</td>
<td></td>
</tr>
<tr>
<td>Ditto</td>
<td>Transaction type = 100</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td>Partner = GS02</td>
<td></td>
</tr>
<tr>
<td>Adjustment entry</td>
<td>Transaction type = 100</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Partner = 999999</td>
<td></td>
</tr>
</tbody>
</table>

- The differential are allocated the posting level ‘space’.
- The document type EU is set for all adjustment records to identify them as the result of reconciliation. However, no journal entries are generated.

This additional information is automatically removed after the first carryforward of balances after the changeover.
Reconciliation Within Consolidation

Prerequisites
Reconciliation within the Consolidation application takes place after reconciliation with the systems that supply data for consolidation.

Features
The following reconciliation takes place:

Reconciliation of the totals database: Balance sheet and income statement
This reconciliation takes using the program RGCEUR00 (FI-LC) or FICEUR00 (EC-CS) at the following callup points:
- During preprocessing
- During table conversion
- During postprocessing (if you use realtime updating)
During preprocessing for the changeover, the program runs in test mode to check whether data is consistent in the original currency. During the RECONCILIATION and POST phases, reconciliation takes place in euros.
Data is reconciled in order to comply with the following rules:
- Assets + Liabilities and stockholders’ equity = 0
- Income statement + appropriation of retained earnings = 0
Data for various organizational units and currencies must comply with these rules, depending on the posting level of the database records.
Statistical items are not reconciled.

The differences found during reconciliation are posted to the adjustment items that you specify in Customizing for the euro changeover. No documents are generated for this. Depending on the items that you specify, adjustment entries either do or do not affect net income. If the entries do affect net income, the system generates adjustment entries for the items Retained earnings and Net income. These adjustment entries are the same as those generated during normal Consolidation posting.

If adjustment entries are not entirely either with or without an affect on net income, you can do the following:
- Decide whether you want adjustments to be posted with or without an affect on net income.
- After reconciliation, select the entries to adjustment items using document types.
- Reclassify entries that you want to handle differently, as far as their affect on net income is concerned, as other items.
The following section lists the organizational units and currencies whose data must comply with the rules, depending on the posting level.

**FI-LC component**

<table>
<thead>
<tr>
<th>Posting level</th>
<th>Rule per…</th>
<th>In local currency?</th>
<th>In ledger currency?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Company</td>
<td>X</td>
<td>X*</td>
</tr>
<tr>
<td>0</td>
<td>Company</td>
<td>X</td>
<td>X*</td>
</tr>
<tr>
<td>8</td>
<td>Company</td>
<td>X</td>
<td>X*</td>
</tr>
<tr>
<td>1</td>
<td>Document type and company</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>2</td>
<td>Document type and company pair</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Document type and subgroup</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

**Comments:**

- If, for entries with posting level 1, the document type also posts in ledger currency, reconciliation of totals records also takes place in ledger currency.

- If, for entries with posting level 2 or 3, the document type posts in local currency instead of ledger currency (for groups reporting in local currency), reconciliation takes place in local currency.

- The posting levels ‘space’, 0 and 8 must also be reconciled in ledger currency. In the overview, these are marked X*, since only the total of these posting levels is reconciled in ledger currency. Differences are posted with level 0.

**EC-CS component**

<table>
<thead>
<tr>
<th>Posting level</th>
<th>Rule per…</th>
<th>In local currency?</th>
<th>In ledger currency?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>Consolidation unit</td>
<td>X</td>
<td>X*</td>
</tr>
<tr>
<td>00</td>
<td>Consolidation unit</td>
<td>X</td>
<td>X*</td>
</tr>
<tr>
<td>08</td>
<td>Consolidation unit</td>
<td>X</td>
<td>X*</td>
</tr>
<tr>
<td>01</td>
<td>Document type and cons unit</td>
<td>(X)</td>
<td></td>
</tr>
<tr>
<td>02</td>
<td>Document type, cons unit and cons group</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>10</td>
<td>Document type and cons unit</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>12</td>
<td>Document type and cons unit</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>20,22,23,24</td>
<td>Document type, cons unit pair, partner</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Document type, cons group, investee</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
Reconciliation Within Consolidation

Comments:
- Totals records with posting level 01 should not exist, since these records are carried forward to posting level 00. In the overview, these are therefore marked (X).
- The posting levels ‘space’, 00, and 08 must also be reconciled in ledger currency. In the overview, these are marked X*, since only the total of these posting levels is reconciled in ledger currency. Differences are posted with level 0.

Reconciliation of the totals database: Retained earnings

This reconciliation takes place during postprocessing for the changeover of the Consolidation application, using the program RGCEUR00 (FI-LC) or FICEUR00 (EC-CS). You need to set the indicator Reconcile retained earnings on the initial screen of the program.

Reconciliation may or may not be necessary, depending where you report the appropriation of retained earnings:
- If you show the appropriation of retained earning in the income statement, the rule Retained earnings in the balance sheet = Retained earnings in the income statement applies. This rule must be also be complied with after the changeover.
- If you show the appropriation of retained earnings in the balance sheet, the transfer item between the balance sheet and income statement does not need to be checked, because net income is transferred (net income is 0 (zero) in the balance carryforward).

The system cannot automatically establish which case applies in your situation. You therefore need to start the program manually during postprocessing if the first case applies.

The above guidelines for reconciliation of the balance sheet and income statement depending on the posting level apply with the following addition:
- FI-LC component: For posting level 2 and above, data is also checked per company.
- EC-CS component: For posting level 20 and above, data is also checked per consolidation unit.

Any differences are automatically correct with one of the following entries:

<table>
<thead>
<tr>
<th>Retained earnings in BS</th>
<th>against</th>
<th>Euro adjustments in BS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Euro adjustments in BS</td>
<td>against</td>
<td>Retained earnings in BS</td>
</tr>
</tbody>
</table>

If you have specified an income statement item as the adjustment item for balance sheet differences in Customizing, the adjustment affects net income.

Item substitution

This reconciliation takes place when using realtime updating. It runs during postprocessing for a changeover using the program RGCHPEU (FI-LC) or FICCHI00 (EC-CS).

You need to run this reconciliation if you used item substitution before the changeover. A conversion or reconciliation with the systems that supply data could lead to inconsistencies between financial data and database records for item substitutions.
You therefore need to restart the program for the period 0.

**Reconciliation of additional financial data**

This reconciliation takes place during postprocessing for the changeover, using the program RGCEUR10 (FI-LC) or FICEUR10 (EC-CS).

Exception: Goodwill is reconciled during the changeover of the EC-CS application in conjunction with the reconciliation of the totals database using the program FICEUR00.

The system performs the following reconciliations:

- **Reconciliation of additional financial data with the totals database:**
  - In EC-CS, carryforward balances for additional financial data are reconciled with the carryforward balances in the totals database. Any adjustments are made to the additional financial data in the balance carryforward period.
    
    New entries are generated for changes in investments and investee equity. These entries are also posted in period 16 of the prior year so that reports such as the equity aging report remain consistent.
  
  - In FI-LC, the records of changes in additional financial statement data are reconciled with the totals database. Any adjustments are made to the additional financial data in the balance carryforward period.

- **Internal reconciliation of entries made by the consolidation of investments program for the amortization of eliminated hidden reserves and goodwill:**
  - The net book value for all entries in the changeover year is derived from other account data, except in the special cases that follow.
  
  - If the net book value was previously 0 (zero), it is also 0 (zero) after the conversion. Differences are corrected in the amortization/depreciation value for the period.
  
  - If the net book value for a positive opening balance is negative after recalculation, it is set to 0 (zero) and the depreciation value for the period correspondingly reduced.
  
  - If the net book value for a negative opening balance (negative goodwill) is positive after recalculation, it is set to 0 (zero) and the depreciation value for the period correspondingly increased.

- **Internal reconciliation of entries made in the prior year by the program for the elimination of intercompany profit/loss in transferred assets (FI-LC only) for the amortization/write-up of asset values:**
  - The net book value is recalculated for all entries in the year is derived from other account data, except in the special cases that follow.
  
  - If the net book value was previously 0 (zero), it is also 0 (zero) after the conversion. Differences are corrected in the amortization/depreciation value for the period.
  
  - If the net book value is negative after recalculation, it is set to 0 (zero) and the depreciation value for the period correspondingly reduced.
Reconciliation with Applications Receiving Data

Prerequisites
Reconciliation of the Consolidation application with those applications that it supplies with data only takes place after reconciliation with applications that supply data for consolidation, and after application-internal reconciliation.

However, a completely accurate opening balance in euros still cannot be guaranteed after the Consolidation application has been successfully changed over and reconciled. SAP recommends that you only transfer data to other SAP or non-SAP systems after you have completed your next closing.

Features

Reconciliation with non-SAP systems
The non-SAP application must reconcile the converted and reconciled consolidation data with its own changed-over data. A reverse procedure whereby the receiving system calculates euro values for Consolidation is not supported.

Reconciliation with the Executive Information System (EC-EIS)

- EC-EIS is not automatically reconciled with the applications that supply it with data (for example the FI-LC and EC-CS applications).

- If you want values converted into euros in the Consolidation application and reconciled in the current year to also be available in the EC-EIS component, you need to restart data transfer for the relevant organizational unit, years, periods, and versions.
Documentation of Adjustment Entries

Features
This section describes the options available for documenting adjustment entries generated by programs for the euro changeover.

The audit trail for each program is the most important means of documentation, and should be printed out and archived. The audit trail is displayed as follows:

- If the program started automatically, you display the audit trail by choosing System → Services → Output control. You select the relevant spool request and identify the audit trail by means of the program name.
- If you started the program manually, the audit trail is automatically displayed once the program has run. Remember that the audit trail cannot usually be regenerated once posting is complete.

FI-LC Consolidation
Reconciliation programs for Consolidation integration

- Reconciliation of the consolidation staging ledger with the general and subsidiary ledgers (RGCEUR50)
  This program is started either automatically or manually during postprocessing for the central euro changeover. You can document postings made by the program as follows:
  - Print out the audit trail
  - Save the adjustment entries in the version EUR
    Data is always managed in version 001 in the consolidation staging ledger. For documentation purposes, the system also automatically saves the adjustment entries generated during reconciliation in the version EUR.
    You can use the program RGCLST30 to list these entries.

- Reconciliation of the consolidation staging ledger with the consolidation processing ledger (RGCEUR30)
  You start this program automatically during postprocessing for the changeover in Consolidation. You can document postings made by the program as follows:
  - Print out the audit trail
  - Assign the document type EU
    The system assigns the document type EU for adjustment entries in the Consolidation database (although it does not generate documents). This additional information is removed automatically in the first balance carryforward after the changeover.
    You can use the program RGCLST00 to select the totals records to which this document type is assigned.

Programs for reconciliation within Consolidation

- Reconciliation of the totals database (RGCEUR00)
You start this program manually during preprocessing and postprocessing for the changeover.

You can document postings made by the program as follows:

– Print out the audit trail
– Run a report for adjustment items

You can use the program RGCLST00 to list the totals records incorporating the adjustment.

- Reconciliation of additional financial data (RGCEUR10)

You start this program manually during postprocessing.

In the initial screen for the program, you can specify that you want the original values — in other words the existing additional financial data — to be displayed in the audit trail as well as the adjustment entries.

**Deletion of data in periods after the balance carryforward for reconciliation**

The system automatically starts the program RGCEUR60 during conversion. Once it has run, you can display the audit trail. You can check the database using the program RGCLST00.

**EC-CS Consolidation**

**Reconciliation programs for Consolidation integration**

- Reconciliation of the consolidation staging ledger with the general and subsidiary ledgers (RGCEUR50)

  This program is started either automatically or manually during postprocessing for the central euro changeover. You can document postings made by the program as follows:
  
  – Print out the audit trail
  – Save the adjustment entries in the version EUR

  Data is always managed in version 001 in the consolidation staging ledger. For documentation purposes, the system also automatically saves the adjustment entries generated during reconciliation in the version EUR.

  You can use the program RGCLST30 to list these entries.

- Reconciliation of the consolidation staging ledger with the consolidation processing ledger (FICEUR20)

  You start this program automatically during postprocessing for the changeover in Consolidation. You can document postings made by the program as follows:
  
  – Print out the audit trail
  – Assign the document type EU

  The system assigns the document type EU for adjustment entries in the Consolidation database (although it does not generate documents). This additional information is removed automatically in the first balance carryforward after the changeover.

  You can use the program FICLST00 to select the totals records to which this document type is assigned.
Documentation of Adjustment Entries

Programs for reconciliation within Consolidation

- Reconciliation of the totals database (FICEUR00)
  You start this program manually during preprocessing and postprocessing for the changeover.
  You can document postings made by the program as follows:
  - Print out the audit trail
  - Run a report for adjustment items
  You can use the program FICLST00 to list the totals records incorporating the adjustment

- Reconciliation of additional financial data (FICEUR10)
  You start this program manually during postprocessing.
  In the initial screen for the program, you can specify that you want the original values — in other words the existing additional financial data — to be displayed in the audit trail as well as the adjustment entries.
  New changes in investments and investee equity entries are generated for differences occurring during reconciliation. Numbering of entries is the reverse of normal numbering: Euro entries are allocated numbers in descending order from 00 (99, 98, and so on). This numbering enables you to identify the entries generated.

Deletion of data in periods after the balance carryforward for reconciliation

The system automatically starts the program FICEUR30 during conversion. You can display the audit trail once the program has run.

In the RECONCILIATION phase, the program reconstructs totals records from documents that result from entries with automatic reversal, and have therefore not been deleted. You can use the program FICLST00 to list these totals records.
Constraints for the Changeover

The changeover of Consolidation has constraints in the following areas:

Data of the Changeover Year

The system does not change over, but instead deletes the data that was reported, or even consolidated in the previous currency in the periods following the carrying forward of balances. This data must again be reported in euros and consolidated.

An exception are the journal entries of the prior year, which were posted in the changeover year with automatic reversals in the subsequent period. Instead of being deleted, these entries are used to reconstruct the totals records after the changeover.

Decentralized Data Entry Programs

The data in the data entry programs based on dBase and MS Access is not converted. See Scenario when Using Offline Data Entry [Page 238].

Validation Rules

Validation rules can contain currency amounts that are defined as constants.

For example, validations for postings can contain rules like:

- Warning if \textit{Extraordinary Expenditure} \textgreater 1000
- Error if \textit{User} = \textit{XYZ} and \textit{Amount} > 1000

The euro changeover cannot recognize these currency amounts. Such rules must be changed manually.

Threshold Values (EC-CS)

The following threshold values can be defined in Customizing:

- Threshold values for interunit eliminations
- Threshold values for the immediate amortization of goodwill

After the euro changeover, you need to check these values and, if necessary, modify them manually.

MCDX Database (FI-LC)

The information stored and summarized in this database is not changed over due to the data’s high redundancy in conjunction with itself and with the totals database.

Therefore, you must reselect any summary data that you require in euros for prior fiscal years to meet your future needs. Such a re-selection involves the following problems:

- Long runtimes may occur, especially when selecting multiple years, versions or subgroups.
- The FS chart of accounts may have been modified since the last selection that was made in the original currency. That is, financial statement items may have been deleted, added or modified. In such cases, the original selection results may not be exactly reproducible.
Constraints for the Changeover

- The euro changeover does not reconcile the prior years. This can cause rounding errors after the re-selection.

Interactive Excel (FI-LC)

- The Interactive Excel feature delivered as of Release 3.0A enables you to access (summarized) R/3 totals data.
- The Interactive Excel feature delivered as of Release 4.0B enables you to directly access the R/3 totals database or the MS Access database.

After running full (or partial) changeovers of the R/3 or the MS Access database, you need to call up and update all of the affected and active MS Excel worksheets.

Any previously created snapshots based on the old currency cannot be updated automatically. If you require any such snapshots in euros, you must create them again.

Key Figures/Ratios (FI-LC)

Key figure (or ratio) definitions can contain constants that represent currency amounts. The euro changeover cannot recognize these currency amounts. You need to change these manually.

Archiving (FI-LC)

Once one or more changeover packages (standard, FI-LC or EC-CS) are used to convert data, you can no longer reload or read the archive files for FI-LC Consolidation.
Cleanup in the Next Closing

Use

After changeover and reconciliation in the Consolidation application, a completely accurate opening balance in euros is still not guaranteed. You need to cleanup errors, either manually or using “normal” automatic consolidation functions during the next closing.

Activities

If you want distinguish the cleanup after the changeover from normal consolidation activities, you can do one of the following:

- Close your accounts in the next regular consolidation period in the changeover year, without entering any new data or changing any exchange rates.
  
  The resulting financial statements document the final changeover results. You print out the audit trails and then close the period as normal.

- In certain cases, you can run an extra intermediate closing (for example for period 01 of the changeover year) before your regular closing in order to generate reports showing adjustments.

  To do this you need to change the input type for the subgroup or consolidation group, at least temporarily.

⚠️

In both of these cases, you need to remove the activities Consolidation of investments and Elimination of intercompany (interunit) profit/loss in transferred assets from the Consolidation application, so that assets are not depreciated and goodwill and hidden reserves not amortized.

The problems resulting from the changeover and the procedures for cleaning these up are explained below. All functions that are mentioned should be started for the next (special or regular) closing, unless otherwise stated.

Reconciliation of financial data to take account of validations

No validations are run during euro reconciliation.

Solution:

Run validations during the next closing.

Reconciliation of financial data with adjustment entries (in local currency)

After the changeover to the euro and the reconciliations involved, differences can occur between financial data and corresponding adjustment entries.

Example:

1000  DEM (financial data) are converted to 500 euros.

1000- DEM (adjustment entry with additional account assignment) are converted to 499- euros.

Solution:
Cleanup in the Next Closing

Manually post an adjustment entry or start the function (reclassification) that automatically generated the adjustment entry. Check in Customizing to see if you can rerun this function or whether 500- euros would be posted.

Reconciliation of financial data / adjustment entries to take account of rounding rules (local currency)

The rounding logic for currency translation requires that data that conforms to rounding rules in group currency also conforms in local currency. This may not be the case, however, after the euro changeover and resulting reconciliation.

Solution:
- Run currency translation in test mode in order to initially identify errors.
- Manually correct financial data.
- Correct adjustments by posting new entries.

Reconciliation of financial data / adjustment entries to take account of rounding rules (group currency)

After the euro changeover, data does not necessarily comply with the rounding rules for currency translation.

Solution:
Run currency translation in update mode after reversing any local currency errors in the previous step.

Reconciliation of financial data / adjustment entries to take account of validations (group currency)

No validations are run during euro reconciliation.

Solution
- Run validations during the next closing.
- If your local currency values are correct, correct group currency values should have been calculated during currency translation. For domestic companies or consolidation units, or when currency translation key 6 (= no recalculation) is used, you should correct errors in group currency values as soon as they are found.

Reconciliation of financial data with entries for intercompany/interunit elimination or reclassification

Group valuation (standardized) payables or receivables that have been converted to the group currency euro must be fully eliminated.

This may not be possible if the data concerned was reported in various transaction currencies but only eliminated in group currency. Database records have different levels of detail and rounding differences can occur during the euro changeover.

Example:

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Group currency before changeover</th>
<th>Euro</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Similar problems can also occur for other item sets in the balance sheet against which elimination or reclassification entries are posted.

**Solution:**

- Run the function during the next closing.
- Rounding differences (in this case 1- euro) are then posted to the differential items specified in regular Consolidation Customizing. If you want to avoid this, you should run an extra intermediate closing with a different method definition (for example posting of differences without instead of with an effect on net income).

**Reconciliation of financial data with consolidation of investments entries (FI-LC)**

Past errors in data entry can lead to financial data and elimination entries with differing levels of detail in the totals database (for example omission of partner breakdown when posting against an investment item). Rounding differences then result between financial data in euros and elimination entries in euros.

Although these differences may be minor, they can affect critical items in the consolidated balance sheet.

**Examples:**

- Shares in affiliated companies not equal to 0
- Subscribed capital not equal to subscribed capital of the parent company

**Solution:**

Make adjustments manually.

**Reconciliation of additional financial for elimination of intercompany profit/loss in inventory with elimination entries (FI-LC)**

Additional financial data reporting inventory and the transfer of inventory to trading partners within the corporate group have a different level of detail from the corresponding elimination entries. This results in rounding differences.

For elimination entries without automatic reversal, the system may make slightly incorrect assumptions about elimination entries in the totals database in the previous year when eliminating in the current year. As a result, elimination records may still remain in the database, even if the inventory value for the current year is 0 (zero)

**Solution:**

Make adjustments manually.

**Reconciliation of additional financial data for elimination of intercompany**
Cleanup in the Next Closing

**Profit/Loss in Transferred Assets with Elimination Entries (FI-LC)**

Additional financial data reporting inventory and the transfer of assets to group-internal trading partners have a different level of detail from the corresponding elimination entries. This results in rounding differences.

Therefore not all elimination records for past periods are corrected if internally transferred assets are sold to external companies.

Information about depreciation of transferred assets in the changes in depreciation table (T875E) may deviate from accumulated depreciation in the totals database. This can result in future depreciation falling slightly short of or slightly exceeding the total amount.

**Solution:**

Make adjustments manually.

**Reconciliation of Additional Financial Data for Goodwill/Hidden Reserves with Consolidation Entries.**

Information in the additional financial data tables (T874 for FI-LC, TF635 for EC-CS) is posted cumulatively to the totals database (several goodwill or hidden reserves entries). This can result in small differences after the euro changeover.

**Solution:**

Make adjustments manually.

**Reconciliation of the Balance Carryforward with Other SAP Systems or Non-SAP Systems**

The euro changeover and resulting reconciliation can only produce carryforward balances that are reconciled with the individual financial statements for companies or consolidation units on the company code level of the same R/3 System.

Automatic reconciliation is not possible for other companies or consolidation units.

**Solution:**

Cumulative values only correspond after the next closing:

- If data is reported cumulatively, correct values are automatically received.
- If data is reported periodically, any differences between the carryforward balances in the sender system and carryforward balances in the SAP Consolidation application must be either corrected in the data reported for the first period after the changeover, or manually corrected after the transfer of original values to the Consolidation application.
Currency Translation Using Spot (Current) vs. Historical Exchange Rates

Features

When changing over the ledger currency to euros, and the local currency of companies or consolidation units to euros, the situation “local = ledger = euro” can occur.

In lieu of the intermediate steps leading to the changeover to “local = ledger = euro”, the following scenarios are possible:

1. local / ledger → euro / ledger → euro / euro
2. local / ledger → local / euro → euro / euro
3. local / ledger → euro / euro

In a “local = ledger = euro” currency situation, currency translation is, in principal, no longer required.

However, the ‘euro local currency amounts’ and the ‘euro group currency amounts’ initially differ for those financial statement items which, in the past, were translated using historical exchange rates. The law permits companies to choose between keeping the historical amounts or switching over to spot (current) rate translation, that is, identical local and ledger currency amounts. This choice can be made for FI-LC and EC-CS within the Customizing of currency translation.

For various reasons, differences between the local currency and ledger currency amounts can also occur in the following situations:

- For companies (or consolidation units) in which the local currency equals the ledger currency prior to the euro changeover
- For companies (or consolidation units) which were already translated with spot (current) exchange rates prior to the euro changeover

You need to clear these dissimilarities in the next closing by performing currency translation.

💡

To enable currency translation to work for companies or consolidation units where the local currency equals the ledger currency, the Currency translation if LC = GC indicator was introduced in the method assignments in Releases 3.1I and 4.0B.

In cases where further discussions within this section prompt you to set or reset this indicator, you should always do this by creating a new entry. This ensures that the transaction history is accurately documented.

As soon as the local and ledger currency amounts again become identical, you should reset the indicator to increase system performance by preventing unnecessary currency translation runs.

First currency translation

When dealing with companies or consolidation units in which the local currency equals the ledger currency prior to any euro changeovers, you must perform a currency translation after the first step of a staged changeover, that is, with a scenario ‘local / euro’ or ‘euro / ledger’.
Currency Translation Using Spot (Current) vs. Historical Exchange Rates

You follow these steps:

1. You define a simple spot (current) rate method with separate translation entries for the balance sheet and the income statement (no specific translation entries for aging reports, such as the asset history sheet)

2. You assign this method to the companies or consolidation units.
   In EC-CS, you may have to define a new task group which contains currency translation, and assign the new task group to the dimension for no specific time period.


During a simultaneous changeover of local and ledger currencies to euros, the amounts involved are presently not reconciled. Reconciliation of local currency amounts with Financial Accounting data can therefore result in differences between local and ledger currency amounts in euros. This discrepancy is also rectified by currency translation.

Retaining currency translation with spot (current) exchange rates

Companies (or consolidation units), which in the past applied the spot (current) exchange rate when the local currency was not the same as the group currency, may also have differences between their local currency and group currency amounts in euros after a simultaneous or staged changeover of local and ledger currencies. This is the result of:

- Rounding
- Reconciliation with Financial Accounting
- Deviation between the fixed exchange rate and the spot (current) rate of the last non-euro closing.

You need to use the defined spot (current) rate method for the next closing. In order to run be able to run currency translation, you need to set the indicator Currency translation if LC = GC. For the following closing, you deactivate the indicator.

Switching over to spot (current) rate translation

In FI-LC and EC-CS you assign currency translation methods to companies and consolidation units for a specific period of time. The switch from historical exchange rate translation to spot (current) rate translation is therefore a normal function in the Consolidation application. Currency differences that have (or do not have) an effect on net income are reversed with (or without) an effect on net income.

Exchange rates can be switched as part of the euro changeover at two points in time:

- During the last closing prior to the changeover
  In the context of the euro changeover, this procedure amounts to continuing currency translation with spot (current) exchange rates.

- During the first closing after the changeover, in order to receive identical local and ledger currency amounts
  In this case, you need to set the indicator Currency translation if LC = GC and then deactivate it for the next closing.
Currency Translation Using Spot (Current) vs. Historical Exchange Rates

Note that for the spot (current) rate translation method you need to make specifications about how aging reports should be handled. These specifications are not required for first currency translation.

Retaining historical rate translation

If you want to retain historical amounts in ledger currency after the euro changeover, the historical rate translation method must remain assigned. By setting the indicator Currency translation if LC = GC, you specify that translation also takes place if local and ledger currencies are identical.

By setting this indicator, you also ensure that no values are copied from local currency fields into ledger currency fields in the database during data entry, even if the currency key is identical. This enables you to post historical adjustment entries in different local currency and ledger currency amounts, for example.

You only deactivate this indicator once you are sure that you are switching to the spot (current) rate method.
Extra Functions

Use
The functions for translating currency within Consolidation Reporting – from the original currency to euros prior to the changeover or vice versa after the changeover – is available in the following common R/3 reporting tools:

- Interactive Drilldown (EC-CS)
- Report Writer (FI-LC and EC-CS)

These functions are not available in:

- Totals reports (FI-LC)
- Journal entry (document) reports
- Reports on additional financial data (list of ownership, investments, investee equity, equity holdings adjustments, hidden reserves (FVA), intercompany profit/loss in inventory/transferred assets)
- The K3 form for the German foreign trade regulations

On the other hand, you can use the “normal” Consolidation functions in regards to the reporting currency (ledger currency) to:

- Generate parallel euro closing statements even prior to the euro changeover
- Copy the closing data in the original currency, to exclude the copy from the euro changeover by means of adjusting the package definition, and thereby retain the copy of the closing data for reporting in the original currency as long as this is required

Features

Euro closing statements prior to the euro changeover (FI-LC)
SAP recommends that you use the Report Writer to dynamically translate closing statement data from the original currency into euros. If you do not wish to do this and, instead, you want to create (parallel) closing statements with the euro as the reporting currency, you must perform the following steps:

1. You define a new ledger with currency type 80 and the currency euro.
2. You define a new version and make all of the special versions identical to the productive (live) version.
3. You assign all companies to the new ledger.
4. You assign the new ledger and the currency euro to all subgroups in the productive ledger (in the new version).
5. You copy the reported financial data and the standardizing entries in the totals database from the old ledger / old version to the new ledger / new version.

   This activity copies the amounts in transaction currency and local currency. The amounts in ledger currency remain blank because of the deviating currency key—the ledger currency amounts are not translated.
6. You copy the additional financial data (investments, equity) to the new ledger and re-enter the group values in euros.

7. You perform the consolidation (currency translation, elimination activities) in the new version.
   
   In general, this involves additional manual effort because the new ledger does not contain historical euro values or the consolidation effects of the prior years.

**Closing statements in the original currency (e.g., DEM) after the euro conversion (FI-LC)**

You need to perform the following tasks must be performed prior to the euro changeover of the productive ledger (using the example of DEM as the original currency):

1. You define a new ledger with currency type 80 and the currency DEM.

2. You define a new version, and make all of the special versions identical to the productive version.

3. You assign all companies to the new ledger.

4. You assign the new ledger and the currency DEM to all subgroups in the productive ledger (in the new version).

5. You copy the totals database from the productive ledger / productive version to the new ledger / new version for the desired closed fiscal years.
   
   This activity copies the amounts in transaction currency, local currency and group currency.

6. You copy the additional financial data (investments, equity, hidden reserves), if desired.

7. You perform a data selection.

If you exclude the new ledger from the euro changeover, it remains available for generating reports in reporting currency DEM. Any local currency changeover performed later on (in a subsequent year) does not modify the group currency values.